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Welcome

This chapter introduces you to the contents and conventions of the Microsoft® Outlook™98 Deployment Kit, and points you to the Microsoft Outlook Web site for the most up­to­date information. The Microsoft Outlook 98 Deployment Kit includes this book, the Outlook 98 Deployment Wizard, and a set of companion tools, utilities, and sample files contained on the Outlook 98 Deployment Kit CD.

The purpose of the Microsoft Outlook 98 Deployment Kit is to provide the information that IS professionals and administrators need to deploy and support Outlook 98. This includes installing and customizing Outlook, optimizing features and functions, and understanding how Outlook interoperates with other mail systems and Microsoft products within organizations. The following section outlines the types of information included in this book.
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About the Deployment Kit

The Microsoft Outlook 98 Deployment Kit provides you with a wealth of information for installing and supporting Outlook 98. This book includes the following chapters:

Chapter 1, "Microsoft Outlook 98 Overview" introduces Microsoft Outlook 98 and describes its design goals and basic architecture. Also, this chapter identifies the system administration features that are new in Outlook 98. 

Chapter 2, "Installation and Configuration" describes the files and settings that administrators use to install and configure Outlook. Learn how to create a custom installation using the Outlook 98 Deployment Wizard and how to deploy Outlook using the Systems Management Server. Read about Outlook mail profiles and system policies. Also, find out how Outlook migrates Microsoft Schedule+ calendar information.

Chapter 3, "Interoperability" explains how Outlook interoperates with Microsoft Exchange Client and Microsoft Mail 3.x. Also, learn how Outlook works with Microsoft Schedule+ and Microsoft Project.

Chapter 4, "Customizing Microsoft Outlook 98 Features" describes how to create your own custom settings for Outlook features, including Outlook toolbars and menus, the Outlook Bar, and Outlook Today. Administrators can review this chapter when customizing these features during installation.

Chapter 5, "Optimizing Microsoft Outlook 98 for Your Users" provides many helpful tips for using Outlook, including how to back up Outlook data and how to set up Outlook for multiple or roaming users. These tips help administrators and their user communities optimize Outlook features within the work environment.

Appendix A, "Sample Outlbar.inf File" provides a sample configuration file for the Outlook Bar. Administrators can review this sample file when customizing this feature during installation.

Appendix B, "Setup Command-Line Options" explains how to run the Setup program from the command line and describes the parameters that you can add to the command to specify special options during installation.

Appendix C, "Other Microsoft Outlook Clients" describes Outlook Web Access, Outlook for Windows 3.x, and Outlook for the Macintosh. 

Additional Information

Outlook provides comprehensive product documentation in both print and online formats. For information about how to use specific Outlook features, see the online Help supplied with the product. Also, see the following reference materials for additional information about Outlook.

Microsoft Office 97 Resource Kit

The Microsoft Office 97 Resource Kit contains valuable information about Microsoft Office 97 applications. For a complete copy of the Microsoft Office 97 Resource Kit, see the Web site at http://www.microsoft.com/office/ork/.

Note: Outlook 98 is an interim release, and therefore is not integrated with Office 97 Setup. 

Microsoft Exchange Server Resource Kit

 xe "Microsoft Exchange Server Resource Kit"\\€part2.doc-1001 
The Microsoft Exchange Server Resource Kit consists of Parts 1 and 2, which are included with the Microsoft BackOffice® Resource Kit. The resource kit provides detailed information about Microsoft Exchange Server architecture and features, as well as setup and implementation tools. For a complete copy of the Microsoft Exchange Server Resource Kit, see your Exchange Server CD or the Exchange Server Web site at http://www.microsoft.com/exchange/.

Web Sites

 xe "Web sites with product information"\\€part2.doc-1002 
Visit the following Web sites for up-to-date information about Outlook and related products:

· The Outlook Web site at http://www.microsoft.com/outlook/ contains a wealth of information about the Outlook product, including access to the Outlook knowledge base, support information, and frequently asked questions.

· The Office Web site at http://www.microsoft.com/office/ is a good source for information about Office applications and provides a link to the Microsoft Office 97 Resource Kit.

· The Office Enterprise Desktop site at http://www.microsoft.com/office/org/ provides pertinent information for enterprises that are deploying Microsoft Office 97. 

· The Exchange Server Web site at http://www.microsoft.com/exchange/ contains current information about Exchange Server and links to other Microsoft BackOffice products.

Conventions in This Deployment Kit

 xe "Conventions in this Deployment Kit"\\€part2.doc-1003 
The following table summarizes the typographic conventions used in this book.

Convention
Description

bold
Menus and menu commands, command buttons, dialog box titles and options, command-line commands, options, and portions of syntax that must be typed exactly as shown.

Initial Capitals
Names of applications, programs, and named windows.

italic
Information that you provide (for example, a <server> or <drive> name that you type) and book titles.

KEY+KEY
Key combinations in which you press and hold down one key, and then press another.

Acronyms in This Deployment Kit

 xe "Abbreviations"\\€part2.doc-1004 
The following table provides a list of standard abbreviations or acronyms used throughout this book and their meanings.

Acronym
Meaning

BCC
Blind carbon copy

CD
Compact disc

CDO
Exchange collaboration data objects

DLL
Dynamic-link library

GAL
Global address list

HTML
Hypertext markup language

IMAP4
Internet Mail Access Protocol 4

IMEP
Internet mail enhancement patch

INF
Information file

ISP
Internet service provider

LAN
Local area network

LDAP
Lightweight Directory Access Protocol

MAPI
Messaging application programming interface

MHTML
Multi-Purpose Internet Mail Extensions

MSDL
Microsoft download service

NNTP
Network News Transport Protocol

OST
Offline store file

OWA
Outlook Web Access

PDF
Package definition file

POP3
Post Office Protocol 3

PST
Personal folder file

RPC
Remote procedure call

S/MIME
Secure Multi-Purpose Internet Mail Extensions

SMS
System Management Server

SMTP
Simple Mail Transfer Protocol

SPX
Sequenced packet exchange

STF
Setup table file

TAPI
Telephony Application Programming Interface

 xe "Abbreviations"\\€part2.doc-1005 
Acronym (cont.)
Meaning (cont.)

TCP/IP
Transport Control Protocol/Internet Protocol

WMS
Windows messaging system

UNC
Universal naming convention

URL
Uniform resource locator

CHAPTER 1

Microsoft Outlook 98 Overview

This chapter provides an overview of Microsoft® Outlook™98, so that you can gain a better understanding of its design goals, architecture, and system administration features. 

Note: If you are supporting Outlook 97 or deploying Outlook 98 in a mixed environment of Outlook 97 and Outlook 98 users, you may want to review the Microsoft Outlook 97 Administrator's Guide for more information about Outlook 97 system administration features.
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Introduction

Outlook 98 is the premier messaging and collaboration client that combines leading support for Internet standards-based messaging systems, including Microsoft Exchange Server, with integrated calendar, contact, and task management features. This important product upgrade responds directly to the new and innovative ways that individuals and organizations are working together. Outlook provides technologies that enable Internet-based collaboration, information sharing, and business solutions. Also, it continues the role of a fully optimized client for the fast-growing number of companies that rely on Exchange Server for scalable, advanced e-mail, calendaring, and collaboration features for their business-critical intranets.

Design Goals

 xe "Design goals for Outlook 98"\\€part2.doc-1010 
Microsoft evaluated industry trends and valuable feedback from user research, corporate customers, press, and individual customers, and formulated a set of design goals for Outlook 98. These design goals include the following: 

· Make the product easier and simpler to use. The Outlook development team focused on usability enhancements that make the product more intuitive. Now, it's easier for users to discover and use important features. For example, simplified menus, toolbars, and options mean easier navigation; users can move more quickly through their e-mail, calendaring, and contact management activities. Also, with Outlook Today, users can see scheduled meetings and required tasks for the day, as well as how many e-mail messages arrived overnight. 

 xe "Performance improvements"\\€part2.doc-1011 
· Improve performance and simplify setup and configuration. Important changes to basic operations in Outlook dramatically improve performance and ease of configuration. Most noticeably, users can open or delete meeting requests much more quickly. They can also perform common tasks more quickly, including starting and quitting Outlook, switching between modules, opening meeting requests, and looking up free/busy times.

Using Active Setup technology, Outlook offers streamlined setup and a customizable, centrally administered user interface that can be configured easily for Internet messaging and collaboration using the Outlook 98 Deployment Wizard (ODW). For Internet Mail users, Outlook provides seamless migration from Outlook Express and many other Internet e-mail products—it recognizes existing accounts and imports folders and personal address books automatically.

 xe "Support for Internet standards"\\€part2.doc-1012 
· Provide industry-leading support for Internet standards. Outlook implements leading Internet messaging and collaboration standards and protocols, including the following:

— Post Office Protocol 3 (POP3) and Simple Mail Transport Protocol (SMTP)

— Internet Mail Access Protocol 4 (IMAP4)

— Lightweight Directory Access Protocol (LDAP)

— Network News Transport Protocol (NNTP)

— Dynamic HTML, including Multi-purpose Internet Mail Extensions (MHTML)

— Secure Multi-purpose Internet Mail Extensions (S/MIME)

— vCard, vCalendar, and iCalendar (for Internet free/busy time)

Outlook helps users and organizations standardize on a single product for secure electronic mail, Internet-ready group scheduling, Web access, and information management. By integrating tightly with the Web, Outlook provides e-mail services, regardless of the Internet service provider or browser. Outlook features, such as customizable views and forms and drag-and-drop integration with scheduling and information management, make it easy for users to manage all of their Internet e-mail as a seamless part of daily communication and collaborative efforts. Also, users can make better use of Internet information from Web sites by integrating it effortlessly into their work days and personal lives.

 xe "AutoPreview feature in Outlook Calendar"\\€part2.doc-1013 
· Further advance e-mail and information management. Outlook introduces innovative features that further advance the usability and integration of e-mail, calendar, and information management features. For example, the Outlook Preview Pane enables users to quickly view messages without opening them; it includes support for attachments, hyperlinks, and HTML mail. Also, the AutoPreview feature in Outlook Calendar lets users display appointment details in daily, weekly, and monthly calendar views. 

 xe "Collaborative applications, using with Outlook and Exchange Server"\\€part2.doc-1014 
· Enable collaboration across the Web or with Exchange Server. Outlook 98 takes the Internet beyond Web pages and e-mail, enabling new ways to collaborate and share information across the Internet. For workgroups and enterprises, Outlook, combined with Exchange Server, is a complete solution for developing and deploying a wide variety of collaborative applications, from contact management solutions to enterprise-wide workflow and tracking applications. 

Users can incorporate the power of Outlook forms and views in enterprise-wide intranet applications based on HTML and other standard Internet protocols. Users can easily add VBScript to Outlook forms using the new find-and-replace feature in the script editor. They can create and distribute custom electronic forms using simplified design menus, and design a form simultaneously in design and run-time modes. Also, users can distribute third-party controls on Outlook forms.

Architecture

Outlook 98 provides the following advanced architectural features:

 xe "Architecture"\\€part2.doc-1015 
· Unified e-mail and personal information. Outlook combines e-mail and group scheduling in a single application with a single database. Therefore, users can go between their e-mail Inbox, Calendar, and other modules with a single mouse click. A single command replicates and synchronizes all e-mail folders, public folders, calendars, and personal information. 

Commands for sorting and filtering information are the same in all modules, so users can perform tasks, such as dragging and dropping or searching for items, across different modules. For example, users can drag an e-mail message to the Calendar to convert the message into an appointment; a single search can return all related messages, appointments, tasks, and contacts.

 xe "Views:support for multiple types of views"\\€part2.doc-1016 
· Support for multiple types of views. Outlook offers a wide variety of view types in a single application with common commands for displaying, filtering, sorting, and grouping information regardless of view type. Using any of the five types of views—table, calendar (day/week/month), card, icon, and timeline—users can customize their information into an unlimited number of personal or shared views. For example, users can browse a Calendar list of annual events in a table view, or they can apply a calendar view to their Sent Mail folder to organize messages by the date they were sent.

· New capabilities for designing custom forms and collaborative solutions. The central elements of custom information-sharing solutions are views and forms. With the Outlook form design tool, users can customize any built-in form or build entirely new forms. Built-in Outlook forms and views can be used with no changes, with minor changes, or as the building blocks for information-sharing or collaborative solutions. Designers can create shared custom views in an Exchange Server public folder; users can also create private views of public folders. 

Custom Outlook forms are 32-bit and support many features necessary for workgroup computing, including security, custom actions, data validation, calculated fields, and number formatting. Developers can extend their custom forms using Visual Basic Scripting Edition (VBScript) and ActiveX™ Controls. Also, with Exchange Server, users of Outlook Web Access or other Web-based applications can automatically use Outlook views in a Web browser.

 xe "Collaboration standards support"\\�part2.doc-1018 
· Support for Internet messaging, scheduling, and collaboration standards. Recognizing customers' concerns about the profusion of e-mail, security, and calendar standards, Outlook simplifies the choices by supporting all commonly used Internet messaging, directory, security, scheduling, and collaboration standards. Microsoft continues to drive creation and adoption of Internet standards in the messaging and collaboration industry, and is working with a variety of companies and consortiums to create standards and products that meet the needs of businesses. For a description of standards supported by Outlook, see the following section.

This combination of architectural elements and a focus on the everyday activities of users makes Outlook a powerful, flexible, and easy-to-use tool for organizing and communicating information. 

What's New for Administrators in Outlook 98

Outlook 98 includes many new features and enhancements that make system administration smoother and easier. Administrators can take advantage of the following features:

 xe "Administrative features"\\€part2.doc-1020 
Optimized installations. Because there are many ways to send and receive e-mail, Outlook lets users optimize their installations to best fit the way that they work. Many customers use only an Internet service provider (ISP) for their e-mail or an Internet-standard server (such as POP3/SMTP or IMAP) in their enterprises. These businesses can easily configure Outlook for optimal performance with a complete feature set for Internet e-mail.

Multiple POP3 or IMAP4 e-mail accounts and LDAP directory accounts can be managed easily using an Internet Only configuration. For example, users who have one Internet account at work and another account with an ISP for personal use can have messages from both accounts delivered conveniently to their Outlook Inbox.

Administrators can also optimize Outlook for corporate and workgroup users who work with Exchange Server, Microsoft Mail, or other third-party mail systems in addition to, or instead of, Internet mail. Some users may want to use Outlook's extensive contact, task, and schedule management features without any e-mail at all, and administrators can optimize Outlook for this scenario as well.

Two separate e-mail configurations are necessary to accommodate the architecture and protocol requirements of both Internet mail, and Microsoft Exchange Server and other Corporate/Workgroup mail servers. The MAPI service provider architecture was designed to optimize performance for Outlook users who connect to MAPI servers (such as Microsoft Exchange Server) across a LAN. For Outlook 98, a separate solution was required to provide the highest level of performance and features for users who want to access and use Internet Mail and directory servers, which support protocols such as LDAP, IMAP4, and SMTP/POP3.

After setup, users can choose a different configuration as their needs change. For example, they can switch from a "No E-mail" configuration to an "Internet Only" configuration just by adding an e-mail account. Switching from "Internet Only" to a "Corporate or Workgroup" installation is easily done using the Add Components Web page.

 xe "Outlook 98 Deployment Wizard:overview"\\€part2.doc-1022 
Outlook 98 Deployment Wizard. The Outlook 98 Deployment Wizard gives administrators a variety of options for pre-configuring setup, including a choice of standard and custom components that can be installed, the ability to add customized configuration files for the Outlook Bar and Outlook toolbar and menus, and also the option to preset user preferences, privileges, and profiles. The wizard automatically detects previous versions of Microsoft and other e-mail clients, and uses this information to optimize and simplify the users' configuration of Outlook. For Internet Mail users, the wizard also detects existing account information, such as Internet mail accounts or MAPI profiles, and automatically configures Outlook to use those accounts.

Also, for Internet Mail users, switching from other e-mail clients is simple because the setup process automatically imports messages and address book information from Outlook Express, Eudora, and Netscape mail products. Outlook Express Inbox Assistant rules are also imported automatically. For more information about wizard features and functions, see Chapter 2, "Installation and Configuration."

Outlook uses Microsoft's innovative Active Setup technology, which is also used to install Internet Explorer 4.01. Active Setup is an efficient modular setup engine that optimizes network connection time by downloading only the initial install engine and identifying any potential problems (such as insufficient disk space) before downloading any application components. Active Setup also detects server problems during installation and seamlessly switches to a new server.

User preferences, privileges, and profiles. Administrators can customize all user settings defined in the Outlook administration (.adm) file, such as the e-mail editor, work calendar, level of journaling, and file format converters. You can also use the wizard to preconfigure MAPI profile settings (which replaces manual editing of .prf files). Administrators can take advantage of new settings for Outlook 98, including the following:

· Offline store synchronization. Outlook enhances offline synchronization (OST) by adding background synchronization and automatic OST setup. In conjunction with Exchange Server, users store messages, calendar data, and other information on the server, where it's secure and can be shared. Users can also work with a synchronized copy of that same data in Outlook when they are not connected to the server. When users are back online, the offline folders (does not include default folders) are synchronized automatically with the information stored on Exchange Server.

· S/MIME options. Administrators can specify the minimum key length for users or alternately, disable S/MIME capabilities altogether. Specifying a minimum encryption length enforces a minimum level of security. Administrators may want to disable S/MIME if some users cannot read S/MIME-encrypted messages (for example, if all users have not yet been migrated to Outlook 98); then, administrators can enable this option for users at a later time.

· Junk e-mail management. Microsoft has analyzed thousands of pieces of junk mail and has developed filters that identify commercial bulk mail and mail suspected of having adult content. Administrators can use the Outlook 98 Deployment Wizard to define settings that protect their users from these types of commercial mass-mailings. Also, Outlook allows additional plug-ins for new junk e-mail filters if commercial junk e-mailers attempt to work around the current filter.

 xe "Internet Explorer:integration with Outlook 98"\\€part2.doc-1027 
Integrated Microsoft Internet Explorer features. You can choose to customize Internet Explorer as part of your Outlook installation. The wizard enables you to customize browser preferences, including Active Desktop™ components, desktop toolbar settings, and proxy settings. You can also choose whether to install the Windows Desktop Update.

Important: Customers using Internet Explorer version 3.0 are automatically upgraded to version 4.01 when they install Outlook.

In addition to continuing the tight integration of Outlook 97 with the Microsoft Office suite, Outlook 98 and Internet Explorer 4.01 offer the convenience of tightly integrated features, including the following:

· The ability to start Outlook from the Internet Explorer Quick Launch toolbar and Go menu

· The option of sending mail and creating contacts from Internet Explorer

· The ability to send a link to the currently viewed Web page or send the entire Web page as 
MHTML e-mail

· Common user interface elements

· Shared HTML rendering with industry-leading support of advanced HTML features, such as dynamic HTML

· Real-time meetings using NetMeeting, which can be scheduled using Outlook

Alternately, you can install Outlook without changing your default browser; Setup installs only the minimum number of Internet Explorer files needed to run Outlook (for example, Outlook uses the Internet Explorer 4.01 editing and rendering engine for HTML mail). You can even hide Internet Explorer icons, if you want (unless Internet Explorer is already installed).

 xe "Security model"\\€part2.doc-1028 
Security. Outlook 98 uses a security model that is different from that of the previous Outlook 97 and Exchange clients. It uses a secure store for users' private key information. The .epf file is now used only to move security information between computers. Outlook will attempt to save security information safely in a secure or protected store. Then, users can associate a security level with their private key information. For Corporate or Workgroup configurations, private and public S/MIME keys are provided so that users can send signed mail and receive encrypted mail. For additional security information, see Chapter 4, "Customizing Microsoft Outlook 98 Features."

Internet standard support. Outlook fully supports all the key Internet standards in use today, including the following: 

 xe "POP3/SMTP support"\\€part2.doc-1030 
· POP3/SMTP. Post Office Protocol 3 (POP3) and Simple Mail Transport Protocol (SMTP) are the two most commonly used protocols for sending and receiving e-mail over the Internet. Outlook provides industry-leading support for POP3/SMTP, including full support for multiple Internet e-mail accounts, authenticated SMTP, distributed password authentication, and the ability to store messages on the server.

 xe "IMAP4 support"\\€part2.doc-1031 
· IMAP4. Internet Mail Access Protocol 4 (IMAP4) is an Internet standard for e-mail and server-based mail storage. IMAP provides a superset of POP/SMTP features, including the ability to store e-mail messages in multiple folders. Outlook supports IMAP4 for Internet Only configurations and provides full support for multiple IMAP4 e-mail accounts.

 xe "LDAP support"\\€part2.doc-1032 
· LDAP. Lightweight Directory Access Protocol (LDAP) is an Internet protocol that enables people to easily find other e-mail users on the Internet or corporate intranet. Currently, LDAP is being deployed as the primary means for searching the increasing number of global directories that are available on the Internet. Outlook supports LDAP fully, including multiple LDAP Internet information accounts. Administrators can specify LDAP settings for both Internet Only and Corporate or Workgroup configurations using the Outlook 98 Deployment Wizard.

 xe "Newsreader"\\€part2.doc-1033 
· NNTP—news reader. Network News Transport Protocol (NNTP) is used to post messages to Internet and intranet newsgroups or bulletin boards, as well as to distribute and retrieve messages. Outlook includes a full-featured Internet news reader (Outlook Express) that is shared with Internet Explorer 4.01. This newsgroup reader contains many innovative features for managing newsgroups, including filters to block unsolicited materials and the ability to download messages for offline reading and response.

 xe "HTML support"\\€part2.doc-1034 
· HTML and MHTML mail. Support for HTML and Multi-Purpose Internet Mail Extensions (MHTML) enables users to send and receive Web pages and other HTML documents using Outlook. HTML is the standard format for information on the Web. It can be used to create graphically rich e-mail messages that contain images and links to multimedia clips. Also, HTML mail enables users to send messages that maintain their formatting, even when they are read by other HTML mail clients. Users can easily specify the fonts, paragraph styles, and the reply style for mail. MHTML enables users to embed images directly into their e-mail messages, which can be sent to other people using applications that support MHTML. 

 xe "S/MIME support"\\€part2.doc-1035 
· S/MIME. Secure Multi-Purpose Internet Mail Extensions (S/MIME) help ensure the security of e-mail messages. The Outlook implementation of S/MIME includes digital signing, which allows users to verify the identity of the sender and the integrity of messages; it also includes digital encryption, which protects the contents of messages from being read by anyone except their intended recipient(s). Outlook supports up to 128-bit encryption in the North American release of the product. Users can exchange signed and encrypted mail with any other mail client that supports S/MIME. Outlook common key and certificate management features are shared with Internet Explorer 4.01. For Microsoft Exchange Server users, S/MIME provides support in addition to the existing Exchange Nortel security.

 xe "vCard support"\\€part2.doc-1036 
· vCard—Internet contacts format. vCard automates the exchange of personal and business information, such as telephone numbers and addresses, across networks. Outlook fully supports sending, receiving, importing, and creating vCards. 

 xe "vCalendar support"\\€part2.doc-1037 
· vCalendar—Internet appointments. vCalendar is an Internet standard that defines a platform-independent format for exchanging calendaring and scheduling information in a consistent way. With Outlook support for vCalendar, users can exchange important data about events and schedule meetings with other users who have vCalendar-supported programs. 

 xe "iCalendar support"\\€part2.doc-1038 
· iCalendar—Internet free/busy. iCalendar is an emerging standard for formatting and storing schedule information, such as free/busy data, which is used to invite attendees to meetings and events. Outlook implements an important part of the iCalendar standard, so users with the Outlook Internet Only configuration can share their free/busy information with other Internet users.

Note that Outlook continues to fully support MAPI, which enables a rich set of messaging, scheduling, and collaboration features when Outlook is used with Exchange Server. 

 xe "Outlook Today, customizing:overview"\\€part2.doc-1039 
Outlook Today. Outlook gives users the power to manage e-mail, calendar, and task information in one place. The innovative, new Outlook Today view gives users a customizable "day-at-a-glance" summary of upcoming meetings, tasks due, and e-mail messages—all without switching between windows. Users can choose to have Outlook Today displayed as the default view when they start Outlook 98 to quickly prioritize their work.

Outlook Today displays information using the familiar and attractive style of a Web page. The information in the view is hyperlinked, so users simply click any of the information in the view to see more details or to check off a completed task. Users can easily customize Outlook Today options, including the e-mail, calendar, and tasks that are displayed. Because the Outlook Today view is defined using HTML, administrators can also deploy a customized Outlook Today view that includes dynamic information specifically tailored for their company or workgroup. 

 xe "Custom forms:new capabilities for designing"\\€part2.doc-1040 
Customizing forms. Outlook makes it easier to customize standard forms. Users can modify the layout of the Contact form and tailor it for specific contact management needs. Also, Outlook offers the ability to use one common HTML-based form across multiple platforms (using an Internet information server and Outlook Web Access).

Numerous enhancements have been made to custom forms, including easier access to Outlook forms design tools and simplified menu commands for publishing forms. Outlook provides more consistent clicking behavior for all controls, including custom controls used on Outlook forms. Also, Outlook includes an integrated debugger for the VBScript that is associated with custom Outlook forms. Standard features, such as setting breakpoints and checking the values of variables, are supported. Outlook includes an object browser so that Outlook object model features are identified more easily. 

 xe "PIM import filters, obtaining"\\€part2.doc-1041 
Enhanced importing from other personal information management (PIM) applications. To help users migrate from other personal information management applications, the Import/Export wizard in Outlook has been enhanced to import information from three more programs: Ecco Pro 4.0, Lotus Organizer 97GS, and Act! 3.0. The wizard also helps users match field names in the source data with Outlook field names. Additional PIM import filters are available separately from DataViz Inc. For more information, visit http://www.dataviz.com. A number of third-party companies also provide tools for users to synchronize Outlook data with hand-held devices. For a complete list, visit the Outlook Web site at http://www.microsoft.com/Outlook/documents/thirdparty_addons.htm.

CHAPTER 2

Installation and Configuration

This chapter provides detailed instructions for installing and configuring Microsoft® Outlook™98 on Microsoft Windows® 95 and Windows NT®. Learn about the setup process and how to customize an installation for your user community.

Important: The complete Outlook 98 Deployment Kit (which includes the Outlook 98 Deployment Wizard, tools, utilities, and sample files described in this chapter) is available through Microsoft volume licensing programs and the Microsoft Developer Network (MSDN). It will not be available for download from the Web or through retail purchase.
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Setup Overview

 xe "Customizing Setup options"\\€part5.doc-1001 
For many situations, the flexibility available in the standard setup process is sufficient. In some cases, though, administrators can benefit from customizing the client installation process by using tools, such as the Outlook 98 Deployment Wizard, described in this chapter. For example, if you want to install a uniform configuration on all your Windows-based client computers, including a specific selection of converters, profiles, and templates, you can create a customized setup package by using the Outlook 98 Deployment Wizard.

There are three Outlook 98 Setup options:

· Create a non-custom client installation point.

· Add new components to Outlook 98. 

· Customize your installation using the Outlook 98 Deployment Wizard.

Note: Outlook 98 Setup uses new Active Setup technology, which does not support previous Run from Network Server and setup /a installation methods. 

Setting Up a Non-Custom Client Installation Point

 xe "Non-custom client installation point, setting up"\\€part5.doc-1002 
If you do not want to customize your installation (using the Outlook 98 Deployment Wizard), you can create a non-custom Outlook client installation point for Microsoft Windows 95 and Windows NT.

To set up a non-custom client installation point

1. Insert the Outlook client CD into the appropriate drive.

2. Drag the entire contents of the CD into a folder that you want to share on the network.

3. Share the folder.

4. Instruct users to connect to the shared folder and click Setup.exe to install Outlook 98.

Adding New Components to Outlook 98

 xe "New components, adding to Outlook"\\€part5.doc-1003 
You can use Active Setup to add default Outlook 98 components that were not installed during initial setup. Typically, this feature is used by people who did not run a full installation of Outlook 98.

To add default components that were not installed with the original setup configuration

1. In Control Panel, click Add/Remove Programs.

2. Click Microsoft Outlook 98, and then click Add/Remove.

3. Click Add New Components.

If the original installation was executed via an HTTP address, Internet Explorer opens the HTML-based Install Components Web page from the appropriate URL, which enables you to select from a list of components.

If the original installation was executed from the CD or a standard network connection, an additional dialog box prompts users to install from the CD/network installation point or from the Web. Installing from the CD/network installation point opens an HTML Web page from the installation CD or network location. Installing from the Web opens the HTML Web page from www.microsoft.com or a different URL (if you used the Outlook 98 Deployment Wizard to create a custom setup using a different HTTP address).

These options provide an alternative for users who install from CD—they can install from the CD, from their network installation point, or via an HTTP connection. Using the CD enables them to install Outlook 98 quickly from a local installation point, while installing from the Web may provide access to more recently released components if they become available.

Note: Removing individual components from your Outlook 98 installation is not supported in Outlook 98. 

Outlook 98 Deployment Wizard

 xe "Internet Explorer Administration Kit (IEAK_"\\€part5.doc-1004 
Use the Outlook 98 Deployment Wizard to create one or more customized Outlook 98 installations, which you can deploy to your user communities. The Outlook 98 Deployment Wizard enables you to easily customize, deploy, and maintain Outlook from one central location. Replacing both the Outlook 97 Network Installation wizard and manual editing of profile (.prf) and setup (.stf) files, this single, more powerful tool provides a comprehensive set of features for customizing your Outlook installation. You can control how Outlook is implemented by choosing the settings that best fit the needs of your organization. This tool also includes Internet Explorer Administration Kit (IEAK) customization features, so you can deploy Outlook 98 and the browser simultaneously, if you like.

The Outlook 98 Deployment Wizard uses new Active Setup technology. With Active Setup, the installation process is modular, which greatly improves the ease of installing Outlook 98, compared to previous versions. The process begins with a small Setup package; this single file is all that you need to start installing Outlook. Active Setup detects installed components that need to be updated, so your users don't have to download an entirely new package just to update one of the components.

Benefits

 xe "Outlook 98 Deployment Wizard:overview"\\€part5.doc-1005 
With the Outlook 98 Deployment Wizard, you have one easy-to-use tool for centrally managing Outlook 98 throughout your organization. Take advantage of these important benefits:

Optimizing Your Installation

 xe "Optimized installations"\\€part5.doc-1006 
Outlook can be used with a wide variety of e-mail servers and services, including standard Internet (SMTP/POP3 or IMAP4) mail servers, and Microsoft Exchange Server. Outlook can also be used without any e-mail server at all, for standalone contact, task, and schedule management. Because the capabilities of e-mail servers vary, there are differences in the features available in Outlook, depending on the e-mail server that you use. 

Outlook works with any SMTP/POP3, IMAP, or MAPI server, which covers a broad range of messaging services, from Internet service providers (SMTP/POP3 or IMAP) to LAN-based systems such as Microsoft Exchange Server (MAPI). Outlook can also be used with a variety of other messaging and information sources, including Microsoft Mail, Microsoft Fax, CompuServe®, Lotus Notes® and cc:Mail®, Hewlett-Packard® OpenMail, and Digital's ALL-IN-1™. Because Outlook uses the MAPI extensibility interface, interoperability with these additional service providers is possible.

Recognizing that there are many ways to send and receive e-mail, Outlook optimizes your installation to fit the way you work. The Outlook 98 Deployment Wizard optimizes your installation based on how you intend to use the product. There are three optimized installations:

 xe "Internet Only configuration"\\€part5.doc-1008 
· Internet Only. If you use an Internet service provider (ISP) for your e-mail or an Internet-standard (POP3/SMTP or IMAP) server in your enterprise, Outlook is installed with the Internet Only configuration at setup.

 xe "Workgroup configuration"\\€part5.doc-1009 
· Corporate or Workgroup. If you are a corporate or workgroup user who primarily works with Microsoft Exchange Server, Microsoft Mail, or another third-party LAN-based mail system (such as cc:Mail), but who also may use Internet mail, Outlook is installed with the Corporate or Workgroup configuration at setup.

 xe "No E-Mail configuration"\\€part5.doc-1010 
· No E-mail. If you use Outlook's extensive contact, task, and schedule management features without any e-mail at all, Outlook is installed with the No E-mail configuration at setup. 

If you choose the wizard default value, setup will always install the Corporate or Workgroup configuration. Also, administrators can select an option (User Choice) to let users choose their own configuration; then, Outlook asks users to specifically choose one of the configurations. Users can switch to another optimized configuration as their needs change. 

Outlook makes complete use of the e-mail, scheduling, and collaboration features available on the server that the product is used with, if any. However, different mail servers or services enable different sets of features. For example, POP3/SMTP, the most common type of mail service, does not allow users to manage and store e-mail messages in multiple folders on the server, whereas both IMAP4 and Microsoft Exchange Server enable this feature.

Used with or without a mail server, Outlook always provides powerful information management tools for contact, calendar, and task management. For a list of the features supported by each configuration, see the Microsoft Outlook 98 Features and Configuration Guide, which is available from the Outlook Web site at http://www.microsoft.com/outlook/.

Easily Deploy Your Customized Package

The wizard enables you to build customized installation packages and then distribute them company-wide or to specific groups of users. The wizard creates files for CD-ROM installations, which you can share out or copy to a network share for users to install. 

If you choose a silent installation (without user interaction), setup installs the software by using the values you specify within the wizard. If users install Outlook in interactive mode, the values you set with the wizard are presented as the default choices during installation. 

Customize Your Outlook Installation

 xe "Default installation options"\\€part5.doc-1012 
The wizard includes all the features and information you need to customize Outlook. Follow step-by-step through the wizard, and select the Outlook options you prefer. You can use the wizard to preconfigure setup options, including the following:

· The list of components that will be installed. Select from three default installation options—minimal, standard, and full—or create an installation with your own selected list of components. You can choose from over 20 Outlook components and create 10 custom installation options for different user groups within your organization. 

· User preferences, privileges, and profiles. You can customize all user settings defined in the Outlook administration (.adm) file, such as the e-mail editor, work calendar, level of journaling, and file format converters. The wizard also lets you preconfigure MAPI profile settings, which replaces manual editing of .prf files; also, existing profile settings are imported automatically. In addition to Outlook 98 options, you can customize Internet settings and restrictions, as well as Web desktop, Microsoft NetMeeting, and subscriptions.

· Custom components. Customizing the installation means that you can add other software products and components to the basic Outlook installation package. Add up to 10 of your own custom components, which can be either self-extracting (.exe) or compressed cabinet (.cab) files, as part of your customized package. For example, you can choose to customize Outlook Today and include it with your Outlook installation; see Chapter 4, "Customizing Microsoft Outlook 98 Features." 

· Internet Explorer 4.01 features. You can choose to customize Internet Explorer as part of your Outlook installation. The wizard lets you customize browser preferences, including Active Desktop components, desktop toolbar settings, and proxy server settings. You can also choose whether to install the Windows Desktop Update.

Alternately, you can install Outlook 98 without changing your default browser; setup installs only the minimum number of Internet Explorer files needed to run Outlook. You can even hide Internet Explorer icons, if you want.

· Outlook Bar and Outlook toolbars and menus. Add your own pre-configured files to customize the Outlook Bar (Outlbar.inf) and Outlook toolbars and menus (Outcmd.dat) settings. Sample files are located in the \Program Files\ODK\Olbin\En\Optional folder. For more information about customizing the Outlook Bar and Outlook toolbars and menus, see Chapter 4, "Customizing Microsoft Outlook 98 Features."

Installing the Wizard

 xe "Installing:Outlook 98 Deployment Wizard"\\€part5.doc-1020 
Install the Outlook 98 Deployment Wizard from your Outlook 98 Deployment Kit CD. 

To install the Outlook 98 Deployment Wizard

1. Insert your Outlook 98 Deployment Kit CD.

2. When the Autorun screen appears, select Install the Outlook 98 Deployment Wizard.

You will need 125 MB of free space available in the Program Files folder and on the destination drive.

Note: You must have Internet Explorer 4.0 (or later) installed before using the Outlook 98 Deployment Wizard. This version of the wizard works with Windows 95, Windows NT 4.0 Server, and Windows NT 4.0 Workstation Service 
Pack 3 (and later versions of these products). 

Preparing to Run the Wizard

 xe "Outlook 98 Deployment Wizard:preparing to run"\\€part5.doc-1021 
Before running the wizard, you should gather the information you will need, decide which custom components you want to include with your customized package, and create custom bitmaps.

· Decide how you will be distributing your customized package (by compact disc or server download). After the Outlook 98 Deployment Wizard builds your package, you will need to move the files to the selected media. If you build a downloadable package, you must move the package to the appropriate place on your server.

Note: If you decide to publish your customized package to an intranet server, you need to gather the path to the server from which users will download the files. Then create a folder on the server to publish all the files and folders associated with your customized package. For example, you might create a server path of \\appserver\customoutlook98.

· Create a folder on your hard disk or network drive for the custom bitmaps you will use.

 xe "CD installations"\\€part5.doc-1022 
· Make initial preparations for signing certain files, such as customization files created by the wizard and any custom components. With security features, users are warned or prevented from downloading files that are not signed. Digital signatures identify the source of programs and guarantee that the code has not changed since it was signed. For silent installations, users' computers must already have installed the certificates that you are using to sign programs. 

Signing the cabinet files and custom programs requires two steps: obtaining a digital certificate from a certificate authority (CA), such as Verisign or GTE, and signing the code. For more information, see "Stage 2: Specify Trusted Publishers" in this chapter. 

If you intend to distribute your customized package on a CD-ROM, create the following directory structure:

Folder Name
Description

\CD
Parent root for all files

\CD\Bitmaps
Custom bitmap files (graphics files needed for your customized package)

Also, create a bitmap for the Autorun screen. If you plan to distribute your customized package on a compact disc, you'll need to create bitmaps as part of the Autorun screen that is displayed after the user has inserted the CD. 

The custom backgrounds and buttons are displayed only on computers with 256-color (8-bit) display capabilities. On computers with 16-color (4-bit) display capabilities, a standard low-resolution background bitmap and button set are displayed.

· Decide which type of e-mail service options you want for your users: either Internet only, Corporate or Workgroup, No E-mail, or User Choice. Also, decide whether you want to use the Outlook Calendar or Microsoft Schedule+ for group scheduling.

· Create custom Outlook toolbars and menus and Outlook Bar configuration files, if you want to customize your standard settings. For more information about customizing these files, see Chapter 4, "Customizing Microsoft Outlook 98 Features."

· Determine any additional registry entries you want to include with your customized package.

· Plan your security strategy. You can customize and control many user options, such as Internet Explorer Security. You should plan your strategy before you run the wizard. For more information about customizing Outlook security, see Chapter 4, "Customizing Microsoft Outlook 98 Features."

The Five Stages

 xe "Outlook 98 Deployment Wizard:summary of stages"\\€part5.doc-1030 
After you install the wizard, click Outlook 98 Deployment Kit (on the Start menu, point to Programs, and then click Microsoft ODK) to begin creating your customized package. You will progress through the wizard's five setup stages:

· Stage 1: Gathering Information 

· Stage 2: Specifying Active Setup Parameters

· Stage 3: Customizing Active Setup 

· Stage 4: Customizing Outlook 98 Setup Options and Internet Explorer

· Stage 5: User Settings Customization

The following sections describe each of these five stages.

Starting the Wizard

 xe "Outlook 98 Deployment Wizard:starting"\\€part5.doc-1031 
The Outlook 98 Deployment Wizard guides you through a series of pages and options. The first page introduces the wizard and describes the five stages that you will complete. You proceed to the next page by clicking Next, and you can go back to the previous page by clicking Back. The Setup files are not modified until you click Finish, so you can go back and change any answers before you complete the final page. 

You can quit the Outlook 98 Deployment Wizard at any time by clicking Cancel.



Stage 1 Overview: Gathering Information

After the initial Welcome page, the Outlook 98 Deployment Wizard introduces Stage 1. In this first stage, the wizard prompts you for the following information:

· Your company name and CD key.

· The language of the customized package that you are creating.

· The destination folder for creating your customized package. 

Stage 1: Enter Company Name

 xe "CD key"\\€part5.doc-1033 
Type your company name and also the CD key, which you received with your Outlook 98 Deployment Kit CD. Based on the CD key that you enter, the wizard generates a product identification code. Every customized package created by the wizard includes this product identification code and your company name. When Outlook is installed, Setup prompts users for their names, but the company name and product identification code appear automatically based on the information you entered into the wizard. 

Note: For Select version CDs, you do not type a CD key; the product identification code is displayed automatically. 



Stage 1: Select a Language

 xe "Language, specifying"\\€part5.doc-1034 
Choose the language you want from the Target language list. If the language you want to use is not listed, quit the wizard, use the Odklang.exe tool to install the language files you want to use, and then restart the wizard.



Odklang.exe, located in the \Program Files\ODK\Tools folder, is a tool that enables you to create customized packages in languages other than English. When you run this standalone tool, all of the .cab files from your language version of the Outlook 98 client CD are copied to the appropriate ODK directory and modified, as necessary. 

For example, if you want to create a customized package in Italian, you will need both the English version of the Outlook 98 Deployment Kit CD and the Italian version of the Outlook 98 client CD. After installing the wizard, you would run the Odklang.exe tool to copy the Italian client files to the appropriate ODK directory. Then, when you run the wizard and choose Italian as the language, it would produce a customized package in Italian.

Stage 1: Select Location for Your Customized Outlook 98 Setup

 xe "Destination folder"\\€part5.doc-1035 
In this panel, you determine where the customized packages will be placed when the wizard is finished. The Outlook 98 Deployment Kit always produces a directory where your package will be available for downloading. 

The Destination folder is the location where you build your customized package. You can create the package on your hard disk and move it to an intranet server, or you can create it on the server. If you are creating the package on your hard disk or network drive, the recommended destination is C:\customoutlook. If you are creating the package on a server that is running from your hard disk, the destination should be the path to the server, plus \customoutlook. 

Subfolders for each localized version and the \CD folder are created in the destination folder you specify. For example, if you specify your destination folder as C:\customoutlook, the English language version would be created in the C:\customoutlook\CD\EN folder. 



Stage 2 Overview: Specifying Active Setup Parameters

 xe "Active Setup:specifying parameters for"\\€part5.doc-1040 
In the second stage of the wizard, you will:

· View a list of available components. 

· Specify any custom components you want to include with your customized package. 

· Specify trusted publishers for signing your customized package.

Stage 2: Component List

 xe "List of components"\\€part5.doc-1041 
The wizard analyzes Outlook, Internet Explorer, and other components on your computer. On this panel, you can review a list of available components. In stage 3, you can choose the components that you want to include with your customized package. 



The status of each component is indicated as follows:

· Green check mark — The latest version of this component has already been installed.

· Yellow exclamation point — While the wizard analyzes the components on your computer, a status message identifies its progress.

· Red X — This component is not currently installed. You should reinstall the Outlook 98 Deployment Kit. If you still receive this red symbol, contact Microsoft Technical Support.

Stage 2: Specify Custom Active Setup Components

 xe "Custom Active Setup components, specifying"\\€part5.doc-1042 
You can add up to 10 custom components that your users can install at the same time that they install Outlook. These components can be self-extracting executable (.exe) files or compressed cabinet (.cab) files.

It is recommended that you sign any custom code. Code-signing lets users know that they can trust your code before installing it on their computers. The default settings in Setup (and Internet Explorer) will reject unsigned code. 



 xe "GUIDs, specifying"\\€part5.doc-1043 
Type values for the following fields.

Field
Description

Component
Type the name of your component in this box. 

Location
Type the path to your program, or click Browse to search for it. 

Command
If you specify a .cab file, you must also specify a command to run it.

GUID
If your program already has a globally unique identifier, or GUID, type it in this box. If your program doesn't have a GUID, then click Generate to assign a GUID. A GUID establishes a unique identity for programs, objects, and other items. 

Parameter
You can specify any switches to run with your program.

Size
Type the size (in KB) of your program. 

Version
The version number helps you track versions of your program and ensure that the latest version is installed. 

Uninstall key
This is the registry entry, or key, for your uninstall program. Registering your uninstall program enables users to remove your program by using Add/Remove Programs in Control Panel. To register your uninstall program, add the entries for your application to the Uninstall subkey. 

HKEY_LOCAL_computer\Software\Microsoft\Windows\
CurrentVersion\Uninstall\ApplicationName\UninstallString

ApplicationName = the display name of your program
UninstallString = path [ switches ] 

Both the ApplicationName and UninstallString values must be supplied and be complete for your uninstall program to appear in Control Panel. The path you supply to UninstallString must be the complete command line used to carry out your uninstall program. The command line you supply should carry out the uninstall program directly rather than from a batch file or subprocess. 

Verify
Programs installed over the Internet typically need "digital signatures" that identify their source and guarantee that the code has not changed since it was signed. Depending on safety settings, users can be warned before the program is downloaded. Certificate authorities can supply public and private keys needed to sign code. To determine whether the program has been digitally signed, click Verify.

Stage 2: Specify Trusted Publishers

 xe "Trusted publishers, specifying"\\€part5.doc-1044 
When creating customized packages, you should sign the custom cabinet (.cab) files created by the wizard before you post them to an intranet. Signing the .cab files and custom programs requires two steps: obtaining a digital certificate and signing the code. 

Digital signatures show where programs come from and verify that they have not been altered. Certificates are obtained from one of two sources: a certificate authority (CA), such as VeriSign or GTE, can provide certificates, or a privately controlled certificate server can issue certificates. You must accept the certificate on your computer. The wizard prompts you to select the publisher certificates you will use to sign the files in your package. 



After obtaining a certificate, you will need to sign the code. Tools for signing code, such as the Code Signing wizard (Signcode.exe), are available in the \Program Files\ODK\Reskit\Addons\Tools folder. You should digitally sign your customized package and any custom programs to ensure that users do not receive warnings during installation. For more information about signing code, see the Microsoft Security Advisor Web site at http://www.microsoft.com/security/.

After you create your customized package, you must sign the following files:

· Branding.cab 

· Chl<xxxx>.cab 

· Desktop.cab 

· Folder<n>.cab 

· Outcif.cab 

· Setup.exe 

Stage 3 Overview: Customizing Active Setup

 xe "Active Setup:customizing"\\€part5.doc-1050 
In the third stage of the wizard, you determine the way that Setup appears and works:

· Customize the CD-ROM Autorun screen, if you are creating a CD-ROM package.

· Customize the components installation title, which names your group of custom components. 

· Determine if you want to install the package "silently," with few or no prompts to the user; also decide whether you want to hide Internet Explorer icons.

· Specify up to 10 installation options, such as Standard and Full, and determine which components to include with each option.

· Specify a unique version for your customized package; this setting ensures that later versions are updated correctly.

· Specify where you want Outlook to be installed on your users' computers.

· Specify whether you want to integrate the Windows Desktop Update functionality into your users' desktops and folders.

Stage 3: Customize the Autorun Screen for CD-ROM Installations

 xe "Autorun screen, customizing"\\€part5.doc-1051 
If you are creating a CD-ROM version of your customized package, you can create an Autorun screen that is displayed when the user inserts the CD into the drive. If you include an Autorun screen, you can provide a background bitmap and labels for two buttons: one for installing Outlook and one for displaying more information. You can also customize the title bar and the text color.



Type values for the following fields.

Field
Description

Title bar text
This text appears in the title bar of the Autorun screen. 

Custom background bitmap location
You can provide a bitmap that appears behind the text. Make sure the background color doesn't conflict with the text color. 

Standard text color
This setting determines the color of any text that isn't part of a link. This setting defaults to a preset Outlook color.

Highlight text color
This setting determines the color of the links on the page. This setting defaults to a preset Outlook color. 

Button style
You can determine the appearance of the buttons that users click to install Outlook and to get more information. 

· Standard beveled buttons are similar to the ones that appear in standard software programs.

· 3-D bitmap buttons have a three-dimensional appearance.

· A custom button bitmap is based on a bitmap that you supply. To locate the path for the image, click Browse. The image should be a 256-color bitmap that is 540 by 357 pixels. 

Stage 3: Custom Components Install Section

 xe "Custom component groups, naming"\\€part5.doc-1052 
If you provide a group of custom components in Stage 2 of the wizard, you can assign a name to them. If you have specified more than one custom component, you can name them as a group (for example, Volcano Coffee Company Inventory Programs). This name appears in the Active Setup wizard when your users install the customized package. Type the title you want to appear. 



Stage 3: Select Silent Install and Hide Icons

 xe "Hiding Internet Explorer icons"\\€part5.doc-1053 
If you want your users to install the customized package without receiving prompts, click Install package silently. You should select this option when you want to control setup options for your users and you want all types of installation (such as Minimal, Standard, or Full) to be the same. Typically, System Management Server (SMS) is used to deploy a silent installation; for more information about SMS, see "Using Microsoft Systems Management Server" in this chapter.

Selecting this check box is the same as installing Outlook with the /Q switch. In a silent install you can specify only one installation option for your users. This mode is not interactive, and users will not have control over its progress. The user will not be prompted with an error message in the case of installation failure. You might consider using this feature for installations deployed to users "after hours" instead of when the user is present. To fine-tune the installation, you can use additional setup command-line switches. For a list of valid switches, see Appendix B, "Setup Command-Line Options."

Using the wizard and choosing the Install package silently option, or using the /Q switch with an non-custom Outlook 98 installation does the following:

· Answers prompts that enable Setup to continue. 

· Accepts the license agreement.

· Carries out the type of installation that you specify (such as Minimal, Standard, or Full). You will set this option later in the wizard.

· Installs Outlook in the location you specify. If Outlook is already installed, however, the newer version will be installed in the same location.

· Installs the e-mail service option that you select.

· Installs your custom Outlook Bar and Outlook toolbars and menus settings, if you choose to customize the standard choices.

· Adds any additional registry entries that you specify.



Select the Prevent Internet Explorer icons from appearing on user's desktop option to prevent the Internet Explorer icons from appearing on the user's desktop and Start menu. Administrators may want to select this option if a default browser other than Internet Explorer is installed. The wizard will install the minimal number of Internet Explorer files required by Outlook, but Internet Explorer will not be apparent from the user's desktop. 

Stage 3: Select Installation Options

 xe "Installation options, specifying in the wizard"\\€part5.doc-1054 
You can specify up to 10 installation options, such as Standard and Full, and determine which standard and custom components are installed with each. At a minimum, you must install Outlook core components and Internet Explorer minimum browser components. If you have specified a silent installation, you can choose only one installation option.

Select the default installation option you want, or click New to create a new Setup option. Type the description for the option, and then add or remove the components you want by clicking the arrows. As a corporate administrator, you might want to specify Setup options for different branches of your company.  



Stage 3: Select Version Information and Add-on Component URL

 xe "Configuration identifier"\\€part5.doc-1055 
The options on this panel ensure that the correct build of your customized package is always installed. The Version number increments each time you run the wizard. It enables you to ensure that only the latest version of each customized component and feature is installed. It prevents a user from installing an earlier version of your customized package. This version number appears in the registry, and does not affect file versions.

The Configuration identifier is an 8-digit code that identifies your customized version. Using this code can prevent the user from installing a previous version over a newer version of your customized package. For the configuration identifier to prevent an earlier version from being installed, the company name for both packages must be the same. You specified the company name in Stage 1 of the wizard. 



When a new version of Internet Explorer is available (and Internet Explorer is the default browser), users can update Internet Explorer components by clicking the Internet Explorer Help menu and then clicking Product Updates. The default location for obtaining product updates is Addon95.htm. If you want users to obtain software updates from another location, specify a different URL in the URL of the Internet Explorer Components Download page box. Users will also see this page when they double-click Add/Remove Programs in Control Panel, click Microsoft Internet Explorer, and then click Add/Remove. 

Stage 3: Specify Where You Want to Install Outlook 98

 xe "Location of Outlook installation, specifying"\\€part5.doc-1056 
You can specify where you want Outlook and other components to be installed. If you click Install in the specified folder within the Windows folder or Install in the specified folder within the Program Files folder, Outlook will be installed in the subfolder shown in the box.

If you select the Specify the full path of a custom folder option, you can type the path you want. If the path you specify does not exist on the user's hard disk, it will be created. If you select this option and do not specify a path, users will be able to type their own.



Stage 3: Integrating the Windows Desktop Update

 xe "Windows Desktop Update"\\€part5.doc-1057 
The Windows Desktop Update makes the desktop and folders look and work more like the Web. It is a component of Internet Explorer that can be installed separately from the browser. You can determine whether or not the Windows Desktop Update is included in your customized package.

To install the Windows Desktop Update, click Yes. If you do not want to install it, click No. Later in the wizard, you can customize settings for the desktop and determine whether users can change these settings.

When the Windows Desktop Update is installed, users can browse their computers just as they browse the Web, and they can browse the Web from nearly anywhere on their computers. They can also add "active content," such as a stock ticker, to the desktop, taskbar, or folders. And, they can single-click files to open and run them.



Stage 4 Overview: Customizing Outlook 98 Setup Options 
    and Internet Explorer

 xe "Setup options, customizing"\\€part5.doc-1060 
In the fourth stage of the wizard, you can customize the following Outlook settings:

· E-mail Service Options. Choose Internet Only, Corporate or Workgroup, No E-mail, or User Choice.

· Microsoft Schedule+ support. You can decide whether to use Schedule+ or Outlook for group scheduling.

· The Outlook Bar and Outlook toolbars and menus. Use your own customized configuration files.

Also, you can customize the following browser settings:

· Customize Internet Explorer or use default settings. If you choose to customize Internet Explorer, the subsequent wizard panels in Stage 4 enable you to do so.

· The browser title bar and toolbar background bitmap. When you select a bitmap, make sure that the colors contrast with text.

· Start, search, and online support pages for the browser.

· Favorites, Favorites folders, and links for the Links bar. The maximum number of favorites or links you can add is 200; semicolons and slashes are not allowed in the titles.

· The Welcome message and desktop wallpaper.

· The Active Channel bar. You can set up channels on your computer and then import them as the corporate standard.

· Software distribution channels. A software distribution channel is an automatic way to update software on a user's computer using new channel, or Webcasting, technology. 

· Active Desktop components. Add these components if the Windows Desktop Update is installed.

· Desktop toolbar settings. You can import the desktop toolbar settings from your own computer as the standard for your company.

· My Computer and Control Panel. Specify your own Mycomp.htt and Controlp.htt files.

· A user agent string. A user agent is optional; it's a way to track the usage of your customized browser.

· Automatic browser configuration. You can provide a path to files that configure your browser automatically.

· Proxy settings.

· Settings for site certificates and Authenticode™ security.

· Settings for security zones and ratings.

Stage 4: Choose E-mail Service Options

Choose one of four e-mail service options:

· Internet Only. Outlook will use only Internet standards for e-mail delivery. If you choose this option, you must also select your Previous mail application on this panel. Also, you can configure other Internet options, such as POP3 and LDAP servers, in Stage 5 of this wizard.

· Corporate or Workgroup. Outlook will be configured to connect to Microsoft Exchange, Microsoft Mail 3.x, third-party e-mail services, or any combination of these, as well as Internet mail. This option automatically imports any available profiles. If you choose this option, subsequent panels will configure other workgroup options, such as whether to use Schedule+ for group scheduling. 

· No E-mail. Outlook will not be set up to read e-mail. 

· User Choice. Users can choose their own e-mail service option during Setup. Administrators may want to choose this option when more than one of the other e-mail service options (Internet Only, Corporate or Workgroup, and No E-mail) apply to their user community.



Users can change their e-mail service options by using Add Components; see "Adding New Components to Outlook 98" in this chapter.

Stage 4: Configure Schedule+ Support

 xe "Configuring Outlook:Schedule+ support"\\€part5.doc-1062 
In Outlook 98, you can substitute Microsoft Schedule+ for the Outlook calendar function. This screen appears only if you choose Corporate or Workgroup as your e-mail service option on the Choose E-mail Service Options screen. 

If you click Yes, users will continue to use Schedule+ as their calendar, rather than switching to the Outlook Calendar. If you click No, Outlook will provide both mail and calendar support. In a mixed environment where both Outlook and Schedule+ are used for group calendaring, all users can continue to exchange meeting request messages and share free/busy status with each other. For more information about Schedule+ interoperability, see Chapter 3, "Interoperability."

Important: If you choose Schedule+ for group scheduling, Schedule+ 95 must be installed and working on the computer before Outlook is installed.  



Stage 4: Customize the Outlook Bar and Command Bar Settings

 xe "Customizing toolbars and menus:specifying custom configuration files"\\€part5.doc-1063 
Type the path to your custom configuration files for the Outlook Bar (Outlbar.inf) and Outlook toolbars and menus (Outcmd.dat), or click Browse to locate the files. For more information about how to customize the Outlook Bar and the Outlook toolbars and menus, see Chapter 4, "Customizing Microsoft Outlook 98 Features."

Important: Test your custom configuration files before including them in your customized package. Incorrectly customized or corrupted configuration files will prevent Outlook from starting. 



Stage 4: Customize Internet Explorer

 xe "Internet Explorer:customizing"\\€part5.doc-1064 
If you click Yes to accept the Do you want to customize Internet Explorer? option, you will continue through a series of panels that enable you to configure Internet Explorer features and settings, such as toolbars, titles, welcome messages, favorites, and support pages. If you click No, you will go directly to Stage 5 of this wizard. 



Stage 4: Customize the Window Title and Toolbar Background

 xe "Window title, customizing"\\€part5.doc-1065 
You can customize the text that appears in the title bar of the Internet Explorer Web browser and Outlook Express, if you include Outlook Express in your package. Select the Customize title bars check box, and then type the text you want in the Title bar text box. It will be added after the text "Microsoft Internet Explorer Provided by" or "Outlook Express Provided by."

Also, you can specify a custom toolbar bitmap. This bitmap is displayed as a backdrop behind the buttons and drop-down menus. The background should be the size of the toolbar and light enough to show black text.



Stage 4: Customize the Start and Search Pages

 xe "Start page, customizing"\\€part5.doc-1066 
The home page, sometimes known as a start page, appears when the user clicks the Home button. Internet Explorer can show a default home page, or you can specify a URL for your own page. Enter the URL that you want in the Home page URL box, and then click Test URL to ensure that it's correct. To have Internet Explorer use its default URL, click Use Default.

The search page appears in a pane called an Explorer bar. This pane enables the user to see the search query and search results at the same time. The page that appears in the pane comes with a choice of search engines. You can overwrite this page if you want by typing a different URL in the Search Pane URL box.



Stage 4: Specify an Online Support Page for Your Browser

 xe "Online support page, specifying"\\€part5.doc-1067 
In Internet Explorer, a support page is available by clicking the Help menu and then clicking Online Support. It's recommended that you develop a support page, and make it available to your users. Enter the URL of your custom support page in the Online support page URL box, and then click Test URL to 
test it. 



Stage 4: Favorites Folder and Links Customization

 xe "Favorites folder, customizing"\\€part5.doc-1068 
You can customize the Favorites folder and Links bar by adding links to sites related to your company or services. The Links bar appears by default at the top of the user's screen, and it comes with a set of default links. You can add links to the default folders, or add new folders. When the user clicks Favorites, the Favorites bar appears on the left side of the window.

To add a folder to the Favorites list or Links bar, in the Favorites bar, click Favorites, Links, or a folder underneath Favorites or Links, and then click Add Folder. In the Name box, type the name of your folder. This can be a friendly name that helps users recognize what kind of links are in the folder. You can add up to 200 links to the Favorites folder.

Note: You can import a folder containing links by clicking Import, or you can click an existing folder to create a new subfolder.

To add a URL to the Favorites list or Links bar, in the Favorites bar, click Favorites, Links, or a folder underneath Favorites or Links, and then click Add URL. In the Name box, type the name of your link. This can be a friendly name that helps users recognize what the link refers to. Then, type the path of your link in the URL box.



Stage 4: Customize the Welcome Message and Desktop Wallpaper

 xe "Desktop wallpaper, customizing"\\€part5.doc-1069 
Internet Explorer displays a welcome page when the browser is first started. You can display the default Internet Explorer Welcome page, specify the URL of your own custom welcome page, or choose not to display a welcome page at all. The welcome page is not the same as the home page, which is the page that opens when you start your browser after the first time and when the user clicks the Home button.

The Disable Internet Explorer Welcome window option disables the Welcome window that appears when users start Internet Explorer for the first time. The Welcome window gives users a quick tour of Internet Explorer, including online registration. This option is turned on by default.

You can customize the users' desktop by specifying a .bmp, .gif, or .htm file in the Path of custom desktop wallpaper file box. Later in this stage, you will have the option of importing your desktop settings. The file you specify here will be displayed on users' desktops, even if you import your settings and your settings are different. The file you specify here cannot have the same name as the wallpaper currently on the users' desktops. 



Stage 4: Customize the Active Channel Bar

 xe "Channels, customizing"\\€part5.doc-1070 
As a corporate administrator, you can customize the Web channels that are included in your package. You can set up channels on your computer and then import them as the corporate standard. For example, you can set up channels that provide content pertinent to your company, or remove channels that are not pertinent.

In Stage 5 of this wizard, you will have the opportunity to determine whether users can customize the channels on their computers. If you don't want to customize channels on users' computers, click Do not customize channels.

In this step, you can import your current channel configuration by clicking Import current channel configuration. Or, without quitting the wizard, click Launch Channel Guide to set up channels as you typically would, and then import the settings.



Stage 4: Customize Software Update Channels

 xe "Customizing software update channels"\\€part5.doc-1071 
A Software Distribution Channel enables automatic software distribution over the Internet or an intranet. A software update, such as a new ODK package, can be posted to a server, and then users can be notified of the update, or the software can automatically be "pushed" to their computers.

You can set up Software Distribution Channels on your computer, and then import them into the wizard. Subscription information will also be imported. Subscription information can be critical for managing server loads when people download programs.

You can import your current settings by clicking Import current Software Distribution Channel configuration. If you do not want to customize distribution channels, click Do not customize Software Distribution Channels. If a schedule is not specified in the .cdf file for the channel, you can specify the distribution schedule by clicking Schedule.



Stage 4: Specify Active Desktop Components

The Active Desktop interface enables users to put Web content on their desktops, such as weather maps that update on a regular schedule. You can import the settings on your desktop as the corporate standard, so that all users have the same desktop. In Stage 5 of the wizard, you can determine whether users can change these settings. You must include the Windows Desktop Update in your browser package to specify Active Desktop components.

To use your current settings as the standard desktop for your company, click Import the current Active Desktop components. To modify your current settings so you can import them, click Modify Settings. If you don't want to customize users' desktops, click Do not customize the Active Desktop.



Stage 4: Customize Desktop Toolbars

 xe "Desktop toolbars, customizing"\\€part5.doc-1073 
With the Windows Desktop Update installed, you can now add toolbars to your Windows taskbar, making it even easier to get to your programs, files, folders, subscriptions, and favorite Web pages. You can also position toolbars on any part of your desktop and resize them.

You can import your current settings by clicking Import the current desktop Toolbar settings. If you want users to have the default toolbar settings, click Do not customize Desktop Toolbars.

These four toolbars can be added where you want them:

· The Quick Launch toolbar provides shortcuts to several often-used features of Internet Explorer: the desktop, the Web browser, Outlook Express, and channels.

· The Address toolbar enables you to type a Web page address (URL) without first opening the Internet Explorer browser.

· The Links toolbar provides shortcuts to important Web sites (for example, www.microsoft.com) so that you can open them without first opening the browser.

· The Desktop toolbar contains all of the shortcuts on your desktop and organizes them in one convenient location.

In addition to the ready-made toolbars, you can create a toolbar from the contents of any folder. For example, you could create a Control Panel toolbar or a toolbar that displays icons for each of your monthly sales reports.



Stage 4: My Computer and Control Panel Web View Customization

 xe "Control Panel Web view, customizing"\\€part5.doc-1074 
You can customize how My Computer and Control Panel appear on your company's computers by customizing the files that serve as templates for them. Then if the user installs the Windows Desktop Update, My Computer and Control Panel can appear as Web pages. One reason to customize these folders is to provide instructions, a company logo, or links to support or corporate sites.

To do this, you would use the following template files:

· Mycomp.htt for My Computer

· Controlp.htt for Control Panel



If you have installed the Windows Desktop Update on your computer, these files are located in the C:\Windows\Web or C:\Windows\NT folder. You can open them using a text editor, such as Notepad or an HTML editor. Microsoft recommends that you make a backup copy of these files before working with them, so you can restore them to their original state, if needed.

There are several ways you can modify these files to suit your company's needs. You can add your own links or graphics, change colors, and even determine which contents (icons and file names) are displayed. For example, you could choose not to display the icons in Control Panel, but provide graphical buttons that the user could click for only those settings you choose to make available.

These files use ActiveX Scripting, such as JavaScript, JScript™, or Visual Basic® Scripting Edition (VBScript). The existing Mycomp.htt and Controlp.htt files, and other files related to the desktop (Folder.htt and Printers.htt) use JavaScript. You can modify some aspects of these files without scripting, or if you're familiar with scripting, you can add to or change the scripting to meet your needs.

If you want, you can provide an HTML file instead of modifying the .htt files. To do this, you need to change the associated PersistMoniker references in the registry to PersistFile, and point the references to your customized file. Note that editing the registry can cause harm to an operating system, and is be performed at your own risk.

Stage 4: User Agent String Customization

 xe "User agent strings, customizing"\\€part5.doc-1075 
Some companies track site statistics, such as how many times their content is accessed and by which types of Web browsers. User agent strings help identify the browser type.

The string you enter in the Custom string to be appended to User Agent string box is appended to the user agent string for the customized browser. You do not need to customize the user agent string unless you want to track the usage of your custom browser and you gather browser statistics from other Internet sites. Be aware that other companies that track site statistics will see the customized string.



Stage 4: Automatic Browser Configuration

 xe "Automatic browser configuration"\\€part5.doc-1076 
You can assign URLs to files that will automatically configure the customized browsers. This feature is helpful if you want to control the settings of several users from one central location.

You can also configure options by using .ins files, also known as ODK profiles. Using .ins files, you can include standard proxy settings. You can also specify script files in .js, .jvs, or .pac format that enable you to configure and maintain advanced proxy settings.

If you specify URLs for both automatic configuration and automatic proxy (auto-proxy), the auto-proxy URL will be incorporated into the .ins file. The correct form for the URL is http://share/test.ins.

To enable automatic configuration, carry out the following steps:

1. Select the Enable automatic browser configuration check box.

2. In the Auto-configure URL (.INS) file box, type the URL for the .ins file you want.

3. In the Auto-proxy URL (.JS or .PAC) file box, type the URL for the autoproxy script.

Also, you can specify the interval in minutes for the auto-configure feature. If you enter zero or do not enter a value, auto-configure will happen only when the user's computer is restarted. 



Stage 4: Specify Proxy Settings

 xe "Proxy settings, specifying"\\€part5.doc-1077 
You can specify which proxy servers your users connect to. A proxy server acts as a security barrier between your internal network (intranet) and the Internet, keeping other people on the Internet from gaining access to confidential information on your internal network. 

If you want to use proxy servers for any of the services listed under Proxy Servers, select Enable proxy settings.

Type the address of the proxy server to the right of any of the listed services. Then type the port number, which in many cases is 80, in the appropriate boxes under Port number. To use the same settings for all services, select Use the same proxy server for all addresses. 

In certain cases, you may not want to use a proxy server (for example, for addresses on your corporate intranet). You can enter specific addresses in the box under Do not use proxy server for addresses beginning with. Use a semicolon to separate entries. To bypass proxy servers for all addresses on your intranet, select the Do not use proxy server for local (intranet) addresses check box. 



Stage 4: Site Certificate and Authenticode Settings

 xe "Certificate authorities:importing"\\€part5.doc-1078 
Two ways to control security are through Certificate Authorities and Authenticode.

You can use Certificate Authorities to control the sites where users can download certain content, such as ActiveX controls and Java applets. Site Authorities are a form of digital certificate for an Internet site. Using Authenticode technology, they show where programs come from and verify that they have not been altered.

You can import these settings from your computer. If you want to modify the settings that you will apply to your users' computers, click Import current Certificate Authorities, and then click Modify Settings. Certificates can apply to network server authentication, network client authentication, secure e-mail authentication, and software publishing.

To add a new root certificate, click Add New Root. This provides a level of trust that certificates lower in the hierarchy can inherit. Each certificate is inspected for a parent certificate until it reaches the root certificate.

Authenticode allows you to designate software publishers and credentials agencies as trustworthy. You can also import these settings from your computer. If you want to modify the settings that you will apply to your users' computers, click Import current Authenticode Security information, and then click Modify Settings.



Stage 4: Security Zones and Content Ratings Customization

 xe "Content ratings, customizing"\\€part5.doc-1079 
You can manage security zones and content ratings for your company. You can customize the settings for each security zone. Through content ratings, you can prevent users from viewing content that might be considered offensive.

If you want to modify the settings that will be installed on your users' computers, click Customize Security Zones Settings, and then click Modify Settings. In Stage 5, you can also specify whether users will be able to change their security settings. You must modify security zones by clicking Modify Settings; you cannot import security zone settings from your computer.



Internet Explorer provides a way to help you control the types of content that your computer can gain access to on the Internet. You can adjust the settings to reflect what you think is appropriate content in four areas: language, nudity, sex, and violence. If you want to modify the ratings that you will apply to your users' computers, click Import the current Content Ratings settings, and then click Modify Settings.

You should know that:

· Content Advisor uses very cautious rating standards when you first enable it. You can adjust these settings to match your own preferences. 

· Not all Internet content is rated. If you choose to allow users to view unrated sites, some of those sites could contain inappropriate material. 

Stage 5 Overview: User Settings Customization

 xe "Configuring Outlook:user settings"\\€part5.doc-1080 
In the fifth stage of the wizard, you can customize the following:

· Your users' news and mail servers for Outlook.

· Lightweight Directory Access Protocol (LDAP) servers, if you want to provide Internet directory services to your users.

· User settings and restrictions, which control the access and functions for your user communities.

· Additional registry entries, which you can add for your custom components during installation.

Stage 5: Specify Internet Mail Servers, Domain, and News Server

 xe "Internet Mail servers, specifying"\\€part5.doc-1081 
This screen is displayed if you selected Internet Only as your e-mail service option in Stage 4 of this wizard and you are not upgrading from another mail client. You can provide this information, so that all users need to type only a single account name and password, or you can leave these settings blank. 

The Post Office Protocol version 3 (POP3) and Internet Message Access Protocol (IMAP) are protocols that permit a workstation to dynamically access a mail drop on an Internet or intranet server in a useful fashion. Your server name should include the server name, domain name, and subdomain; an example is pop01.microsoft.com.

In the Outgoing (SMTP) server box, type the name for this outgoing mail server. In some cases, the SMTP server might have the same name as the POP3 server.

A Network News Transfer Protocol (NNTP) is the protocol used to distribute network news messages to NNTP servers and to NNTP clients (news readers) on the Internet. NNTP provides for the distribution, inquiry, retrieval, and posting of news articles by using a reliable stream-based transmission of news on the Internet. Type your Internet news server name; an example server name is microsoft.public.outlook.odk.

Also, you can use Secure Password Authentication (SPA) to authenticate your users' logons, by selecting the Use Secure Password Authentication check box. 



Stage 5: Specify LDAP Server Settings

 xe "LDAP server settings, specifying"\\€part5.doc-1082 
Directory services are powerful search tools that help your users find people and businesses around the world. The Address Book supports LDAP (Lightweight Directory Access Protocol) for accessing directory services, and it comes with built-in access to several popular directory services. You can specify LDAP services for your users only if you selected Internet Only as your e-mail service option in Stage 4 of this wizard.

If you selected Corporate or Workgroup as your e-mail service option, you can specify LDAP settings on the Customize User Settings screen. For more information about deploying a MAPI LDAP service provider for the Corporate or Workgroup configuration, see "Additional Setup Notes" in this chapter. 

Type values for the following items.

Field
Description

Friendly Name
Type the friendly name of your LDAP service. 

Directory Service
Type the name of the directory service you want to add, such as ldap.switchboard.com or ldap.four11.com.

Home Page
This is the page that appears if the user clicks the Start button, points to Find, clicks People, and then clicks Web Site.

Field (cont.)
Description (cont.)

Search Base
Sometimes known as the root or scope, the Search Base is the hierarchical level at which to search a given LDAP server. The allowable scopes are "base" for a base object search, "one" for a one-level search, or "sub" for a subtree search. If scope is omitted, a scope of "base" is assumed.

Service Bitmap
Type the name of a custom 134-by-38 pixel, 16-color .bmp file, or click Browse to locate a file.

 xe "Checking names against directory services"\\€part5.doc-1083 
To have Outlook check names against the server when sending messages, select Check names against this server when sending mail. This setting helps ensure that e-mail addresses match names in the directory. Also, on this panel, the wizard lets you select the Authentication type: either Anonymous, Secure Password, or Password. 



Stage 5: Customize User Settings

 xe "Calendar format, specifying"\\€part5.doc-1084 
You can customize Outlook settings and restrictions, including Outlook settings for MAPI mail profiles and LDAP (for Corporate or Workgroup configurations using the MAPI LDAP service provider). For example, some of the Outlook 98 options that you can customize include the following:

· E-Mail — Specify a mail editor for your users, and determine how mail will be delivered and processed.

· Calendar — Define the calendar work year, week, days, and hours, and set the default duration and reminder time for appointments.

· Journal — Set the level of Journaling and the types of items, such as faxes and meeting requests, that are recorded.

· Converters — Specify an intranet URL where future file-format converters will be located.

· Security — Determine whether users should have S/MIME security capability. Also, set the minimum encryption key length for users.

In addition to Outlook 98 options, you can customize Internet settings and restrictions, as well as Web desktop, NetMeeting, and subscriptions.



 xe "Customizing user settings"\\€part5.doc-1085 
To customize user settings

1. Double-click each category to display the options.

2. Select or clear the check boxes you want.

The settings displayed in the wizard are contained in administration (.adm) files that come with the Outlook 98 Deployment Kit; these files are located in the \Program Files\ODK\Policies folder and are in the same language as your Outlook 98 Deployment Kit CD. If you are familiar with .adm files, you can use the wizard to specify user settings that you have defined in your own .adm files, by clicking Import.  

Important: Settings that you customize on this screen will only be written to the user's computer during setup, and can be changed by the user. To lock down these settings, you must set system policies; for more information about Outlook system policies, see "Setting System Policies" in this chapter.

User settings can be stored in a central location; as users log on at various computers, these settings "follow" them. This could be useful, for example, for a user who needs low security settings but who uses a computer that is typically operated by someone whose security settings are very restrictive. 

Stage 5: Add Registry Entries

 xe "Registry settings:adding new registry entries"\\€part5.doc-1086 
The wizard allows you to add registry entries to the user's Windows registry during the installation process. This can be useful if, for example, you have written an application that relies on the contents of a particular registry entry. You can add the entry so that your application is ready after the user completes the installation process. 

To add a new registry entry

1. In the Add Registry Entries panel, click Add.

2. In the Root box, type the name of the top-level key for the new registry entry. 

Top-level keys include the following: HKEY_CLASSES_ROOT; HKEY_CURRENT_USER; HKEY_LOCAL_MACHINE; and HKEY_USERS. 

3. In the Data type box, click the type of data stored in the new entry: either DWORD (double-word integer) or SZ (string). 

4. In the Key box, type the name of the subkey in which the new entry is stored. 

5. In the Value name box, type a name for the new registry entry. 

6. In the Value data box, type the data to be stored in the new entry. 

The data must match the data type already specified. 

7. In the Description box, type a description of the new registry entry. 

This description is stored with the key in the registry and is optional. 

After you add your registry entries, you can highlight an entry and then click Edit to update any of the information that you added. Also, you can click Remove to delete one or more entries. 



Generate Your Custom Outlook 98 Setup

 xe "Generating your custom Setup"\\€part5.doc-1090 
When you click Finish, the wizard builds your customized package. In most cases, your next steps will be preparing your files and then preparing other media (such as compact discs) for distribution.



Before distribution, you should complete the following tasks:

 xe ".cab files, signing"\\€part5.doc-1091 
· Digitally sign all programs. Digital signatures show where programs come from and verify that programs have not been altered. Users are warned against installing programs that are not digitally signed. You must sign the custom cabinet files and any custom components you distribute with your customized package.

The custom files you must sign are:

— Branding.cab

— Chl<xxxx>.cab

— Folder<n>.cab

— Outcif.cab

— Setup.exe

For more information, see "Stage 2: Specify Trusted Publishers" in this chapter.

· Review the Readme.txt file. This file provides important notes, tips, and other information to help you deploy your customized package.

· Test your customized package. After running the wizard, initiate Setup to verify that you can complete all steps successfully. 

The steps you take for distributing your customized package will vary, depending on how users will install the package.  

How Active Setup Works for the End User

 xe "Active Setup:how Active Setup works for the user"\\€part5.doc-1092 
The following actions occur when the end user initiates the setup process and Active Setup installs the customized package that you created.

· Setup.exe extracts the setup files into a temporary directory.

· Active Setup downloads .cab files, which are placed in the directory that the end user specifies.

· Active Setup extracts the .cab files.

· Active Setup installs Outlook and each component that you specified.

· If necessary, Active Setup prompts the end user to restart the computer.

Enabling Outlook Automatic Upgrade

 xe "Automatic upgrade, enabling"\\€part5.doc-1093 
The Outlook automatic upgrade feature will upgrade Windows 95 and Windows NT clients to the latest version of Outlook, if the version of Outlook installed on the computer is older than the one installed at the installation point. This applies only to future versions. If you use a shared installation point for Outlook, you can enable the automatic upgrade feature by adding the following registry key on the Add Registry Entries screen (Stage 5) of the wizard:

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\8.0\Outlook\UpgradePath]

"serverpath" = "<\\\\server\\share\\subdir>"

where "<\\\\server\\share\\subdir>" is the Outlook directory on the server that contains Outlook.stf.

Note: Do not add a trailing backslash. All backslashes must be doubled. 

 xe "Automatic upgrade, enabling"\\€part5.doc-1094 
The automatic upgrade feature performs the following actions at startup to determine whether a new version is available:

· Reads the registry entry (HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\8.0
\Outlook\UpgradePath) that identifies the installation point. It opens the Outlook.stf file at that installation point and reads the version number from the "App Version" string on the second line of 
the file.

· Compares the version number to the same version number extracted from the local Outlook.stf file, which was placed on the user's computer during setup. If the version number at the installation point is higher than the version number in the local file, Outlook opens a dialog informing the user that a new version is available, and allows them to install it.

If the user chooses to install the new version, Outlook launches Setup.exe from the installation point and exits.

The automatic upgrade feature has the following limitations:

· This feature only works with standalone installations of Outlook. It does not work with versions of Outlook that are deployed with Microsoft Office.

· Microsoft Schedule+ does not support the automatic upgrade feature. In addition, if Schedule+ is launched before Microsoft Exchange, the user will never be prompted for automatic upgrade.

· If the user starts Microsoft Exchange while not connected to the network, and then connects after Microsoft Exchange is running, the user will not be prompted for automatic upgrade.

Setting System Policies

 xe "System policies:overview"\\€part5.doc-1100 
System administrators can predefine Outlook options for their user communities by implementing system policy settings. This section describes how to set system policies using the System Policy Editor (Poledit.exe). If you predefine system policies, you do not need to specify user settings on the Customize User Settings screen (Stage 5 of the Outlook 98 Deployment Wizard).

Using the Policy Editor with the Outlook .adm File

 xe "Policy Editor" \t "See System Policy Editor"\\€part5.doc-1101 
System policies for Outlook are a powerful mechanism for increasing control and manageability of computers across a network. Defined in a policy file, system policies are a method to enforce user and computer settings by overriding default registry values. Using System Policy Editor in Windows 95 or Windows NT 4.0, you can implement policies to control user and computer access privileges and to standardize configurations for your user community. 

Outlook 98 system policies allow administrators to control both Outlook 97 and Outlook 98 clients using a single .adm file. Outlook 98-specific policy settings will not work on Outlook 97 clients, though, so administrators must be aware that Outlook 98-specific settings only affect Outlook 98 users. 

You must install System Policy Editor for Windows 95 or Windows NT to create system policies. System Policy Editor for Windows NT is included with your Outlook 98 Deployment Kit CD; you should upgrade to this newer Windows NT version of System Policy Editor. For specific instructions on how to install and use System Policy Editor, see the Microsoft Windows 95 Resource Kit or the Microsoft Windows NT Workstation Resource Kit. These documents are packaged with the purchased product, or you can download them from the following Web sites:

· For Windows 95, http://www.microsoft.com/windows95/default.asp

· For Windows NT, http://www.microsoft.com/ntworkstation/default.asp

Changing System Policy Settings

 xe ".adm template file for system policies"\\€part5.doc-1102 
Outlook system policies are set using the Outlk98.adm template. For Windows 95, you must install this template in the Windows\Inf directory. For Windows NT, you must install this template in the Winnt\Inf directory. 

After starting System Policy Editor, you must open the Outlk98.adm template to set Outlook system policies.

 xe "System Policy Editor"\\€part5.doc-1103 
To open the Outlk98.adm template

· In System Policy Editor, make sure all policy files are closed.

· On the Options menu, click Template for Windows 95 or Policy Template for Windows NT.

· Click Open template for Windows 95 or Add for Windows NT, and click the Outlk98.adm file. Then, click Open.

· Click Close to return to System Policy Editor.

Note: You can use the Windows NT System Policy Editor to create and update system policies in Windows 95. The Windows NT System Policy Editor enables you to load multiple templates. For Windows NT and Windows 95, you can apply the policies of multiple templates to a single policy file. 

New System Policy Settings for Outlook 98

 xe "New system policies"\\€part5.doc-1104 
Outlook 98 policy settings are incorporated into the existing hierarchy of the Outlook 97 policy file. For information about Outlook 97 system policies, see Appendix C, "Registry Keys and Values" of the Microsoft Office 97 Resource Kit. The Outlk98.adm includes the following new system policies for Outlook 98:

Mail Editor

 xe "Mail editor"\\€part5.doc-1105 
You can select the mail editor for your users. Choose either HTML, Rich Text, WordMail, or Plain Text. Rich Text is the default value for Corporate or Workgroup configurations, and Plain Text is the default value for Internet Only configurations. If you set this system policy, users will not be able to use a different editor, and they will not be able to change the mail editor that you select. The Mail Editor option (from the Tools menu, click Options) will be disabled.

This option is available in for both Corporate or Workgroup and Internet Only configurations; you can set a different editor for each mode. For Corporate or Workgroup configurations, Outlook 98 users are affected only by the Corporate or Workgroup policy setting, and for Internet Only configurations, users are affected only by the Internet Only policy setting. If you select a mail editor other than WordMail, the menu item (on the Actions menu) will be disabled.

 xe "Registry settings:mail editor"\\€part5.doc-1106 
This system policy sets one of the two registry keys, depending on your mail support:

· Corporate or Workgroup configuration: 
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\Mail\ExchangeEditor

· Internet Only configuration: 
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\Mail\InternetEditor

Journal

 xe "Journal, system policy for"\\€part5.doc-1107 
By default, the Journal feature is disabled. You can use a system policy to enable this feature for all Microsoft Office Journaling or for Outlook Journaling only. Journaling information will be maintained in the user's store. You can control the amount and types of Journaling information, which affect the server load. If you enable this option, the following registry key is set to a value of 1 (Outlook only) or 2 (Microsoft Office):

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\Journal\EnableJournal

Outlook Today

 xe "System policies:Outlook Today"\\€part5.doc-1108 
Outlook 98 includes a unique "at a glance" view called Outlook Today, which displays information about the user's calendar, tasks, e-mail, and contacts using the familiar and attractive style of a Web page. This new feature is available by default. You can turn off Outlook Today, and instead show the contents of your root folder (similar to Outlook 97). To do so, set the following registry key to a value of 1:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Today\Disable

You can enable Outlook Today again by either deleting the Disable registry value or setting it to 0.

S/MIME

 xe "S/MIME system policy options"\\€part5.doc-1109 
You can set two system policy options for S/MIME. First, you can set a system policy to disable S/MIME. Second, you can use a system policy to specify the minimum encryption key length for users. 

If S/MIME is disabled, all S/MIME-specific options will appear dimmed on Outlook menus (users can continue to use Microsoft Exchange Server security, though). You may want disable S/MIME if some users cannot read S/MIME-encrypted messages. For example, you may want to disable this capability if your organization is deploying Outlook 98, but some users are still working with Outlook 97 or the Microsoft Exchange client (neither of which support S/MIME). If you disable S/MIME, the following registry key is set to a value of 0:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\UseSMime

 xe "Encryption:specifying minimum key length"\\€part5.doc-1110 
You can set the minimum encryption key length to either 40 (default), 64, or 128. You may want to specify this system policy to enforce a minimum level of security. The shorter the key length, the easier it is to decrypt messages. Longer keys are harder to decrypt and, therefore, are more secure. Use the following registry key to set the minimum encryption key length:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\MinimumEncryptionKey

For more information about customizing security features, see Chapter 4, "Customizing Microsoft Outlook 98 Features."

Offline Store Synchronization

 xe "System policies:offline store synchronization"\\€part5.doc-1111 
Outlook 98 enhances offline store synchronization by adding background synchronization, automatic .ost file setup, and local caching of the Outlook Calendar to Microsoft Exchange Server when users are online. Using system policy features, you can control whether users have offline store synchronization capabilities; if these capabilities are enabled, you can control the synchronization features that users can gain access to and use. You can set the following system policies for offline store synchronization:

· Offline store synchronization and calendar caching capabilities are turned on by default. Using a system policy, you can completely disable offline store synchronization, enable offline store use without calendar caching, or use the offline store for calendar caching without enabling offline access. Also, users will not be able to set their Microsoft Exchange store as an offline store. The following registry key controls the setup of offline store synchronization: 

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\OST\NoOST

where:

0 or no value = An offline store will be set up by default and used for calendar caching. The user can enable offline access and use the offline store.

1 = An offline store will be set up by default and used for calendar caching. The user cannot enable offline access and use the offline store.

2 = An offline store will not be set up by default, and cannot be set up by the user.

· Outlook automatically detects when the user is not connected to the network or the server is not available. It attempts to connect to the server and waits a specified length of time for a response. If the server does not respond within this time limit, Outlook assumes that it is unavailable. You can use a system policy to set this time limit to a value between 0 and 9,999,999 milliseconds; the default time limit is 10,000 milliseconds (10 seconds). This system policy sets the following registry key:

HKEY_CURRENT_USER\Software\Microsoft\Exchange\ConnTimeout 

· Outlook automatically synchronizes the offline store for users. You can disable this automatic synchronization feature, which removes this option from the Outlook Options dialog box. To disable automatic synchronization, set the following registry key to a value of 1:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\General\AutoSyncDisable

· If the AutoSyncDisable value is set to 0 or the key is not present, users can configure Outlook to synchronize their offline store automatically while they are online. Also, Outlook periodically attempts to connect to Microsoft Exchange Server and synchronize their offline store while they are offline. You can use system policies to turn on automatic online and offline synchronization. Users can change these settings. Automatic synchronization is turned on if the value of the following keys is set to 1: 

Online synchronization:
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\General\AutoSyncOn

Offline synchronization:
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\General\AutoSyncOffline

· You can use system policies to set the intervals for both online and offline synchronization. These intervals specify how often synchronization occurs. Users can change the settings, but you can specify a minimum interval and a default interval. You can set these intervals to a value between 0 and 1440 minutes; the default value is 60 minutes. The following registry keys are set by these policies: 

Online synchronization interval:
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\General\AutoSyncInt

Offline synchronization interval:
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\General
\AutoSyncIntOffline

Default synchronization interval:
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\General
\AutoSyncIntDefault

· If a significant number of users set a short interval and are constantly synchronizing with Microsoft Exchange Server, performance may be affected. Therefore, you may want to set a system policy to specify the minimum number of minutes that users can set for the synchronization interval. If you set this system policy, users cannot reduce the interval below this number. You can set this minimum interval to a value between 0 and 1,440 minutes; the default value is 1 minute. This system policy sets the following registry key: 

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\General\AutoSyncIntMin

Junk E-mail

 xe "Registry settings:junk e-mail"\\€part5.doc-1115 
Outlook 98 adds a new feature to automatically protects users from commercial mass-mailings, or "spam" mail. This capability can help prevent users' Inboxes from becoming cluttered with junk mail, such as advertisements and adult solicitations.

By default, this feature is enabled. However, users must still turn on the feature in Outlook. When they activate the content filters, they can choose to either mark the mail with a specific color (the default setting) or move the mail to a specific folder. These filters are defined in the Filters.txt file, which is located in the \Program Files\Microsoft Office\Office folder.

You may want to disable this feature if you are concerned that users might create poor rules, which might cause important mail to be detected as junk mail and deleted or moved to another folder. Also, using the filters might cause a slight decrease in server performance, if the majority of users turn on the feature and open their Inboxes at the same time. If you disable this option, the following registry key is set to a value 
of 1:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\AntiSpam\Disable

NetFolders

 xe "NetFolders"\\€part5.doc-1116 
NetFolders allow users to publish an Outlook folder to folder subscribers. The information in the folder is replicated via e-mail. You can use a policy setting to enable this NetFolders capability. To use this feature, users must have the NetFolders component installed on their computers.

If this feature is disabled, users cannot access and use NetFolders, and all NetFolders options appear dimmed on Outlook menus. This prevents users from publishing confidential company information that might be accessed by people outside the company. NetFolders are a client extension, so users cannot install NetFolders manually. To enable NetFolders but maintain company security, you can configure your gateway appropriately on the mail server.

If you enable NetFolders, the following registry key is set to 1:

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\8.0\NetFolder\EnableNetFolder

Package Definition Files

 xe "Package definition files"\\€part5.doc-1120 
You can use sample package definition (.pdf) files with the Microsoft Systems Management Server to install applications remotely. A network administration tool, such as Microsoft Systems Management Server, lets you distribute a customized version of client Setup to your users. This tool helps you automate large-scale deployment by performing an automatic installation that requires no intervention from you or the user. 

To install the Outlook .pdf file (outlk98.pdf), use the Office SetupPDF.exe or NewPDF.exe program, described in the following steps.

 xe "Installing:package definition files"\\€part5.doc-1121 
To install the package definition files

· For Office 97, click SetupPDF.exe (208K). 

- or - 

For Office 97 Service Release 1, click NewPDF.exe (170K). 

The .pdf files and associated files will be decompressed and placed in the \Program Files\ORK97\Tools\SetupPdf folder on your computer. 

For information about using the sample .pdf files, read the Readme.doc file in this folder. This document contains comprehensive information about installing an application using Microsoft Systems Management Server version 1.2. 

Using Microsoft Systems Management Server

 xe "Systems Management Server"\\€part5.doc-1130 
Important: This section supplements the Microsoft Systems Management Server documentation; it does not replace it. The procedures that follow provide additional information for using Systems Management Server, but they do not cover all Systems Management Server options and features. For complete information, see the Microsoft Systems Management Server Administrator's Guide.

To use Systems Management Server to distribute Outlook remotely, perform the following steps: 

1. Create a package. A package consists of a folder (the package source folder that contains all the installation files) and a .pdf file. The .pdf file describes the Setup commands that can be used to install an application on client computers. 

2. Create and run a job to distribute the package. A job consists of a package and a list of destination client computers. Systems Management Server copies the package to distribution servers servicing the client computers and executes the jobs on the client computers. 

Note: Before you use Systems Management Server to install an application, you must create an administrative installation point on a server. Systems Management Server uses the administrative installation point as the package source folder. 

To install an application on your users' computers, you create a package to run Setup using the standard installation types, or using a Setup script you have customized.  

Creating a Package

 xe "Creating Setup packages"\\€part5.doc-1131 
You create a package by using the Systems Management Server Administrator program and importing the .pdf file. The Outlook .pdf file is located in the main Office folder in the administrative installation point, and is named outlk98.pdf.

The .pdf file contains command-line definitions for the standard installation types: Typical and Custom, as well as for the complete installation (a Custom installation with all the components selected) and Uninstall options. Each of these command-line definitions contains a Setup command line that directs Setup to run in batch mode with the specific installation type (except for Custom, which always runs interactively). For a description of all the available Setup command-line options, see Appendix B, "Setup Command-Line Options."

To use one of the standard installation types for installing an application on your client computers, create a package using the unmodified .pdf file. 

To create a Setup package

1. Start the Systems Management Server Administrator program, and switch to the Packages window.

2. On the File menu, click New. 

3. In the Package Properties dialog box, click Import. 

4. In the File Browser dialog box, select the appropriate .pdf file (outlk98.pdf for Outlook 98), and then click OK. 

The .pdf file is located in the administrative installation point in the folder containing the main Office application files. 

5. In the Package Properties dialog box, click Workstations. 

6. In the Source Directory box, type the location of the administrative installation point.

7. In the Workstation Command Lines box, click the installation type you want, and then click Close. 

To add a new command to the package

1. Start the Systems Management Server Administrator program, and switch to the Packages window.

2. Select the package you created. 

3. On the File menu, click Properties. 

4. In the Package Properties dialog box, click Workstations. 

5. In the Source Directory box, type the location of the administrative installation point, and then click New. 

6. In the Command Name box, type a name for the new command.

For example, type Install Outlook.

7. In the Command Line box, type the command to run your custom Setup. 

For example, type: setup.exe.

8. To indicate that no user input is required to run the package, select the Automated Command Line check box. 

9. If you are installing on Windows NT Workstation, you can also select the System (Background) Task check box to indicate that you want the package to run in the background.

10. In the Supported Platforms box, select the appropriate operating systems, Windows 95, Windows NT, or both, and then click OK. 

11. In the Workstation Command Lines box, select the command you created, and then click Close.

Note: For more information about creating, modifying, or distributing packages, or for information about other package options available in Systems Management Server, see the Microsoft Systems Management Server Administrator's Guide. 

Creating a Job for the Package

 xe "Run On Workstation job, creating"\\€part5.doc-1133 
After you create the Systems Management Server package, you can create a Run On Workstation job to distribute the package. 

To create a Run On Workstation job

1. Start the Systems Management Server Administrator program, and switch to the Jobs window. 

2. On the File menu, click New. 

3. In the Job Properties dialog box, click Details.

4. In the Package box, click the package you created. 

5. Under Run Phase, select the Run Workstation Command check box, select one of the Setup commands in the package, and then click OK. 

Important: The previous procedure describes how to create a simple job for the package and how to select the appropriate Setup command line. To finish creating the job, you must define job targets (user computers) on which to install an application, and you must set the job schedule. For more information about creating and scheduling the job, see the Microsoft Systems Management Server Administrator's Guide. 

When the job is executed, Systems Management Server copies all the files from the main Office folder on the administrative installation point to a folder on one or more Systems Management Server distribution servers that service the users on your network. When a user runs the package, Setup is run from within this copy of the administrative installation point. 

Additional Setup Notes

The following paragraphs provides additional information about Outlook 98 setup and installation.

 xe "Desktop icons"\\€part5.doc-1140 
· Desktop icon changes.
When a user installs Outlook 98, the new Outlook 98 icon is added to the desktop, and the Inbox and Microsoft Exchange icons are removed automatically. In addition, when a user first starts Outlook 98, the Outlook Express icon is removed from the desktop as well. The Outlook 98 Deployment Wizard lets you choose whether to show the Microsoft Internet Explorer icon on the desktop and Start menu. For more information, see "Stage 3: Select Silent Install and Hide Icons" in this chapter.

 xe "Internet Explorer Administration Kit (IEAK)"\\€part5.doc-1141 
· Installing the IEAK a second time.
If you have already installed Internet Explorer 4.0 on a computer using the IEAK and you attempt to install your customized Outlook 98 package (created with the Outlook 98 deployment wizard), it is the same as installing a second IEAK package. Therefore, if you previously customized the following settings using the IEAK, these settings are reset to the browser defaults when you install your customized Outlook 98 package (or a second IEAK package):

— Help and online support URLs

— Add/Remove Components' add-on URL

— Window title bar 

Also, when you install the customized Outlook 98 package, the default browser channels are added to the user's list of current channels.

 xe "Migrating calendar information"\\€part5.doc-1142 
· Migrating calendar information into Outlook 98. 
If the users' Schedule+ 7.x calendaring information is stored on Microsoft Exchange Server, you can easily migrate it to Outlook 98 by setting the following registry key on the Add Registry Entries screen in Stage 5 of the Outlook 98 Deployment Wizard:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Import
"ImportDetection" (DWORD)

where:
1 = Prompt user to import Schedule+ information
2 = Import Schedule+ information without prompting the user

If the registry keys are properly set, the calendaring information will be imported the first time a user starts Outlook 98. During this process, Outlook 98 creates a local Schedule+ file in the user's \Temp directory. The Schedule+ file will be either an .scd or .sc2 file, depending on the format of the calendaring information that the user stores on Microsoft Exchange Server. After creating the file in the \Temp directory, Outlook imports it into the user's default calendar folder. If the import fails for any reason, the file still exists in the \Temp directory.

Note: Schedule+ permissions are not migrated. 

In order to migrate the calendaring information the first time a user start Outlook 98, both the PIM converters and Schedule+ support components must be installed on the user's computer. To ensure that these components are installed, you must modify the list of components on the Select Installation Options screen in Stage 3 of the Outlook 98 Deployment Wizard.

Also, you can use the Exchange Migration Kit to "mass" migrate e-mail and calendaring information from other servers, such as Microsoft Mail. When migrating from Microsoft Mail, you do not need to set the ImportDetection registry key; the Exchange Migration Kit automatically sets properties that import calendaring information the first time a user start Outlook 98.

 xe "Form design feature, disabling"\\€part5.doc-1143 
· Disabling form design. 
To disable the Outlook form design feature on users' computers, add the following registry key to your installation package using the Add Registry Entries screen in Stage 5 of the Outlook 98 Deployment Wizard:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\NoOutlookFormsDesigner

If this key exists in the users' registry, they will not be able to access the form design option from the Outlook Tools menu.

 xe "Offline store synchronization"\\€part5.doc-1144 
· Changes to offline store synchronization. 
Outlook 98 provides the following new features, which make it easier for Corporate or Workgroup configuration users to work offline with Microsoft Exchange Server:

 xe "Link auto-detection"\\€part5.doc-1145 
Link auto-detection. When a user starts Outlook 98, Outlook automatically attempts to connect to the server. If the server is not available, it times out after 10 seconds. If the connection attempt times out, the user is given the option to retry the connection or work offline (with Outlook 97, users had to wait several minutes before being given this option). 

If no network connection is available, Outlook defaults to working offline. This is useful for users with laptop computers that have network adapters in the computer's docking station. When the computer is connected to the docking station, Outlook automatically connects to the server; when the computer is disconnected from the docking station and no network is available, Outlook automatically works offline. 

If users continually experience connection timeouts when connecting to the server, you can use a system policy to increase the time limit; see "New System Policy Settings for Outlook 98" in this chapter. If Outlook is working offline, an offline icon appears on the right-hand side of the status bar.

 xe "Background synchronization"\\€part5.doc-1146 
Background synchronization. If a user enables offline access to mailbox folders, synchronization between the offline copy and the server copy of the folders occurs in the background, enabling the user to continue working while synchronization takes place.

 xe "Automatic synchronization"\\€part5.doc-1147 
Automatic synchronization. Outlook now has the ability to synchronize offline folders automatically at a regular interval. Users can control automatic synchronization for both online and offline. To limit server load, you can use system policies to specify the minimum interval that users can set for online and offline synchronization. 

 xe "Offline folder icons"\\€part5.doc-1148 
Offline folder icons. When a user enables offline access to the Microsoft Exchange Server mailbox, a graphic added to the folder icons identifies the folders that are available offline.

 xe "Calendar caching"\\€part5.doc-1149 
Calendar caching. For Corporate or Workgroup configuration users with Microsoft Exchange Server, Outlook automatically creates an .ost file when a new profile is used. Then, the calendar is synchronized with the .ost file. The next time Outlook is started, it uses the local copy of the calendar (which reduces server load and improves server scalability with Outlook). When the user makes changes to the calendar, Outlook updates the local calendar first, and then within a few seconds, synchronizes with the server copy of the calendar. Outlook does not make a local copy of the user's other folders, which are located in the server mailbox.

 xe "MAPI LDAP service provider"\\€part5.doc-1150 
· MAPI LDAP service provider. 
For the Corporate or Workgroup configuration, Outlook uses MAPI to access address books and requires an additional MAPI service provider to access an LDAP directory. If your organization requires LDAP support, you can deploy a self-extracting MAPI LDAP Address Book Provider, which is included with the Microsoft Outlook 98 Deployment Kit CD. This MAPI LDAP Address Book Provider is contained in an IExpress package; you can add this package to your custom setup by using the Outlook 98 Deployment Wizard. For more information, see "Stage 2: Specify Custom Active Setup Components" in this chapter.

 xe "Automatic generation of Microsoft Exchange Views"\\€part5.doc-1151 
· Automatic generation of Microsoft Exchange views. 
Outlook provides the ability to create Exchange Views, which can be viewed using Microsoft Exchange Client and Outlook Web Access. View definition files are stored as hidden messages in each folder. Standard views, which are specific to each folder, are installed automatically. 

In Outlook 97, users defined Exchange Server views by using the Folder Properties dialog box. In Outlook 98, Exchange Views (both for Personal and Public Folders) are generated automatically for users who have the Corporate or Workgroup configuration. Then, users can create custom views in Outlook and see these views (as well as the default views) by using Outlook Web Access or Microsoft Exchange Client. Exchange Views are not generated automatically for users who have the Internet Only configuration.

Administrators can use the Outlook 98 Deployment Kit to change the default views as necessary. The following registry keys control the default values for generating Exchange Views of Personal Folders and Public Folders (0=False 1=True):

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\ExchVwPsnl

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\ExchVwPub 

 xe "Internet Free/Busy feature"\\€part5.doc-1152 
· Internet free/busy. 
Internet free/busy (using the iCalendar protocol) is a new feature of the Internet Only configuration that enables users to share free/busy information with each other. Outlook users and users of other applications that support iCalendar can gain access to this information to plan meetings and view the times when other people are available. 

The Internet free/busy feature enables users to search for and post their free/busy information to and from files by using three different types of URLs: file, FTP, and HTTP. An optimal configuration for a small LAN would be to set up a share on a server where all users could maintain their free/busy information and also view the free/busy information for other people. Administrators must set up users' computers to post and read information from that server. The following registry key is used to define Internet free/busy on users' computers:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Options\Calendar\InetFB

This registry key accepts the following values:

ReadURL. A string value that contains the URL of the default location and string where the user will search for the free/busy information of others.

WriteURL. A string value that contains the URL where the user will publish his or her free/busy information.

Publish. A value of 1 means that the user will publish his or her free/busy information.

These URLs can contain two different string substitutions: %NAME% and %SERVER%. Each user's e-mail address has the format name@server. The %NAME% is replaced with the string of all characters before the @ symbol in the address. The %SERVER% is replaced with a string of all the characters after the @ symbol. For example, if your e-mail address is JohnDoe@Somewhere.com and your WriteURL value is set to File://C:\temp\%NAME%.ifb, you would have a file named "JohnDoe.ifb" written in the C:\Temp directory of your computer.

Follow these three steps to set up Internet free/busy on a LAN:

1. Create a share on the LAN where each user can create, modify, and read his or her own files and can read all other files (for example, \\FreeBusyServer\FB).

2. Set the WriteURL for all clients so that they are writing a unique file to that share. If all users on the LAN have a unique e-mail address, the following URL should work for all users: FILE://\\FreeBusyServer\FB\%NAME%.ifb.

3. Set the ReadURL for all clients so that they can read each other's information from that share (for example, FILE://\\FreeBusyServer\FB\%NAME%.ifb).

Then, all users can write their free/busy information to the FreeBusyServer\FB share and can read other people's information from the same location. 

To find the free/busy information for people who do not keep their information in the default share, users can create a contact. Then, on the Details page, they can enter the specific URL location of that user's free/busy file (for example, http://MyWebSite.Server.com/MyFreeBusy.ifb).

 xe "Files moved to \Application Data folder"\\€part5.doc-1155 
· Files moved to the \Application Data folder.
The following table identifies the files that were moved from the \Windows folder to the \Application Data folder for Outlook 98. These files, which store Outlook settings, were moved to facilitate roaming; for more information, see "Setting Up Outlook for Multiple or Roaming Users" in Chapter 5. The \Application Data folder is maintained in the registry at the following location:

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\AppData 

File
Folder location

Views.dat
Application Data\Microsoft\Outlook

Outcmd.dat
Application Data\Microsoft\Outlook

Outlprnt (printer settings file)
Application Data\Microsoft\Outlook

*.fav (Outlook Bar settings)
Application Data\Microsoft\Outlook

*.rwz (Rules wizard files)
Application Data\Microsoft\Outlook

File (cont.)
Folder location (cont.)

*.nick (nicknames files)
Application Data\Microsoft\Outlook

*.pst (store)
Application Data\Microsoft\Outlook

All Signatures
Application Data\Shared\Microsoft\Shared\Signatures

Custom Stationery
Application Data\Shared\Microsoft\Shared\Stationery

 xe "Migration tools"\\€part5.doc-1156 
· Migration tools. 
Outlook 97 included two important migration tools, the SC2 Importer and the Outlook Migration Kit, which administrators used to migrate .cal, .scd, and .sc2 calendar information to Outlook 97. In Outlook 98, these migration tools are replaced by a native SC2 Importer and the ability to import Schedule+ information automatically using the Outlook 98 Deployment Wizard, described in this chapter. For more information, see "Stage 4: Configure Schedule+ Support" in this chapter.

 xe "Fax numbers:checking"\\€part5.doc-1157 
· Check fax numbers.
To facilitate automated dialing, Outlook includes a feature to verify fax numbers, which ensures that the numbers are properly formatted. Fax software requires a canonical format. This feature works whether you are using WinFax, At-Work Fax, or no fax at all. If you do not use automated dialing capabilities for faxing, you can disable the Check Numbers dialog box by setting the following registry key to 0:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Contact\ConfirmPhone 

 xe "Customizing junk e-mail filters"\\€part5.doc-1158 
· Deploying custom junk e-mail filters.
 If you turn on the junk e-mail feature using Outlook 98 system policies, you can customize the list of sender names that Outlook filters. In addition to the default filters, you can add other sender names using the following three files:

Junk Senders.txt. Mail from senders listed in this file will be marked as Junk. 

Adult Content Senders.txt. Mail from senders listed in this file will be marked as Adult Content.

Exception List.txt. Mail from senders listed in this file will not be marked as either Junk or Adult Content.

Users can view the Filters.txt file in their \Program Files\Microsoft Office\Office directory to see a list of the default Outlook 98 junk e-mail filters that are being used. This file is for information purposes only; if users attempt to write to this text file, it will not affect the filters list.

If you customize Junk Senders.txt, Adult Content Senders.txt, or Exception List.txt, you can add the files to your Outlook 98 installation package using the Specify Custom Active Setup Components screen in Stage 2 of the Outlook 98 Deployment Wizard. Make sure that the files are installed in the user's \Application Data\Microsoft\Outlook folder.

CHAPTER 3

Interoperability

As an administrator, you need to know how the Microsoft® Outlook™98 works together with other workgroup clients in your organization. Read this chapter to find out how Outlook interoperability with other Microsoft messaging, calendar and group scheduling, and project management products takes the administrative trouble out of upgrading or managing a mixed client environment.
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Introduction

 xe "IMAP4 protocol, using with Outlook"\\€part4.doc-1001 
Microsoft Outlook provides interoperability with other Microsoft and third-party messaging and collaboration products, which makes it easy for administrators to manage mixed clients. Outlook, like Microsoft Exchange Client, can use either Microsoft Exchange Server or Microsoft Mail 3.x as its messaging transport. In addition, Outlook can use Internet messaging protocols, including POP3/SMTP and IMAP4. A high level of interoperability enables users of different Microsoft messaging and collaboration clients on different platforms to send and receive mail, as well as to perform group scheduling activities. 

In a mixed-client environment, users who continue to use previous Microsoft messaging and group scheduling clients cannot take full advantage of Outlook's enhanced user interface and capabilities. These interoperability differences are similar to the differences users notice when they upgrade other applications (such as upgrading from Microsoft Word 95 to Word 97). For example, non-Outlook users may not be able to gain access to or view an Outlook user's messages or other Outlook information in the same way that another Outlook user would. 

For organizations that are managing both Outlook 97 and Outlook 98 environments, there are very few significant interoperability issues between these two versions. Because the versions are built with the same file format, there is complete interoperability for group scheduling activities (sending and receiving meeting requests, viewing free/busy times or details, and delegating access). Outlook 97 and Outlook 98 users can also send and receive mail across versions. The only significant interoperability issues are new Outlook 98 features, such as HTML mail, Stationery, vCard, vCalendar, and iCalendar—which are not supported in Outlook 97 (with the exception of vCard, which is available as a free add-on to Outlook 97).  

Interoperability with Microsoft Exchange Client

 xe "Exhange Client, interoperability"\\€part4.doc-1002 
In an environment where Outlook users must share information with Microsoft Exchange Client users, all users can exchange e-mail with each other. However, because many Outlook capabilities go beyond those of Microsoft Exchange Client, Outlook users should be aware that their co-workers who are using Microsoft Exchange Client might not be able to view or use portions of the Outlook users' messaging information the same way as another Outlook user would. 

Exchanging Messages

In a mixed environment, Outlook users should be aware that their co-workers who use Microsoft Exchange Client cannot take full advantage of many Outlook messaging features, including the following:

 xe "Enhanced standard message form:Microsoft Exchange Client"\\€part4.doc-1005 
· Enhanced standard message form. Microsoft Exchange Client users who view messages created in Outlook see the messages in the Microsoft Exchange Client standard message form; this form does not support the advanced features of the Outlook standard message form, such as message expiration. As a result, some of the information in the Outlook message may not be viewable to Microsoft Exchange Client users.

 xe "Extended message properties:Microsoft Exchange Client"\\€part4.doc-1006 
· Extended message properties. When a Microsoft Exchange Client user opens an Outlook message, extended Outlook message properties, such as voting buttons, are ignored because they are not recognized by Microsoft Exchange Client. This means that some messages created in Outlook may appear different to Microsoft Exchange Client users. However, Outlook recognizes all Microsoft Exchange Client message properties. 

 xe "Private items, Microsoft Exchange Client"\\€part4.doc-1007 
· Private items. When an Outlook user marks an item (such as an e-mail or calendar item) as "Private," other Outlook users cannot view the item. However, Microsoft Exchange Client users can view the item if they have been granted folder access privileges for the folder where the item is stored. Because Outlook folder-level privacy is absolute, the Outlook workaround for this functionality difference is to have Outlook users put private items in a separate folder, which they do not share or for which they have set restrictions.

 xe "Non-table views, Microsoft Exchange Client"\\€part4.doc-1008 
· Non-table views. Microsoft Exchange Client users can display Outlook table views—views that consist only of rows and columns—if the Convert to Exchange views check box is selected as part of folder properties for the Outlook folder. However, Microsoft Exchange Client cannot display Outlook non-table views (such as the day, week, and month views in the calendar) and card, icon, and timeline views. When Outlook and Microsoft Exchange Client users access the same set of public folders, Microsoft Exchange Client users cannot display any non-table views created by Outlook users.

 xe "Saved views, Microsoft Exchange Client"\\€part4.doc-1009 
· Saved views. Outlook and Microsoft Exchange Client use different formats to create saved views. Outlook recognizes both formats, so Outlook users can use any Microsoft Exchange Client view, as well as all Outlook views. In contrast, Microsoft Exchange Client does not recognize the Outlook format, so Microsoft Exchange Client cannot use Outlook views by default. 

Outlook users can choose to maintain two copies of all saved table views in a folder automatically—one copy in Outlook format and one copy in Microsoft Exchange Client format. This workaround enables Microsoft Exchange Client users to use Outlook forms, although any Outlook-specific view features, such as formula fields, are not included in the Microsoft Exchange Client copy. Also, when a Microsoft Exchange Client user opens a folder, Microsoft Exchange Client displays only the views that have been saved in Microsoft Exchange Client format.

 xe "Custom field types:Microsoft Exchange Client"\\€part4.doc-1010 
· Custom field types. No Outlook custom field types, such as formula and combination fields, are viewable by Microsoft Exchange Client users. 

 xe "Rich text in messages:Microsoft Exchange Client"\\€part4.doc-1011 
· Rich text in message. Like Microsoft Exchange Client users, Outlook users can format message text by using rich text attributes such as bold, italic, and indent. 

 xe "Attachments:Microsoft Exchange Client"\\€part4.doc-1012 
· Attachments. Outlook can open attachments or objects within messages created by Microsoft Exchange Client users, and vice versa. Outlook and Microsoft Exchange Client users can also attach a message to another message. Outlook users can also attach other Outlook items (such as a contact) to their messages. However, Microsoft Exchange Client users receive the items as text-only attachments.

 xe "Embedded hyperlinks:Microsoft Exchange Client"\\€part4.doc-1013 
· Embedded hyperlinks. If an Outlook or Microsoft Exchange Client message recipient clicks an embedded Web-style hyperlink (a URL address of an Internet or intranet Web site) in a message created by another Outlook or Microsoft Exchange Client user, the recipient's browser opens the appropriate Web site. 

 xe "Message size:Microsoft Exchange Client"\\€part4.doc-1014 
· Unlimited message size. Outlook and Microsoft Exchange Client users can create and read messages of any size (subject to available system resources). 

 xe "HTML-formatted messages:Microsoft Exchange Client"\\€part4.doc-1015 
· HTML-formatted mail messages. Outlook supports the ability to send mail that is formatted as HTML and also to create stationery by using HTML mail. However, Microsoft Exchange Client users cannot send mail formatted with HTML, and when they receive HTML messages, the messages are displayed as plain text without the original formatting.

 xe "vCards:Microsoft Exchange Client"\\€part4.doc-1016 
· Sending and receiving vCards. Outlook allows users to send and receive contact information by using the Internet standard vCard format. Microsoft Exchange Client does not support this feature. 

Using Public Folders

 xe "Interoperability:public folders"\\€part4.doc-1020 
Outlook supports all the custom public folder view features of Microsoft Exchange Server. In fact, Microsoft Exchange Server does not distinguish between Outlook and Microsoft Exchange Client when users open a public folder. For this reason, Outlook and Microsoft Exchange Client users can gain access to a common set of public folders. 

Other Messaging and Collaboration Features

Some interoperability differences between Outlook and Microsoft Exchange Client features go beyond the basic capabilities of exchanging e-mail messages and using public folders. These additional feature differences include the following:

 xe "Collaboration features:Microsoft Exchange Client"\\€part4.doc-1030 
· Rules. Microsoft Exchange Client has an interface to manage rules, called the Inbox Assistant. Outlook includes the Rules wizard, an enhanced rules user interface. The Outlook Rules wizard enables users to manage Inbox Assistant rules (server-side rules) in addition to their Outlook rules (client-side rules). The Rules wizard allows users to easily recreate (convert) Inbox Assistant rules into Outlook rules.

Each time the Rules wizard is started, it checks for active Inbox Assistant rules on the user's computer. If any exist, the Rules wizard gives the user the option to convert them automatically to Outlook rules. After an Inbox Assistant rule has been converted to an Outlook rule, users can modify it at any time using the Rules wizard. 

Note: The Rules wizard is a built-in feature of Outlook and is not available with the Microsoft Exchange Client. 

 xe "CDO interface for scripting forms"\\€part4.doc-1031 
· Forms. Forms created using the Outlook forms design environment can only be used by Outlook users. Forms created using the Exchange Forms Designer (EFD) can be used by both Outlook and Microsoft Exchange Client users. Forms implemented using Exchange Server HTML interfaces can be used by Outlook, but not by Microsoft Exchange Client. Developers should create forms using a tool that is appropriate for the mix of operating systems in the particular organization.  

Microsoft Exchange Server provides an alternative means of creating forms for use in collaborative applications. It does this by using Active Server Pages and the Microsoft Exchange Collaboration Data Objects (CDO) interface to script forms that are displayed as HTML in a Web browser. Outlook supports Microsoft Exchange Server HTML forms. These features provide Microsoft Exchange sites with an option for developing electronic forms that can be deployed across all operating systems.

 xe "Microsoft Word, using for WordMail"\\€part4.doc-1032 
· WordMail. Microsoft Exchange Client users can choose either Microsoft Word 95 or Microsoft Word 97 for WordMail. Outlook users, however, must have Microsoft Word 97 installed to create messages using WordMail (although they can receive and read messages composed with either WordMail 95 or WordMail 97).

 xe "Ballot messages"\\€part4.doc-1033 
· Voting. With Outlook, users can easily create and send ballot messages to other Outlook users and track the voting responses automatically in Outlook. An Outlook user specifies the voting choices when creating the message, and then sends the message to other users. When recipients using Outlook receive a voting message, the selections they can vote on appear as buttons in the Outlook message—a recipient votes with just a mouse click. However, when Microsoft Exchange Client users receive voting messages from Outlook users, they receive only the text of the Subject line and the body of the voting message. No voting buttons are displayed.

 xe "Preview pane, Microsoft Exchange Client"\\€part4.doc-1034 
· Microsoft Exchange Client Preview Pane. Outlook has a built-in Preview Pane. The Microsoft Exchange Client Preview Pane is not compatible with Outlook, and is therefore not recommended for use with Outlook.

 xe "Delegation of tasks, Microsoft Exchange Client"\\€part4.doc-1035 
· Tasks. When an Outlook user delegates a task to a user who is running Microsoft Exchange Client, the recipient receives only an e-mail message that lists the task's description, start and end dates, and other information as text in the body of the message.

Interoperability with Microsoft Schedule+

 xe "Appointments and Schedule+ interoperability"\\€part4.doc-1040 
Outlook and Schedule+ (16-bit version 1.0 and 32-bit versions 7.0, 7.0a, and 7.5) offer interoperability for basic calendar and group scheduling capabilities. In a mixed environment consisting of Outlook and Schedule+ users, all users can exchange meeting request messages and share calendar free/busy status with each other. However, many Outlook capabilities go beyond those of Schedule+. Outlook users should be aware that their co-workers who are using Schedule+ might not be able to view or use some of the messaging or calendar information the same way as another Outlook user would. 

Note: Outlook users with a Corporate or Workgroup configuration have the option to substitute Microsoft Schedule+ 7.x for the Outlook calendar function. See "Using Schedule+ As the Primary Calendar in Outlook" in Chapter 5. 

Basic Group Scheduling Capabilities

 xe "Group scheduling"\\€part4.doc-1050 
For most organizations, two scheduling functionality areas are considered essential: 

· Exchanging meeting requests

· Viewing free/busy status 

Outlook and Schedule+ interoperate completely in both of these key areas. 

Note: The Outlook driver for Schedule+ allows Schedule+ users to open Outlook users' calendars (read only) and view free/busy details; without this driver, users are unable to do so. To install this driver, see "Outlook Driver for Microsoft Schedule+ " in this chapter.

As you read this section, you should be familiar with the distinction between free/busy status and free/busy details: 

 xe "Free/Busy feature:interoperability with Schedule+"\\€part4.doc-1051 
· Free/Busy Status. The time blocks during which the user is either available for a meeting or is busy. When users publish their free/busy status, other users can view the free/busy time blocks (but not necessarily their free/busy details) from within the Meeting Planner. 

 xe "Free/Busy feature:interoperability with Schedule+"\\€part4.doc-1052 
· Free/Busy Details. The descriptions (details) of the appointments or activities a user has scheduled. Users who have been given at least Read-Only permission to another user's calendar can not only view (in the Meeting Planner) the time blocks representing when that user is free or busy, but they can also view the user's free/busy details.

Exchanging Meeting Request Messages

Outlook and Schedule+ 1.0 and 7.x users can freely exchange meeting messages across Windows and Macintosh platforms. Although Outlook users and Schedule+ 1.0 users can freely exchange meeting requests and responses, Schedule+ 1.0 does not recognize the advanced features of Outlook (such as attachments, the meeting location field, and recurring meetings). As a result, when a Schedule+ 1.0 user receives a meeting message from an Outlook user, Schedule+ 1.0 ignores any Outlook-specific message features it does not recognize. For example, if an Outlook user sends a recurring meeting request to a Schedule+ 1.0 user, the Schedule+ user receives only the first meeting request. 

Viewing Free/Busy Status

When users "publish" their free/busy status, other users can view the free/busy time blocks (but not necessarily their free/busy details) from within the Meeting Planner. With appropriate permission, Outlook and Schedule+ 1.0 and 7.x users can view each other's free/busy status (time blocks). 

In addition to designating free/busy status, Outlook users can designate "tentative" and "out of office" time blocks for specific appointments. When Outlook users view each other's calendars, they can identify the time blocks that are free, busy, tentative, or out of office. When Schedule+ users view an Outlook user's calendar in their Meeting Planners, time blocks designated by the Outlook user as tentative appear as free times to the Schedule+ users. However, time blocks designated by the Outlook user as out of office appear as busy times to Schedule+ users. 

Outlook differs slightly from Schedule+ in how it handles unpublished free/busy status. When Schedule+ users choose not to publish their free/busy status, other Schedule+ users—if they have at least Read-Only permission—can still view the users' free/busy status in their Meeting Planners. However, when Outlook users choose not to publish their free/busy status, other Outlook users—even those who have at least Read-Only permission—cannot view the users' free/busy status in their Meeting Planners. To view the users' unpublished free/busy status, Outlook users must view (open) the user's calendar, providing that they have appropriate permission. 

By default, Outlook 98 publishes two months of free/busy status for all users (the default value for Outlook 97 is three months). Users can change the number of months or choose not to publish their free/busy status at all (by specifying 0 months).To set the number of months of free/busy status that is published, click the Tools menu, click Calendar Options, and then click Free/Busy Options. In the Publish X Month(s) of free/busy information on the server box, enter 0 (zero).

Other Group Scheduling and Calendar Features

The following sections describe differences that exist in how Outlook and Schedule+ interoperate. 

Opening Other Users' Calendars

 xe "aa"\\€part4.doc-1060 
Unless the Outlook driver for Schedule+ is installed, Schedule+ 7.x users cannot open an Outlook user's calendar. As a result, Schedule+ 7.x users cannot view free/busy details of an Outlook user's calendar. To install this driver, see "Outlook Driver for Microsoft Schedule+" in this chapter; there are 16-bit and 32-bit versions of this driver (no Macintosh version is available). Outlook users, on the other hand, can open Schedule+ 7.x users' calendars with appropriate permission, and can therefore view a Schedule+ 7.x user's free/busy details. 

Viewing Another User's Free/Busy Details

 xe "aa"\\€part4.doc-1061 
Outlook users on Microsoft Exchange Server can view the free or busy details of Schedule+ users who are also on Microsoft Exchange Server, but they cannot view the details of those on Microsoft Mail Server. Schedule+ 7.x users can view the free or busy details of Outlook users when all users are on Microsoft Exchange Server and the necessary Windows 16-bit or 32-bit driver is installed; for more information, see "Outlook Driver for Microsoft Schedule+" in this chapter. Schedule+ 1.0 users cannot view Outlook users' free/busy details. 

Outlook users who have at least Read Only permission to another user's calendar can see when that user is free or busy. Also, they can view the description (details) of that user's scheduled appointments and activities in the Meeting Planner. 

Delegate Access

 xe "Delegate access:Microsoft Exchange Client"\\€part4.doc-1062 
Just as they can give others permission to read or modify their folders, users can designate other users to be their "delegates." As a delegate, a user can manage the owner's e-mail and schedule, as well as create, send, and reply to messages (including meeting and task requests) on the owner's behalf. For example, managers could give their assistants or teams access to their schedules so the assistants or team members can create messages, appointments, tasks, or other items for them.

A delegate relationship requires that both users run the same scheduling client. For example, Outlook users can be delegates only for other Outlook users. Outlook users who want to participate in delegate relationships with other Outlook users must keep all their primary folders (such as Calendar and Inbox) on the server instead of on their local computers. 

Schedule+ 7.x users can designate other users to be their "delegate owners." As a delegate owner, a user has all the capabilities of a delegate, and can also designate additional delegates for the owner's schedule. Like Schedule+ 7.x users, Outlook folder owners can enable their delegates to give other users the necessary permission for gaining access to the owner's folders. However, Outlook does not allow a delegate to designate additional delegates for the owner's folders. To designate a delegate in Outlook, you must be logged on as the folder (account) owner. 

Note: When Outlook is a client for a Microsoft Mail server, Outlook users cannot give other Outlook users access to their folders.

Direct Booking

 xe "Direct booking"\\€part4.doc-1063 
If they have appropriate permission, Outlook users can take advantage of the Schedule+ direct booking feature to book appointments directly into a Schedule+ Calendar. However, Schedule+ 1.0 and 7.x users cannot book appointments directly into Outlook Calendars. In addition, Outlook users cannot book appointments directly into other Outlook Calendars. 

With direct booking, no meeting request is actually sent to the Schedule+ resource (unless the booking fails). The meeting organizer's client software just adds the meeting directly into the Schedule+ resource's calendar. If the direct booking fails, a meeting request is sent instead; if no one responds to the meeting request, the resource will not be booked.

Because a directly booked Schedule+ resource is unlikely to receive many meeting requests, you are not required to assign a delegate to the resource or have a continuously running computer logged into the resource's account to process incoming meeting requests. However, without a delegate or continuously running computer for the Schedule+ resource, if a user does send an explicit meeting request to the resource instead of booking an appointment directly, the meeting request goes unnoticed until a user actually logs on to the resource's account. However, with appropriate permission (such as Delegate), an Outlook user can open another Outlook user's or resource's calendar and modify it directly, if necessary.

Unlike Schedule+ accounts, Outlook accounts cannot be booked directly. Therefore, to process the meeting requests that are sent to Outlook resource accounts, it is recommended that each Outlook resource account be set up with a delegate that receives its meeting requests. The delegate account should be logged on to a continuously running computer. Because a single delegate can be responsible for multiple resource accounts, a single, dedicated "delegate computer" can handle a large number of conference rooms and other resources. 

Tasks

 xe "Task data, importing from Schedule+"\\€part4.doc-1064 
Outlook gives users new task features that are not available in Schedule+ 7.x or Schedule+ 1.0. For example, Outlook provides additional views for task items, making it easier for users to manage tasks in a way that best suits their needs. Also, Outlook enables users to delegate tasks to other users. When an Outlook user delegates a task to another Outlook user, all the task's information (such as start date, end date, and status) is sent as a special task request message to the recipient, who can add it to their own task list automatically. 

After Outlook is installed, users can import their Schedule+ 7.x or Schedule+ 1.0 task data at any time using the Outlook Import wizard. By default, Outlook imports Schedule+ task information into the Outlook Tasks folder. Users can choose to ignore or replace any duplicate entries encountered during the import process.

Contacts

 xe "Contact data, importing from Schedule+"\\€part4.doc-1065 
Outlook provides a rich Contacts feature that helps users keep their business and personal contact information up-to-date. Although Schedule+ 7.x includes some contact features, many of the Outlook contact management enhancements, such as additional contact views, are not available in Schedule+ 7.x.

The enhanced Contacts feature enables Outlook users to include e-mail addresses with their contacts. Outlook users can import all Schedule+ 7.x contacts, as well as contacts stored in Microsoft Exchange Client personal address books (PABs). In addition, Outlook users can maintain contacts as their personal e-mail address books; they no longer need to maintain individuals' names and e-mail addresses in two separate places.

After installing Outlook, users can import their Schedule+ contact data at any time using the Import And Export command on the Outlook File menu. By default, Outlook imports Schedule+ contact information into the Outlook Contacts folder. Users can choose to ignore or replace any duplicate entries encountered during the import process. The Outlook Import wizard also imports Microsoft Exchange Client PABs.

Outlook Driver for Microsoft Schedule+

 xe "Calendar features:Outlook driver for Schedule+"\\€part4.doc-1070 
With the Outlook driver for Schedule+ 7.x, Schedule+ users can open an Outlook Calendar from Schedule+ and view Outlook free/busy details. The Schedule+ user must have at least Read-Only permission for the Outlook user's calendar. Also, that calendar must be stored on the Microsoft Exchange Server.

Note: The Schedule+ user can only read the Outlook user's calendar, not add to it or edit it, regardless of the permissions granted by the Outlook user. 

This driver works on 16-bit and 32-bit versions of Microsoft Schedule+. Both the Schedule+ and Outlook users must be running Microsoft Exchange Server. The 32-bit driver is available with the Microsoft Exchange Server 5.0 and 5.5 CDs; you can also download this driver from the Outlook Web site at http://www.microsoft.com/outlook/.

The 16-bit driver is available only with the Microsoft Exchange Server 5.5 CD.

Installing the Driver

 xe "Installing:Outlook driver for Schedule+"\\€part4.doc-1071 
You must have installed Schedule+, Outlook, and either Windows 3.1, Windows 95, or Windows NT 3.51 or a later version.

To install the Outlook driver for Schedule+

1. If Schedule+ is open, close it.

2. In the same folder as your Schedule+ files, double-click Msoutl.exe (Windows 95 users) or Msoutl16.exe (Windows 3.1 users). 

3. When asked if you want to continue, click Yes. 

4. When the installation is complete, restart Schedule+.

The following files are installed on your computer:

· Msoutl32.dll

· Msostubs.dll

· Msoutl.inf

· Unins351.reg

· Readme.txt 

After the driver is installed, the Schedule+ user can open an Outlook user's calendar.

 xe "Calendar features:opening an Outlook calendar from Schedule+"\\€part4.doc-1072 
To open an Outlook user's calendar from Schedule+

1. On the Schedule+ File menu, click Open. 

2. Click Open Other's Appointment Book. 

Removing the Driver

 xe "Removing the Outlook driver for Schedule+"\\€part4.doc-1073 
If you no longer want the driver installed on your computer, you can remove it easily. The following procedure describes how to remove the driver if you are running Windows 95. If you are running Windows 3.1 and you need to remove this driver, you must run setup again. 

Windows NT 3.51 users can remove the driver by running Unins351.reg and then deleting Msoutl32.dll and Msostubs.dll. These files are located in the same folder as Schedule+.

To remove the Outlook driver for Schedule+ if you are running Windows 95

1. On the Start menu, point to Settings, and then click Control Panel.

2. Double-click Add/Remove Programs.

3. On the Install/Uninstall tab, click Microsoft Outlook 97 Driver for Schedule+, and then click Add/Remove. 

Known Issues

This list identifies potential issues with the Outlook driver for Schedule+ 7.x:

· All-day events in Outlook appear as appointments when viewed in Schedule+ 7.x.

· If you reinstall Schedule+ 7.x, you must also reinstall the driver.

· An Outlook user might share his or her Outlook Calendar with other users and then switch to using Schedule+ 7.x as the primary calendar. In this case, Schedule+ 7.x users who are using the Outlook driver for Schedule+ 7.x to open that user's calendar will continue to open that user's Outlook Calendar instead of the Schedule+ 7.x Calendar. To solve this problem, the Outlook user needs to remove the permissions on the Outlook Calendar folder so that the Outlook driver for Schedule+ 7.x does not open the folder.

· Outlook appointments with more than 32K of text in the Notes field appear to have a blank Notes field when viewed in Schedule+ 7.x. 

Interoperability with Outlook for Windows
    3.1x and Outlook for the Macintosh

 xe "Interoperability:Macintosh"\\€part4.doc-1080 
The Microsoft Outlook integrated e-mail client for the Windows 3.1x and Macintosh operating systems improves the messaging and group scheduling interoperability with Outlook 98 (for 32-bit Windows) without requiring new hardware. These versions are appropriate for customers with Microsoft Exchange Server who need "stepping stone" clients as they migrate to the 32-bit Windows operating systems. The Outlook clients for Windows 3.1x and Macintosh are upgrades from the Microsoft Exchange Mail and Schedule+ clients.

Customers committed to staying on Macintosh or 16-bit Windows platforms for the long term might consider Outlook Express for Macintosh or Windows 3.x for messaging, as well as Outlook Web Access (for Microsoft Exchange Server) for calendaring. Microsoft continues to support the Macintosh and Windows 3.x Microsoft Exchange Server mail clients, as well as Schedule+ for Macintosh and Windows 3.x.

The Outlook clients for Windows 3.1x and Macintosh include all the features of the existing Microsoft Exchange Mail and Schedule+ clients, plus new features to smooth interoperability with Outlook 98. Due to operating system and hardware limitations of typical computers based on 16-bit Windows and Macintosh, Outlook clients for Windows 3.1x and Macintosh continue to provide only a subset of Outlook 98 features. 

The following new features are included in the Outlook clients for Windows 3.1x and Macintosh: 

 xe "Message recall"\\€part4.doc-1081 
· E-mail interoperability improvements. Users can now receive and send flagged messages, recall messages, and respond to (but not send) voting messages. Microsoft has also improved attachment handling and translation for Macintosh users. These clients are intended for Microsoft Exchange Server integration only and do not include Internet mail (POP3 or IMAP) support required to connect directly to an ISP. Users of 16-bit Windows and Macintosh who require POP3 support are encouraged to evaluate the Outlook Express client.

 xe "aa"\\€part4.doc-1082 
· Calendar and group scheduling. By default, Outlook for Windows 3.1x and Macintosh can only view the free/busy information of Schedule+ 7.x users. Outlook for Windows 3.1x can read the details of a calendar on Outlook for Windows 95 using an add-on Schedule+ Exchange Transport .dll file, which is located in the \Support\MSOUTL\Win16 folder on the Microsoft Exchange 5.5 Client Pack CD; this feature is not available to Macintosh users at this time. The clients continue to have the same calendar, contacts, and task features available in Schedule+ version 7.0, and to display calendar, contacts, and task information in a separate window, accessible from the Outlook Bar.

 xe "CDO interface for scripting forms"\\€part4.doc-1083 
· Custom forms. Outlook for Windows 3.1x and Macintosh can display custom forms implemented with HTML and Microsoft Exchange Server Collaboration Data Object (CDO) scripts. When a user of Outlook for Windows 3.1x or Macintosh opens a custom form, it is displayed in the user's Web browser. HTML and CDO-based custom forms can be developed using the Microsoft Visual InterDev™ Web development system or any standard text editor and stored on Microsoft Exchange Server. The Windows 3.1x and Macintosh clients cannot design or display a custom form compatible with Outlook 98.

 xe "aa"\\�part4.doc-1084 
· Improved visuals and interface. Outlook for Windows 3.1x and Macintosh includes a partially customizable Outlook Bar and a Folder Banner consistent with Outlook 98. Menu and toolbar commands are now arranged to match Outlook 98 more closely. 

Interoperability with Microsoft Mail 3.x

 xe "Deferred delivery, Microsoft Mail 3.x"\\€part4.doc-1090 
In an environment where Outlook users must share information with Microsoft Mail 3.x for Windows users, all users can exchange e-mail with each other. However, because many Outlook capabilities go beyond those of Microsoft Mail 3.x, Outlook users should be aware that their co-workers who are using Microsoft Mail 3.x might not be able to view or use portions of the Outlook users' messaging information the same way as another Outlook user would. 

Although Outlook works with Microsoft Mail post offices, the full set of Outlook features is available only when using Outlook with Microsoft Exchange Server. The following Outlook features require Microsoft Exchange Server and are not available when Outlook is run on Microsoft Mail 3.x post offices:

· Opening another user's e-mail folders as a delegate

· Security on "Sent on behalf of" messages

· Deferred delivery and message expiration

· Digital signatures and encryption

· Public folders

· Full-text search

In addition, Microsoft Mail 3.x and Outlook cannot share the same message store. To use data from a Microsoft Mail 3.x message store, users must import the message store to an Outlook-compatible format. Microsoft Exchange Server includes a utility that imports Microsoft Mail 3.x message stores to MAPI format.

Exchanging Messages

In a mixed environment, Microsoft Mail 3.x users cannot take full advantage of many Outlook messaging features, including the following:

 xe "Enhanced standard message form:Microsoft Mail 3.x"\\€part4.doc-1091 
· Enhanced standard message form. Microsoft Mail 3.x users who view messages created in Outlook can see the messages in the Microsoft Mail 3.x standard message form, which does not support the advanced features of the Outlook standard message form. As a result, some of the information in the Outlook message may not be viewable to Microsoft Mail 3.x users.

 xe "Extended message properties:Microsoft Mail 3.x"\\€part4.doc-1092 
· Extended message properties. When a Microsoft Mail 3.x user opens an Outlook message, extended Outlook message properties, such as voting buttons, are ignored, because they are not recognized by Microsoft Mail 3.x. This means that some messages created in Outlook may appear different to Microsoft Mail 3.x users. However, Outlook recognizes all Microsoft Mail 3.x message properties. 

 xe "Custom field types:Microsoft Mail 3.x"\\€part4.doc-1093 
· Custom field types. No Outlook custom field types, such as formula and combination fields, are viewable by Microsoft Mail 3.x users. 

 xe "Plain text:Microsoft Mail 3.x"\\€part4.doc-1094 
· Rich text in messages. Microsoft Mail 3.x does not support rich text in messages. As a result, when an Outlook message with rich text is opened by a Microsoft Mail 3.x user, all rich text attributes are removed from the file and replaced by plain text.

 xe "Attachments:Microsoft Mail 3.x"\\€part4.doc-1095 
· Attachments. Outlook users can open attachments or objects within messages created by Microsoft Mail 3.x users and vice versa. When Microsoft Mail 3.x users receive a message that has another message attached to it, they can view the original message, but they cannot view the attached message. Outlook users can also attach other Outlook items (such as a contact) to their messages. Microsoft Mail 3.x users receive the items as text-only attachments.

 xe "Embedded hyperlinks:Microsoft Mail 3.x"\\€part4.doc-1096 
· Embedded hyperlinks. If a Microsoft Mail 3.x user opens a message that contains an embedded hyperlink, the hyperlink is displayed in the message as plain text only.

 xe "Message size:Microsoft Mail 3.x"\\€part4.doc-1097 
· Unlimited message size. Outlook can create and read a message of any size (subject to available system resources); Microsoft Mail 3.x has additional size restrictions for messages. Although Microsoft Mail 3.x users may not be able to open a very large message created by an Outlook user, they can save the message to a file or print it.

 xe "HTML-formatted messages:Microsoft Mail 3.x"\\€part4.doc-1098 
· HTML-formatted mail messages. Outlook supports the ability to send mail that is formatted as HTML and also to create stationery by using HTML mail. However, Microsoft Mail 3.x users cannot send mail formatted with HTML, and when they receive HTML messages, the messages are displayed as plain text without the original formatting.

 xe "vCards:Microsoft Mail 3.x"\\€part4.doc-1099 
· Sending and receiving vCards. Outlook allows users to send and receive contact information by using the Internet standard vCard format. Microsoft Mail 3.x does not support this feature. 

Other Messaging and Collaboration Features

 xe "Collaboration features:Microsoft Mail 3.x"\\€part4.doc-1100 
Some interoperability differences between Outlook and Microsoft Mail 3.x go beyond the basic capabilities of exchanging e-mail messages. For example, forms created using the Outlook forms design environment can be used only by 32-bit Outlook users. Forms created with the Microsoft Exchange Forms Designer (EFD) and forms implemented using Exchange Server HTML interfaces cannot be used by the Microsoft Mail 3.x client. As a result, developers should create forms by using a tool that is appropriate for the mix of operating systems in your organization.

Also, when an Outlook user delegates a task to a user who is running Microsoft Mail 3.x, the recipient receives only an e-mail message that lists the task's description, start and end dates, and other information as text in the body of the message. 

Interoperability with Microsoft Project

 xe "Interoperability:Microsoft Project"\\€part4.doc-1110 
Microsoft Project 95 users can assign tasks to Outlook users. However, if the Outlook recipients accept the tasks, Project 95 does not add the tasks to Outlook Tasks automatically. Project 98 offers additional integration with Outlook. From within Project 98, Outlook reminders can be set up and Project items can be journaled.  

The workgroup features of Project 98 integrate with Outlook similarly to how previous versions of Project integrated with Microsoft Mail and Schedule+. Team members who want to use these features need to install the workgroup setup routine (available from Microsoft at no additional charge). This setup routine allows team members to view the custom e-mail messages that Project 98 generates. Project managers can use the TeamAssign feature to send custom e-mail messages to team members and assign them to project tasks; these messages are received in the team member's Outlook Inbox.

After the team member has officially accepted the task and sent a response back to the project manager, the task is logged automatically in the team member's Outlook Task list. The tasks are grouped under a new category that corresponds to the project name. Then, the team member can keep track of the task status (using the percentage complete field in the task list) from within the Outlook Task list.

With previous versions of Project, project managers had to send TeamStatus messages to team members to request that the team members submit status reports. However, Project 98 adds a new menu item called New TeamStatus Report to the Outlook Tasks menu. This feature enables team members to generate and submit TeamStatus reports without waiting for the project manager to ask for them. When the team member chooses this command, a custom TeamStatus e-mail message is created and stored in the Outlook Inbox. If the team member has been tracking the task status in the task list, the status information is added automatically to the TeamStatus report. Users can just open it and send it to the project manager. In addition, they can use the TeamStatus message to track the task status and also to save and store it in the Inbox until they are ready to submit it to the project manager. 

CHAPTER 4

Customizing Microsoft Outlook 98
Features

Read this chapter to learn about customizing important Microsoft® Outlook™98 features. System administrators can install these customized features as part of their Outlook deployment.
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Outlook Toolbars and Menus

 xe "CommandBars, customizing:overview"\\€part3.doc-1001 
Outlook toolbars and menus are combined into a single collection called CommandBars. The CommandBars collection is included in the Microsoft Office 97 object model, making it fully programmable. Also, like other Microsoft Office applications, Microsoft Outlook toolbars and menus can be modified through the user interface. With the Customize dialog box open (on the View menu, click Toolbars, and then click Customize), users can right-click any toolbar and change it, including the text, the access key, and the icon. 

Some common commands affect multiple modules, and other commands are module-specific (a change only applies to a single module). For example, if a user moves the Print command to the Help menu, the command moves for both the Calendar and the Inbox. If a user moves the Go to Today button to the File menu for the Calendar, this change only affects the Calendar module. User-defined toolbars are not module-specific, and always appear in all modules (if turned on). Note that shortcut (context) menus cannot be customized.

Outlook toolbars and menus are defined in the Outcmd.dat file, which is located in the Application Data folder. You can customize this file and include it as part of your installation package by using the Outlook 98 Deployment Wizard (ODW). The following sections describes the syntax for referencing your custom toolbars and menus. For more information about the wizard, see Chapter 2, "Installation and Configuration."

 xe "CommandBars, customizing:preventing users from changing settings"\\€part3.doc-1002 
If a custom Outcmd.dat file is installed during setup, users can still modify their toolbars and menus. If you want to prevent users from changing custom toolbar and menu settings, you can remove access to the Toolbars menu (the command will still appear on the context menu, though). Also, you can make the Outcmd.dat file read-only. Deleting this file will reset the toolbars and menus to the system defaults.

Syntax for Referencing Toolbars and Menus

 xe "CommandBars, customizing:syntax for referencing toolbars and menus"\\€part3.doc-1003 
From a developer's point of view, the main window in Outlook (the "application window") is referred to as "Explorer" and the form windows are referred to as "Inspectors." Both types of windows include a set of menus and toolbars, so it is important to make sure you are working with the correct set. 

Use the Explorer objects to refer to the main application window in Outlook; these objects use the ActiveExplorer method to reference an open window and GetExplorer to create a new window. Use the Inspector objects to refer to an Outlook item or form window; these objects use the ActiveInspector method to reference an open window and GetInspector to create a new window. 

You can use the following simplified syntax to reference toolbars and menus for both Microsoft Visual Basic for Applications and Microsoft Visual Basic Scripting Edition (VBScript): 

Set MyCB = <Inspector object>.CommandBars.Item("Menu Bar")

WARNING: Microsoft provides programming examples for illustration only, without warranty either expressed or implied, including, but not limited to, the implied warranties of merchantability and/or fitness for a particular purpose.  

 xe "Code example for referencing toolbars and menus"\\€part3.doc-1004 
For example, the following Visual Basic for Applications subroutine will not generate an error: 

Sub TestCommandBars()

Dim ol As New Outlook.Application

Dim myInspector As Inspector

Set myInspector = ol.ActiveInspector

Set MyCB = myInspector.CommandBars("Menu Bar")

End Sub

Using the FindControl Method

 xe "CommandBars, customizing:using the FindControl method"\\€part3.doc-1005 
You can use the FindControl method to reference Outlook commands (or controls, in relation to the CommandBars object model) if you know the internal value that Outlook has assigned for the command. Using the internal value means that you can use more concise syntax when running CommandBar commands. 

For example, consider a custom Outlook form that uses a custom command button to print the form. Assuming the command button is named cmdPrint, the following VBScript code examples display the File Print dialog box: 

Sub cmdPrint_Click()

Item.GetInspector.CommandBars.FindControl(,4).Execute

End Sub

Sub cmdPrint_Click()

Item.GetInspector.CommandBars.Item("Menu Bar").Controls("File") _

.Controls("Print...").Execute

End Sub

 xe "Code example for FindControl method"\\€part3.doc-1006 
You can obtain the Outlook command values for the CommandBars collection by using the following sample Automation code. This code must be run from Microsoft Word 97; it will create a new document and insert a tab-delimited listing of the information into the document. 

Sub GetIDsForInspector()

' The Outlook object library must be referenced.

Dim objOL As New Outlook.Application

Dim objCommand As Object

Set cb = objOL.ActiveExplorer.CommandBars

' Create a new Word document.

Documents.Add

With Selection

' 3500 is the maximum # of Controls Outlook has defined.

For I = 1 To 3500

Set lbl = cb.FindControl(, I)

If lbl Is Nothing Then

' Do nothing.

Else

' Insert CommandBar name, Command name, and ID.

.TypeText lbl.Parent.Name & Chr(9) _

& lbl.Caption & Chr(9) & I

.TypeParagraph

End If

Next

End With

End Sub

Note: If you need to determine the commands that are available for each type of Outlook item or the application window, you can use the code example to create a listing for that particular item. 

Outlook Bar

 xe "Customizing the Outlook Bar:overview"\\€part3.doc-1008 
The Outlook Bar is defined as the complete set of Outlook Bar Groups attached to the Outlook window. Outlook Bar Groups are stored in a .fav file, which is located in the Application Data folder. When Outlook detects that the Outlook Bar needs to be refreshed (at setup or based on a command-line switch), it follows directives in the Outlbar.inf file and installs Outlook Bar Groups and shortcuts accordingly. Typically, the Outlbar.inf file is located in the same folder as Outlook (\Program Files\Microsoft Office\Office by default). You can customize the Outlbar.inf file and include it as part of your custom installation by using the Outlook 98 Deployment Wizard. For more information about the wizard, see Chapter 2, "Installation and Configuration."

If the Outlbar.inf file is not located, users will receive an error message. Administrators may want to install a backup copy of the original Outlbar.bar file with a different file name in the installation directory to aid product support efforts. To review a sample Outlbar.inf file, see Appendix A, "Sample Outlbar.inf File."

Outlbar.inf File Format

 xe "Customizing the Outlook Bar:Outlbar.inf file format"\\€part3.doc-1010 
Outlbar.inf is similar to any other .ini or .inf file. It is a text file that consists of a set of sections. Each section begins with a section heading and may contain various commands or properties. A section name may contain any combination of alphanumeric characters, but may not contain any spaces. The following table describes the sections of a basic Outlbar.inf file. 

Section
Description

[Version]
Required. Provides basic version information for validating the Outlbar.inf file.

[DefaultOutlookBar]
Required. This section runs whenever the default Outlook Bar is being constructed. It contains pointers to other sections, which specify the groups and shortcuts to create.

[DefaultOutlookBarPIMOnly]
Used in place of [DefaultOutlookBar], if Outlook is set up in PIM Only mode.

[DefaultOutlookBarNoIFM]
Used in place of [DefaultOutlookBar], if Outlook is set up without installing Integrated File Management (IFM).

[DefaultOutlookBarPIMOnlyNoIFM]
Used in place of [DefaultOutlookBar], if Outlook is set up in PIM Only mode and Integrated File Management (IFM) is not installed.

[UpgradeOutlookBar]
Used in place of [DefaultOutlookBar], if you are upgrading from Outlook 97. If [UpgradeOutlookBar] is used, [UpgradeGroupSections] applies rather than [GroupSections]. 

Section (cont.)
Description (cont.)

[GroupSections]
Represents an Outlook Bar Group. This section contains pointers to collections of shortcuts represented by [ShortcutsSections].

[UpgradeGroupSections]
Used in place of [GroupSections], if you are upgrading from Outlook 97. If [UpgradeOutlookBar] is used, [UpgradeGroupSections] applies rather than [GroupSections].

[ShortcutsSections]
Represents a collection of shortcuts. This section contains pointers to shortcuts described by [ShortcutSections].

[ShortcutSections]
Specifies properties for a single shortcut.

[Strings]
Optional. Lists localizable strings used throughout the Outlbar.inf file.

[Version]

 xe "[Version] section, Outlbar.inf"\\€part3.doc-1011 
This following format defines the standard header for all Outlbar.inf files:

[Version]

Signature="$Chicago$"

OutlookInfVersion=1

If the signature is not $Chicago$ or if the OutlookInfVersion is not specified, Outlook will not accept the .inf file as valid. The signature string recognition is not case-sensitive.

[DefaultOutlookBar]

 xe "[DefaultOutlookBar] sections, Outlbar.inf"\\€part3.doc-1012 
The [DefaultOutlookBar] sections create groups of shortcuts for [GroupSections] that you specify. These sections use the following basic format:

AddGroups=

<group-section>[,<group-section>]…

Each listed section must correspond to a section in the Outlbar.inf file. The following example shows a typical [DefaultOutlookBar] section that creates three groups of shortcuts:

[DefaultOutlookBar]

AddGroups=OutlookGroup,MailGroup,OtherGroup

In this example, the Outlbar.inf file would contain at least three other sections that defined the contents of each group.

[GroupSections]

 xe "[GroupSections] section, Outlbar.inf"\\€part3.doc-1013 
[GroupSections] contain three parts:

· Name=<group name>
Specifies a name for the Outlook Bar Group represented by this section. If this property is omitted, the section name is used.

· Shortcuts=<shortcuts-section >
[,<shortcuts-section>]…

Lists pointers to other sections in the Outlbar.inf file that describe sets of shortcuts in the group. Each section of this type represents an Outlook Bar Group.

· ViewType=<integer>

If set to a value of 1, creates the group in small icon mode.

If you are upgrading from Outlook 97 and using [UpgradeGroupSections], the commands specify the values that you want to change for the group. Also, the OldName command specifies the name of the previous group that you want to change; the ShortcutsGroupIndex command (integer value) specifies that the shortcuts should be added to a group at a particular index, rather than the group specified by the OldName command.

The following example shows a typical [GroupSection]:

[OutlookGroup]

Name=Outlook

Shortcuts=OutlookShortcuts

If the name of the section is used as a parameter to a command in an [DefaultOutlookBar] section, the command affects that section and its contents. For example, if this sample section were referred to by the AddGroup command in the [DefaultOutlookBar] section, a group with a display name of "Outlook" would be created and would contain all of the shortcuts listed in the "OutlookShortcuts" section.

The following example describes an empty group named OBG:

 [OBG]

; I'm a lonely, empty group since my

; author left out the Shortcuts property.

;

; I also have an ugly name, OBG,

; since my Name property was forgotten.

If this section was listed in an AddGroup command, an empty group named OBG would be created.

[ShortcutsSections]

 xe "[ShortcutsSections] section, Outlbar.inf"\\€part3.doc-1014 
The following syntax lets you list a shortcut as part of the [ShortcutsSections] collection:

<shortcut-section-reference>

[=<target-namespace>{,<rootid> | ,[<rootid>],<path>}]

The properties for the shortcut are specified in the [ShortcutSection] pointed to by this line. Optionally, you can also set the Target property, and the [ShortcutSection] of the same name will be ignored; all other properties will use their default values.  

[ShortcutsSections] list a sequence of shortcuts. If a section is referred to by a Shortcuts command in [GroupSections], it is considered an element of that group. Therefore, any commands will also affect the shortcuts in that group. For example, consider the following segment from Outlbar.inf:

[DefaultOutlookBar]

AddGroup=OutlookBarGroup

[OutlookBarGroup]

Shortcuts=OutlookShortcuts

[OutlookShortcuts]

Inbox

If Outlook processes this segment, an Outlook Bar Group named OutlookBarGroup is created. A single icon, Inbox, is installed in that group.

This example shows a typical [ShortcutsSection]:

[OutlookShortcuts]

Inbox=1,1

; Special syntax. No need for an [Inbox] section.

Calendar

Contacts=1,3

; Also uses special syntax.

Tasks

Journal

Notes

DeletedItems

Note the use of the optional syntax to specify the Target property for both the Inbox and the Contacts shortcut. Because the other shortcuts use the standard syntax, the following [ShortcutSections] would be expected from this example: [Calendar], [Tasks], [Journal], [Notes], and [DeletedItems].

[ShortcutSections]

 xe "[ShortcutSections] section, Outlbar.inf"\\€part3.doc-1015 
[ShortcutSections] contain two parts:

· Target=<target-namespace>
{,<rootid> | ,[<rootid>],<path>}
Required.  Specifies the shortcut target.

· Name=<name>
Optional. Overrides the default name for the shortcut, which is determined by the <namespace> field.

Each [ShortcutSection] describes a single shortcut and must have a target. Optionally, you can override the display name by setting the Name property. You can specify the target with either the <rootid> or the <path> field. If you use the <path> field, the <rootid> field must have a value of 0 (as a placeholder), and the <path> field must be either a full path (for example, \\Public Folders\All Public Folders\Office), or a path relative to the default store root (for example, Inbox\subfoldername).  

The following are available values for the <namespace> field:

· MAPI namespace — Integer value of 1. Shortcuts point to MAPI folders. For a list of valid codes, see "MAPI Namespace <Rootid> Codes" in this chapter. 

· File System namespace — Integer value of 2. Shortcuts point to file system objects (files). For a list of valid codes, see "File System Namespace <Rootid> Codes" in this chapter. 

The following example shows a possible [ShortcutSections] for a default MAPI calendar folder:

[Calendar]

; See   REF _Ref387687560

; \* MERGEFORMAT  Appendix A  for MAPI <rootid> codes

Target=1,1



; 1 is Calendar

[Strings]

 xe "[Strings] section, Outlbar.inf"\\€part3.doc-1016 
This section must be named [Strings]. Use the following format for this section: 

<Strings-key>=<value>

This section defines one or more <Strings-key> fields. <Strings-key> must be a unique name consisting of letters and digits. <Value> is a string consisting of letters, digits, or other printable characters. It should be enclosed in double quotation marks if the corresponding <Strings-key> is used for an item that requires double quotation marks.

Although the [Strings] section is generally the last section in the Outlbar.inf file, a <Strings-key> defined in this section may be used anywhere in the Outlbar.inf file that the corresponding string would be used. Outlook expands the <Strings-key> to the given string and uses it for further processing. A <Strings-key> used in another section must be enclosed in percent signs (%). Also, the [Strings] section makes it easier to translate strings for international markets by placing all strings that can be displayed by the Outlook Bar in a single section of the Outlbar.inf file.

The following example shows the [Strings] section for a sample Outlbar.inf file:

[Strings]

OUTLGRP="Outlook"

MAILGRP="Mail"

OTHRGRP="Other"

This example shows how to use a string from the [Strings] section:

[OutlookGroup]

Name=%OUTLGRP% Group
; Names the group "Outlook Group"

Tasks

String Substitution

 xe "aa"\\€part3.doc-1017 
The Outlbar.inf file provides support for a table of localizable strings. The Outlbar.inf file can contain a [Strings] section that provides a table of strings for substitution. Generally, the Outlbar.inf string table should include all of the strings that appear in the Outlook Bar user interface.  

The following example shows a typical substitution string:

[MyGroup]

Name=%GROUPNAME%

; %GROUPNAME% is expanded to "Microsoft Ren"

[Strings]

GROUPNAME="Microsoft Ren"

Comments

 xe "Comment text in Outlbar.inf file"\\€part3.doc-1018 
Comments may appear on any line in the Outlbar.inf file. A comment is preceded by a semicolon (;). Comment text appears between the semicolon and the end of a line. Note that semicolons within quotation marks do not begin comments.

In this example, the bold text is a comment:

[Inbox]

Name="Hello;World"
; This also sets the display name
MAPI Namespace <Rootid> Codes

 xe "MAPI namespace <rootid> codes"\\€part3.doc-1020 
The following table defines the values for the <rootid> codes used for [ShortcutsSections] and [ShortcutSections].

Value
Special Folder
Icon

0
Inbox
Inbox

1
Calendar
Calendar

2
Contacts
Contacts

3
Tasks
Tasks

4
Journal
Journal

5
Notes
Notes

6
Deleted Items
Trash can

7
Sent Items
Sent Items folder

8
Outbox
Outbox Tray

9
Drafts
Drafts folder

10
Outlook Today
Outlook Today

11
Public Folders Root
Generic store

12
Public Folder Favorites folder
Mail folder

13
News
News

14
User Public Folder Favorites
None

15
User Store folders
None

File System Namespace <Rootid> Codes

 xe "File System namespace <rootid> codes"\\€part3.doc-1021 
The following table lists the <rootid> values that you can use with the File System namespace. The values are derived from constants documented in the Win32® Software Developer's Kit (SDK). Consult this SDK for more information about these constants.

Value
Win32 Constant (from SHLOBJ.H)
Interpretation

0
CSIDL_DESKTOP
Desktop folder

1
CSIDL_INTERNET
The Internet

2
CSIDL_PROGRAMS
Start Menu Programs folder

3
CSIDL_CONTROLS
Control Panel

4
CSIDL_PRINTERS
Printers

5
CSIDL_PERSONAL
My Documents

6
CSIDL_FAVORITES
Internet Favorites Bookmarks folder

7
CSIDL_STARTUP
Start Menu Programs Startup folder

8
CSIDL_RECENT
Recent Documents; contains links

9
CSIDL_SENDTO
Contains items placed on Send To shortcut menu

10
CSIDL_BITBUCKET
Recycle Bin

11
CSIDL_STARTMENU
Start Menu folder

16
CSIDL_DESKTOPDIRECTORY
Desktop folder

17
CSIDL_DRIVES
My Computer

18
CSIDL_NETWORK
Network Neighborhood

19
CSIDL_NETHOOD
Consult Win32 documentation

20
CSIDL_FONTS
Fonts folder

21
CSIDL_TEMPLATES
Consult Win32 documentation

22
CSIDL_COMMON_STARTMENU
Common Start Menu folder

23
CSIDL_COMMON_PROGRAMS
Common Start Menu Programs folder

24
CSIDL_COMMON_STARTUP
Common Start Menu Programs Startup folder

25
CSIDL_COMMON_DESKTOPDIRECTORY
Common Desktop folder

26
CSIDL_APPDATA
Consult Win32 documentation

27
CSIDL_PRINTHOOD
Consult Win32 documentation

28
None
Outlook Installation Directory

29
CSIDL_ALTSTARTUP
Consult Win32 documentation

30
CSIDL_COMMON_ALTSTARTUP
Consult Win32 documentation

31
CSIDL_COMMON_FAVORITES
Consult Win32 documentation

32
CSIDL_INTERNET_CACHE
Internet Explorer Cache folder

33
CSIDL_COOKIES
Internet Explorer Cookies folder

34
CSIDL_HISTORY
Internet Explorer History folder

Predefined Substitution Strings

 xe "Outlbar.inf file:predefined substitution strings"\\€part3.doc-1025 
Outlook includes several predefined strings that you can use in the Outlbar.inf file. These strings expand as paths to various directory locations based on the end-user setup. You cannot use these strings in the [Strings] section. 

The following example shows a predefined substitution string:

[Notepad]

%11%\NOTEPAD.EXE
; %11% is the user's Windows System directory

The following table lists the available substitution strings.  

ID
Location

01
Location of the operating system

10
Machine directory (maps to the Windows directory on a server-based setup)

11
Windows System directory

12
Windows System Drivers directory

13
Windows Command directory (Windows 95 only)

17
Windows INF directory

18
Windows Help directory

20
Windows Fonts directory

21
Windows Viewers directory

22
Windows VMM32 directory (Windows 95 only)

23
Windows Color directory (Windows 95 only)

24
Root of the drive containing the Windows directory

25
Windows directory

26
Guaranteed boot device for Windows Winboot (Windows 95 only)

28
Host Winboot (Windows 95 only)

30
Root directory of boot drive

31
Root directory for the host drive of a virtual boot drive - compressed volume (Windows 95 only)

Outlook Today

 xe "Customizing Outlook Today:overview"\\€part3.doc-1030 
Microsoft Outlook 98 includes a unique "at a glance" view called Outlook Today. This view displays information about the user's calendar, tasks, e-mail, and contacts, using the familiar and attractive style of a Web page. Outlook Today lists upcoming appointments, indicates what tasks are due, lets users search Outlook for contacts, and shows the number of unread e-mail messages in the user's Inbox. Each item on the Outlook Today page is a hyperlink to an Outlook item or view, so users can gain access to more specific information about a meeting or check off a completed task. And end user can easily customize his or her Outlook Today page by using the Outlook Today Options page. For example, the Options page lets end users change how many days of meetings to display.  

Outlook Today displays information in HTML, which allows limited customization by enterprise developers and solution providers. Outlook Today can be thought of as a "home page" of information available to Outlook users; therefore, it provides an excellent opportunity to deliver corporate intranet or public Internet content, in addition to Outlook information. For example, you might create a standard Outlook Today page that shows a bulletin of corporate news and a stock ticker tied to real-time market data taken from the Web. A customized version of Outlook Today might also contain information drawn from other enterprise applications (such as account tracking or financial management software), enabling an Outlook Today page that is targeted to a specific job function within an organization. For example, you might create an Outlook Today page for sales and marketing employees, the accounting department, or senior management. 

 xe "Databinding, using with Outlook Today"\\€part3.doc-1035 
Outlook Today uses databinding, a new feature of Microsoft Internet Explorer 4.0, to link an HTML table on the page to a datasource—Outlook 98, in this case—via an ActiveX® datasource control. The page has separate databinding tables for the Calendar, Mail, and Tasks sections. After the page loads, the datasource controls collect the appropriate Outlook information and display it in the databinding tables. Whenever the source information is updated or new items are created, the databinding controls update their tables dynamically without refreshing the page. (For more information about databinding, see the Internet Client SDK). You can customize the Outlook Today page in the following ways:

· Adding text, links, and images

· Adding script

· Adding ActiveX components

· Changing styles (backgrounds, fonts, etc

Customizing Outlook Today is an advanced developer feature. Therefore, keep in mind the following limitations when you add content and functionality to the Outlook Today page:

· Although Outlook Today provides users with a powerful time-saving summary view, it is not intended to replace the Inbox, Calendar, or Task modules. Nor is Outlook Today intended to replace a Web browser. You should consider Outlook Today as a summary and starting point for personal, intranet, and Internet information delivery.

· Modifying the Outlook Today page may result in reduced performance when information is retrieved and rendered on the page. Again, you should consider the Outlook Today page as a starting point, which users read at startup or check into periodically during the day or week. 

· Outlook Today is expected to change in future releases of the product. Therefore, any changes to Outlook Today pages that work in Outlook 98 may require additional updates or rewriting in future versions of Outlook.

· You can modify Outlook Today by adding links or controls that connect to untrusted, external Web sites or content providers. Outlook Today does not verify the security of the URL you assign to Outlook Today in the registry or the pages you browse within the Outlook Today frame. Outlook Today pages that contain unsafe content can expose individual users and entire organizations to the risks associated with that content, including viruses and data destruction.

Note: If you must include links to untrusted, external sites on your customized page, make sure that the links launch the URLs in a new browser window to take advantage of browser security. For instructions, see "Customization Details" in this chapter.

· You cannot add Outlook Today as an Active Desktop® item. The Outlook Today functionality only works when it is hosted within the Outlook window.

Distributing Your Customized Outlook Today Page

There are three ways to distribute a customized Outlook Today page:

 xe "Customizing Outlook Today:distributing your customized page"\\€part3.doc-1040 
· Customized .dll file. You can save your customized Outlook Today page as a .dll file and view it in place of the default Outlook Today page; for more information, see "Advanced Customization" in this chapter. This method uses the res:// protocol. For example, the protocol for the default page is res://Outlwvw.dll/Outlook.htm. For an arbitrary path, use the following format:

"Url" = "res://C:\Program Files\Microsoft Office\Office\Outlwvw.dll/Outlook.htm"

-or- 

"Url" = "res://<path to .dll file>/<resource within the .dll file>"

· Web server. Because Outlook Today hosts the Internet Explorer 4.01 browser, you can save your customized Outlook Today page as an .htm or .asp file on a personal or corporate Web server; for more information, see "Basic Customization" in this chapter. This method uses the http:// protocol (for example, "Url" = "http://corpweb/users/outlook.htm").

· File/Network. You can save your customized Outlook Today page as an .htm file on your local hard disk or corporate network; for more information, see "Basic Customization" in this chapter. This method uses the file:// protocol (for example, "Url" = "file://C:\myfile.htm"). 

Because advanced customization takes advantage of performance enhancements, Microsoft recommends that you save your customized page as a .dll file. It will load much faster than if you use the "Web Server" or "File/Network" scenarios. You can distribute your customized .dll file and also change the Outlook Today registry key to point to your customized page by using the Outlook 98 Deployment wizard. For more information about adding your customized .dll file to the installation package, see "Stage 2: Specify Custom Active Setup Components" in Chapter 2; for more information about adding registry keys during the installation process, see "Stage 5: Add Registry Entries" in Chapter 2.  

Basic Customization
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With Basic customization, you can customize and save your Outlook Today page as an .htm file on your hard disk, network, or Web server using a simple, three-part process. You will need a working knowledge of HTML and the Windows registry; the tools and ability to edit a custom .dll file are not required. 

If you are proficient with Microsoft Developer Studio or a similar resource editor, Microsoft recommends that you go to "Advanced Customization" in this chapter. With advanced customization, you can save your customized Outlook Today page as a .dll file for better performance.
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PART 1: To obtain the Outlook Today source

Important: If you copy the Outlook.htm source file directly from the Outlook 98 Deployment Kit CD, you can skip these steps and go to Part 2.

1. In Internet Explorer, go to the following URL:

res://C:\Program Files\Microsoft Office\Office\Outlwvw.dll/Outlook.htm

Note the forward slash after the .dll file name. If you installed Outlook to a non-default directory, you may need to change the file path to the URL. 

2. Outlook.htm will generate a script error because it is not being hosted within the Outlook window. When you receive an error message, click No. The Outlook Today HTML page displays (without the graphics and data tables). 

3. On the View menu, click Source to open a copy of the Outlook.htm source file in Notepad.

4. On the File menu, click Save As, and save this file to your hard disk.

Note: Because Outlook Today uses specialized layout properties, it will not appear correctly in Microsoft FrontPage®98 or other HTML editors. 

5. The text display:none appears three times in the file. Search for and replace all three instances with the text display:. This change is necessary because the source file was designed to be saved as a .dll file and loaded with the res:// protocol. Instead, you are saving it as an .htm file, and loading it with the http:// or file:// protocol.
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PART 2: To add the correct settings to your registry

1. Locate the following registry key: 

HKCU\Software\Microsoft\Office\8.0\Outlook\Today

2. If this key does not exist, add it.

3. In this key, add the string value Url (this value is case sensitive). For its value data, enter the path to the Outlook.htm file that you saved in Part 1, step 4. For example, Url might contain the following data:

file://C:\My Documents\Outlook.htm

Note: If at any time you want to reset the registry and return to your original Outlook Today page, just delete the Url registry key. Then, Outlook will point to the original Outlook Today page.
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PART 3: To modify your new Outlook Today page

1. Start Outlook, and go to Outlook Today.

The three data tables (Calendar, Mail, and Tasks) will render more slowly, line-by-line rather than all at once. This is because the page you are viewing has been loaded with the http:// or file:// protocol.  

2. Modify the HTML.

For more information about the types of changes you can make, such as adding a link or graphic, see "Customization Details" in this chapter.

Note: On the Outlook Today page, you cannot customize the existing data, sorting, or filtering in any of the Calendar, Mail, and Tasks data tables (although you can remove the Mail table and add your own).

Advanced Customization
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With a resource editor, such as Microsoft Developer Studio, you can save your customized Outlook Today page as a resource .dll file by using a five-part process. Advanced customization allows you to take advantage of performance enhancements, described in "Performance Impact" in this chapter. 

Important: The following instructions are for Microsoft Developer Studio 5.0 only. You must use Microsoft Developer Studio 5.0 (earlier versions may also work) or a similarly capable resource editor. Also, you must use Windows NT. Developer Studio does not support the ability to replace resources in executable files on Windows 95.
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PART 1: To copy the original Outlwvw.dll resource file

1. Locate the Outlwvw.dll resource file, which is installed in the C:\Program Files\Microsoft Office\Office folder by default.

2. Make a working copy of Outlwvw.dll (for example, Outlwvw_custom.dll).

WARNING: Do not modify or remove Outlwvw.dll. This file contains both the Outlook Today source files and the source files for the Find and Organize features. If you want to create a custom .dll file, give the new file a different name, and update the URL setting in the registry accordingly. 
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PART 2: To add the correct settings to your registry

1. Locate the following registry key: 

HKCU\Software\Microsoft\Office\8.0\Outlook\Today

If this key does not exist, add it.

2. In this key, add the string value Url. For its value data, enter the path to the Outlook.htm resource within your Outlwvw_custom.dll file that you saved in Part 1, step 2. Make sure that you use the res:// protocol. For example, Url might contain the data:

res://C:\My Documents\Outlwvw_custom.dll/Outlook.htm

Note the forward slash after the .dll file name.

Note: If at any time you want to reset the registry and return to your original Outlook Today page, just delete the Url registry key. Then Outlook will point to the original Outlook Today page.

PART 3: To open the resource .dll file

1. In Windows NT, start Microsoft Developer Studio.

2. On the File menu, click Open.

3. Select the Outlwvw_custom.dll that you saved in Part 1, step 2.

4. In the Open as box, click Resources.

5. Click Open to open Outlwvw_custom.dll.

6. Double-click the tree-node 2110 to open it.

7. Double-click the Outlook.htm node.

You should now be in Developer Studio's binary editor, with text on the right side of the window and hex-numbers on the left side.

PART 4: To modify the HTML

You can modify the HTML file by editing the text directly in the Developer Studio binary editor, but this is a fairly difficult editor to work in. It is much easier to modify the HTML in a separate text editor, copy it, and then paste it into the Developer Studio editor. 

1. In Developer Studio, select all of the .dll file text, and copy it.

2. Open a text editor, such as Notepad, and paste in the text.

3. Modify the HTML.

For more information about the types of changes you can make, such as adding a link or graphic, see "Customization Details" in this chapter.

4. When you are done, select all of the file text, copy it, and paste it back into the .dll file in Developer Studio.

5. Save your Outlwvw_custom.dll file.

6. View the Outlook Today page in Outlook. You will see your modified page.

Important: In the HTML, you may notice three commented <RENSTATICTABLE> sections. If you change the layout of the Calendar, Mail, or Tasks databinding tables, you will also need to make parallel changes to their associated RENSTATICTABLEs. For more information, see "About the RENSTATICTABLE" in this chapter.

If you are making and testing a large number of changes, you may prefer to use this alternate method to modify the HTML:

1. In Developer Studio, select all of the .dll file text, and copy it.

2. Open a text editor, such as Notepad, and paste in the text.

3. Save this file to your hard disk.

4. Point the Outlook Today registry setting to this saved file by using the file:// protocol.

5. Search for and replace the three instances of display:none with display:. (Because you are using the file:// protocol, the live databinding tables will not be visible without this step.) 

6. Make changes to this file. 

For more information about the types of changes you can make, such as adding a link or graphic, see "Customization Details" in this chapter.

7. Undo the search and replace changes you made in step 5 to prepare the file for res:// protocol format.

8. When you are done, select all of the text, copy it, and paste it back into the .dll file in Developer Studio.

9. Save your Outlwvw_custom.dll file.

10. Set the registry setting appropriately (res://<path to Outlwvw_custom.dll>/Outlook.htm).

Go to Outlook Today to see your modified page.

Note: On the Outlook Today page, you cannot customize the existing data, sorting, or filtering in any of the Calendar, Mail, and Tasks data tables (although you can remove the Mail table and add your own). 

PART 5: To add images to your .dll file

If your new HTML file makes references to images outside the original Outlwvw.dll resource, you can include these images in the Outlwvw_custom.dll resource file to take advantage of the resource file's performance advantages. You can include a .gif, .jpeg, or other type of image file. (This is optional—you can always save the images as regular files on your hard disk.)

1. Using an image editor, create the .gif file that you want.

2. With Outlwvw_custom.dll open in Developer Studio, double-click the tree node 2110.

3. Select any existing .gif resource.

4. On the Edit menu, click Copy, and then click Paste to create a duplicate of this .gif resource under the 2110 tree node. (For example: if you copy Calhdr.gif and then paste it, you will have a duplicate called Calhdr.gif1.)

5. Right-click this duplicate resource, click Properties, and then change the name to whatever you like (for example, "Whatever.gif").

Remember that you must include the quotation marks around the name.

6. In Developer Studio, open your .gif file from step 1.

7. On the File menu, click Open.

8. In the Open as box, click Binary.

9. On the Edit menu, click Select All to select all of the file text.

10. On the File menu, click Copy.

11. Close this file.

12. Double-click the new Whatever.gif resource to open it, and replace the data in the file with the data you copied in step 10. 

13. Close the Whatever.gif window, and save your Outlwvw_custom.dll file.

Your .gif file is now embedded as a resource in Outlwvw_custom.dll. You can refer to it in your Outlook.htm file as res://Outlwvw_custom.dll/Whatever.gif to take advantage of the resource file's performance optimizations.

Customization Details
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This section describes the different ways that you can modify your Outlook Today page.

Adding Text and Images

The Outlook Today page is an HTML page that uses cascading style sheets (CSS). It is laid out with standard HTML tags and CSS properties. You can add text and images just as you would on any other HTML page. For more information about how to use CSS properties, see the Internet Client SDK.

Note: The original page uses the res:// protocol to point to its images (for example: res://Outlwvw.dll/Calhdr.gif). If you supply your own image files, you can use the file:// or http:// protocols (for example: file://C:\My Documents\myimage.gif).

Adding Links
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To link to an external Web site, you must not use a simple HTML hyperlink. Instead, you must use the following syntax to launch that link in a new browser window, which allows you to take advantage of browser security.

WARNING: You must take special care when adding links to external, untrusted Web sites. If you add a simple hyperlink to your page, by default Outlook will follow that link within the Outlook Today window. Because security is always disabled in Outlook Today, there are no security safeguards to protect you from viewing a site that contains unsafe content.  

To link to a local Outlook folder, use the following syntax:

<a href="" onclick="window.location='outlook:Sent Items';">Sent Items</a>

To link to an Exchange Server Public folder, use the following syntax:

<a href="" onclick="window.location='outlook:\\Public Folders\\Favorites';">Favorites</a>

Changing Font Styles
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You can change the styles of most fonts on the page by modifying their style sheet definitions at the top of the page. For example, the following lines define the text styles for a completed task, an important item, and the date at the top of the page:

.TskDone
{font-size:8pt; color:gray; text-decoration:line-through; }

.itemImportant
{color:red}

.date

{font-size:11pt;font-family:arial;text-decoration:none;

font-style:normal;color:white;font-weight:bold; }

In some cases these styles are referenced directly in later lines of the page. But in other cases, such as "TskDone" and "itemImportant" above, the lines that reference these styles are dynamically generated within the three main databinding tables (Calendar, Mail, and Tasks), and you will never see them used literally in the code.

For example, when you check a task as complete in the Tasks table, the databinding table automatically applies the "TskDone" style to the text. Because the "TskDone" style is defined as gray strike-through, the completed task's text will also use this same style. However, you can change the style to whatever you like.

Adding Additional ActiveX Controls
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You can add ActiveX controls to the page, just as you would any other HTML page. However, the security safeguards have been disabled in Outlook Today, so you must be sure about a control's trustworthiness before adding it to your page. It's a fun exercise, for example, to add the Microsoft Investor stock ticker (http://investor.msn.com) to your page.

For more information about how to create your own ActiveX controls, including databinding controls, see the Internet Client SDK.

Adding Script
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With script, you can also take full advantage of the Outlook object model. Be aware, however, that as with any interpreted scripting language, performance will not be at its best. This sample JavaScript exposes Outlook's Application object, and then uses it to open the Inbox in a new Outlook window:

<html>

<script language=JavaScript>

var theApp = window.external.OutlookApplication

var theOLNS = theApp.GetNameSpace("MAPI")

var myInbox = theOLNS.GetDefaultFolder(6) //olFolderInbox

myInbox.Display()

</script>

</html>

Disabling Outlook Today
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You can turn off Outlook Today and instead show the contents of your root folder (similar to Outlook 97).

To turn off Outlook Today

1. In regedit, go to the following registry key:

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Today\

2. Add the new DWORD Value, Disable.

3. Modify the Disable Value, and give it a value data of 1.

You can enable Outlook Today again by either deleting the Disable registry value or setting it to 0.

Performance Impact
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With advanced customization, there is no performance degradation between your customized page and the original, even if you add a link or graphic to the page. With Basic customization, the only performance difference is that your Outlook data (Calendar, Mail, Tasks) will appear more slowly, line-by-line, as the page loads. By comparison, in the original page, your data appears almost immediately. After it is loaded in the view, though, there is no performance difference between your customized page and the original page. 

As with any Web page, the more elements that you add, such as images, script, or ActiveX controls, the longer the page will take to load. Also, performance depends on your mail support and on the number of items in your store. Using a Corporate/Workgroup configuration will decrease performance (constructing the page requires many calls to the server). The more items in your store, the longer it takes to display. For example, on a Pentium 120 with 32 MB of RAM, using an Internet Only configuration and a moderate store size, the performance difference is approximately four seconds.

To improve the performance of HTML rendering and databinding, Microsoft made the following enhancements: 

· Files are compiled into a resource .dll file. The Outlook Today source HTML and .gif files are compiled into a resource file—Outlwvw.dll—allowing Outlook to load the page faster. This file is installed in the ...\Program Files\Microsoft Office\Office directory.
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· res:// streaming and processing. When you specify a URL with the res:// protocol, Outlook performs special streaming and preprocessing on the page. This does not take place when you use the http:// or file:// protocols.

When the page first loads, it takes some time for the databinding tables to collect and render all of their data. To avoid this delay and display your information more quickly at load-time, Outlook initially hides the three databinding tables and replaces them with temporary, raw HTML tables. As it streams the HTML from the resource .dll file, Outlook builds temporary static tables (containing the same information as the live databinding tables) and inserts them directly into the stream (at the RENSTATICTABLE tags). As a result, your Outlook information appears faster than if you had to wait for the databinding to complete.

After the page is loaded, the hidden databinding tables activate and gather their data. When they finish, Outlook hides the temporary static tables and makes the live databinding tables visible. This switch from static to live tables is not noticeable in the Calendar and Mail tables, but you will see it in the Tasks table (when the column of check boxes appears). 

Note: These performance enhancements apply only to pages loaded via the res:// protocol, not via http:// or file:// protocols. 

About the RENSTATICTABLE
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In the HTML, you'll see three commented RENSTATICTABLE blocks. When Outlook reads the page through the res:// protocol, it uses these blocks to determine how to insert the temporary static tables.

For example, review the block that defines the Calendar (both live and static tables):

<!-- Live Databinding Table  -->

<table border=0 name="ItemCol" id=CalendarLiveTable datasrc="#CalList" style="margin-top:0px;margin-left:0px; display:none">

<tbody>

<tr>

<td width=23px></td>

<td valign=top width=10><div datafld="Next" DATAFORMATAS="html"></DIV></TD>

<td valign=top nowrap ><DIV DATAFLD="StartEnd" DATAFORMATAS="html"></DIV></TD>

<td valign=top><div class=CalendarSubjectLocation datafld="SubjectLocation" DATAFORMATAS="html"></DIV></TD>

</tr>

</tbody>

</table>

<!-- Temporary Static Table -->

<table border=0 id=CalendarStaticTable style="margin-top:0px;margin-left:27px;"><br>

<!-- RENSTATICTABLE~Calendar~Next=valign=top width=10~

StartEnd=valign=top nowrap~SubjectLocation=valign=top~ -->

</table>

The block includes two sections, the Live Databinding Table and the Temporary Static Table. Relevant elements include the following:

· display:none
This is a CSS attribute that tells the page to hide the table. When the page loads, this table stays hidden and the temporary static table is visible instead. After the live databinding table gathers all of its information, however, Outlook overrides the display:none attribute automatically and removes the static table. In most cases, this switch is imperceptible.

· <!-- RENSTATICTABLE ... -->

This element tells Outlook to "insert a temporary static table here." The properties that follow this tag describe how to construct the table, giving you a necessary degree of control over how Outlook constructs its temporary static tables. In most cases, you may want to make the static table look like the live table so that the switch is imperceptible.

Notice that each section of the RENSTATICTABLE syntax corresponds to a section in the live table definition.

· ~Calendar

This element identifies the static table that contains the data for the Calendar.

· ~Next=valign=top width=10

This element tells Outlook to add a first column (<TD>) to the table for each row, with the following syntax:

<td valign=top width=10 class="CalendarNext">

...

{inserts "Next" data here for each row}

...

</td>

This column contains the triangular "Next/Current Appointment" indicator.

· ~StartEnd=valign=top nowrap

This element tells Outlook to add another column to each row:

<td valign=top nowrap class="CalendarStartEnd">

...

{inserts "StartEnd" data here for each row}

...

</td>

This column contains the start and end times for each appointment.

· ~SubjectLocation=valign=top

This element tells Outlook to add a final column to each row:

<td valign=top class="CalendarSubjectLocation">

...

{inserts "SubjectLocation" data here for each row}

...

</td>

This column contains the Subject and Location for each appointment.

· ~
The final "~" is required. It signals the end of the command.

· CalendarSubjectLocation style, InboxCount styles, etc.

When Outlook constructs the cells, it adds a class property to the cell tag that is a combination of the table name and the column name:

<tablename> + <columnname>

This allows you to set the styles of the table cells for each column. Then you can define these styles at the top of the Outlook.htm file, among the CSS style definitions. You will notice that two definitions already exist:

CalendarSubjectLocation

{margin-left:10px;color:windowtext;}

.InboxCount


{margin-left:13px;}

Outlook Security
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Outlook 98 uses a security model that is different from that of Outlook 97 and previous Microsoft Exchange clients. In addition to the previous Microsoft Exchange Server security, Outlook 98 supports S/MIME. S/MIME security can be used to send and receive secure e-mail messages over the Internet as well as within an organization.

The Outlook 98 security model helps ensure the security of Outlook 98 e-mail messages by using public and private keys to send and receive signed and encrypted mail. This feature includes digital signing, which allows users to verify the identity of the sender and the integrity of messages, and digital encryption, which protects the contents of messages from being read by anyone except their intended recipient(s). Users can exchange signed and encrypted mail with other mail clients that supports S/MIME.

Outlook 98 uses a secure store to store a user's private key information. A user's certificate contains his or her public key and other required information, such as e-mail address. Mail encrypted by the user's public key can be decrypted using only the associated private key and vice versa. Therefore, when you send encrypted mail, you use the receiver's certificate (public key) to encrypt it; likewise, when you read encrypted mail, your private key is used to decrypt it.

Note: For Corporate or Workgroup configuration users, the Microsoft Exchange Key Management Server (KMS) 5.5 issues keys for Microsoft Exchange Server security only. Microsoft Exchange Key Management Server 5.5, Service Pack 1 will provide S/MIME keys for corporate users. 

Registry Settings for Security
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Set the following registry keys for Outlook 98 security options:

· HKCU\Software\Microsoft\Office\8.0\Outlook\Security\Options
Each time a user attempts to read a signed message that has an invalid signature, a dialog box appears warning the user about the signature and listing the cause of the failure. You can choose not to show this dialog box. Only the last bit of the registry key is used, and it is set to a value of 0 by default.

· HKCU\Software\Microsoft\Office\8.0\Outlook\Security\MinEncKey
This registry key (type=DWORD) sets a minimum key length for encrypted mail. You can set a minimum key length for your users based on the desired security level. Outlook displays a warning message if this minimum key length is not met. Standard key sizes are 40, 64, 128, and 168. International users will not be able to read mail encrypted using a key greater than 40 bits.

· HKCU\Software\Microsoft\Office\8.0\Outlook\Security\RequiredCA

This registry key (type=STRING) limits users to certificates from a specific certificate authority only (for example, only the Microsoft Exchange KMS). Specify the certificate authority name as the registry key value. 

Note: To disable S/MIME, set this registry key to the name of the Microsoft Exchange KMS. Then, in KMS, use the Issue V1 certificates only option to disable the ability to issue S/MIME (V3) certificates. 

Upgrading Security Users from Outlook 97 and 
    Microsoft Exchange Client
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The first time a user attempts to send or read secure e-mail, Outlook triggers a security upgrade feature. To upgrade to Outlook 98 security, the old .epf file should exist on the user's computer, and the user should know the password. 

During the upgrade process, the user selects a keyset name for his or her security keys, which includes one signing key and one encryption key. The user can accept the default name or choose a unique name (for example, "my security keys"). Also, the user must choose one of the following security levels, which will be associated with the user's keys: 

· High. Each time the keys are accessed, the user must enter a password. 

· Medium. A dialog box appears notifying the user that his or her keys are being accessed; no password is required.

· Low. No dialog box appears and no password is required.

The Outlook upgrade feature attempts to save the security information in a secure (protected) store. If the .epf file cannot be found or the user cannot remember the password, the upgrade feature can be canceled. Then, the user should recover his or her security keys (that is, enroll again) by asking for a new security token from the administrator. The upgrade process must occur before the user can become security-enabled, with the ability to send and receive secure e-mail.

 xe "Enrolling security keys"\\€part3.doc-1105 
To enroll in security or obtain a certificate using the Microsoft Exchange 
    Key Management Server

1. Contact the system administrator for a security token. The request for security enrollment uses this token. After receiving the token, continue with step 2.

2. On the Tools menu, click Options.

3. Click the Security tab.

4. Click Get a Digital ID, and then select Enroll in Exchange Server Security. 

5. Type your token, and then click OK. A message is sent to the Microsoft Exchange KMS. After you receive a reply, Outlook attempts to store your security keys in the secure store.

6. Select a security level for your keys (High, Medium, or Low), and then click OK. The default security level is Medium. To change the level, click Set Security Level. The levels are as follows:

· High. Each time the keys are accessed, the user must enter a password. 

· Medium. A dialog box appears notifying the user that his or her keys are being accessed; no password is required.

· Low. No dialog box appears and no password is required.

If you do not want to receive a prompt each time you send signed mail or read encrypted mail, you should select low security. Microsoft recommends that you set your keys to a high security level. At any time, you can change the security level associated with an Exchange security setting by clicking the Tools menu, clicking Options, and then clicking Security.

7. Click OK to save your changes.

8. To add the certificate to the Root Store, click Yes. The dialog box provides the required information about the certificate. If you click No, you will experience problems when you attempt to read and send secure messages.
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To enroll in security or obtain a certificate using external Certificate Authorities

1. On the Tools menu, click Options.

2. Click the Security tab.

3. Click Get a Digital ID, and then select Get an S/MIME certificate from an External Authority. A Microsoft Web page provides information for obtaining a certificate. The page lists various Certificate Authorities. Select the link to the Certificate Authority that you want to use to obtain a certificate.

Note: To send S/MIME messages to users on the same corporate server, you should use the S/MIME certificates issued by the Microsoft Exchange KMS. 

4. While your Web browser (Internet Explorer) is storing your certificate and keys on your computer, you may be prompted to select the security level associated with your keys. The default security level is Medium. To change this level while storing the keys, click Set Security Level. The levels are as follows:

· High. Each time the keys are accessed, the user must enter a password. 

· Medium. A dialog box appears notifying the user that his or her keys are being accessed; no password is required.

· Low. No dialog box appears and no password is required.

If you do not want to receive a prompt each time you send signed mail or read encrypted mail, you should select low security. 

5. While storing the certificates, you may be prompted to save the root certificate. To add this certificate to the Root Store, click Yes. The dialog box provides the required information about the certificate. If you click No, you will experience problems when you attempt to read and send secure messages. 

After the certificate and keys have been installed, Outlook can access and use them.

Configuring Security Settings
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The following procedures describe how users can configure Outlook security settings.

Viewing and Changing Security Settings

If the user enrolls in Microsoft Exchange Server security, Outlook creates security settings for the user.

To view or change Outlook security settings

1. On the Tools menu, click Options.

2. Click the Security tab.

3. Under the default security setting, select the setting you want to view or change.

4. Click Change Settings to view or change a particular setting.

5. Click OK.

Creating Outlook Security Settings

If the user obtains a certificate using an external Certificate Authority, Outlook creates a security setting for a single certificate. For multiple certificates, users may want to create their own settings.

To create an Outlook security setting

1. On the Tools menu, click Options.

2. Click the Security tab.

3. Click Change Settings.

4. Click Create New.

5. Click Choose to choose a signing certificate. A default encryption certificate and default signing and encryption algorithms are shown. You can change the encryption certificate by choosing another one. Also, you can change the default algorithms by selecting a different value from the drop-down list.  

You may want to make this setting the default setting for all secure mail or for this particular message format (S/MIME or Microsoft Exchange Server security) by using the check boxes provided. Also, for an S/MIME security setting, you may want to send your certificates with secure mail.

6. Click OK.

Moving Certificates and Keys Between Computers

Users with more than one computer can duplicate their security information using the Outlook Digital IDs Import/Export feature.

To move certificates and keys between computers

1. On the Tools menu, click Options.

2. Click the Security tab.

3. From the Digital IDs section, click Import/Export.

4. On the computer that has your keys and certificates, click Export.

5. On the other computer where you want to import the security information, repeat steps 1 through 3, and then click Import.

Outlook exports Microsoft Exchange Server security settings to an .epf file; Outlook exports S/MIME certificates and keys from external certificate authorities to a .pfx file. Users should provide a password to protect this information file.

Users should provide a friendly name, also referred to as the "keyset name" for the keys and certificates they are importing. A password is required before the file can be exported. After importing the security information, users can read and send secure messages. 

Renewing Keys and Certificates

 xe "Keys, security:renewing after time-out period"\\€part3.doc-1119 
A time-out period is associated with each certificate and private key. When the keys given by the Microsoft Exchange KMS approach the end of the time-out period, Outlook warns the user and offers to renew the keys. Outlook sends the renewal message to the server on the user's behalf. 

Troubleshooting

 xe "Certificates:troubleshooting"\\€part3.doc-1120 
The following table describes possible security-related problems that may occur and some troubleshooting techniques.

Problem
Troubleshooting techniques

When attempting to read signed e-mail, the user receives an error message about an invalid signature.
This problem can occur for a variety of reasons, which are listed in the invalid signature dialog box. The most common reason is that a sender's certificate is not trusted. Outlook 98 security uses trust-based certificates. If the user's security does not trust the sender's certificate or the certificate authority that issued the sender's certificate, the signature is considered invalid.

To correct the problem by editing the trust for the certificate, click Edit Trust in the invalid signature dialog box. The trust status of the certificate is displayed. Then, click Explicitly trust this certificate to identify this particular certificate as trusted. Also, you can trust the Certifying Authority's certificate by selecting it from the displayed hierarchy and changing its trust status.

The user is unable to see secure messages in the preview pane.
This feature is not currently supported; a future version of Outlook may support display of signed messages.

While sending a secure message, the user receives an error message—either the user's e-mail address does not match the address on the certificate or there is a problem with the user's certificate.
The user can view the certificate from the security setting chosen for the current e-mail message. If the user has more than one e-mail account, it is possible that the account being used has a different e-mail address than the one on the certificate. Other possible reasons for the problem could be that the certificate is not trusted, or the certificate is expired or revoked.

CHAPTER 5

Optimizing Microsoft Outlook 98
for Your Users

Read this chapter to learn about helpful tips for using Microsoft® Outlook™98. These tips can help you and your user community optimize Outlook features within the work environment. So that you can easily locate information in this chapter, topics are divided into these major categories:

· Configuring Outlook

· Folders, Forms, and Address Books

· Calendar Issues
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Configuring Outlook

Using Additional Command-Line Switches for Outlook

 xe "Command-line options:switches for Outlook tasks"\\€part3.doc-1200 
The following table describes additional command-line switches for Outlook. You can use these switches to perform important Outlook tasks from the command line.

Command-line switch
Description

/CleanFreeBusy
Cleans and regenerates free/busy information.

/CleanReminders
Cleans and regenerates reminders.

/CleanSchedPlus
Deletes all Schedule+ data (free/busy, permissions, and .cal file) from the server and allows the free/busy information from the Outlook Calendar to be used and viewed by all Schedule+ 1.0 users. 

/CleanViews
Restores default views. 

/Profile
Opens the Profile dialog box when Outlook starts so that users can select from a list of profiles. 

/ResetFolders
Restores missing folders for the default delivery location. 

/ResetOutlookBar
Rebuilds the Outlook Bar.

WARNING: ANY USE BY YOU OF THE COMMAND-LINE SWITCHES PROVIDED IN THIS SECTION IS AT YOUR OWN RISK. Microsoft provides these command-line switches without warranty of any kind, either express or implied, including but not limited to the implied warranties of merchantability and/or fitness for a particular purpose. 

To use command-line switches 

1. In Windows 95 or Windows NT, click Start, and then click Run.

2. Type the path to the Outlook application file, type a space after the path, and then type one or more of the command-line options listed in the table.

Optionally, you can create a shortcut to the Outlook application file (right-click on the Outlook icon, and then click Shortcut), and use the path to the shortcut instead.

3. Click OK.

Note: If any path contains spaces, such as C:\Program Files, you must enclose the path in quotation marks and use the correct case for each character in the path. The command-line switch must be typed outside the closing quotation mark. 

Setting Up Outlook for Multiple or Roaming Users

 xe "Configuring Outlook:setting up for multiple users"\\€part3.doc-1210 
Often, many users need to log on to the same computer or a roaming user may need to log on to different workstations on the network. In each of these cases, users might prefer to access their own Outlook settings. You can set up Outlook for multiple computer users or roaming workstation users if Windows NT is set up for roaming profiles.

Typically, the files that store Outlook settings are located in the Application Data directory to facilitate roaming (in Outlook 97, these files were located in the Windows directory). You can use the Outlook 98 Deployment Wizard to change the registry key that specifies the location of this directory (HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\User Shell Folders\"AppData"="%USERPROFILE%\Application Data"). Note that if files already exist in this directory, they will not be migrated automatically to the new Application Data directory. Also, if you change the default Application Data directory, make sure that your new directory path includes support so that you can create unique directories for multiple users on the same computer (the default directory uses the "%USERPROFILE%" variable in the path).

These files are: 

· Views.dat - contains customized view settings for the user 

· Outlprnt - contains customized print settings for the user

· <profile name>.fav - stores Outlook Bar settings 

· <profile name>.rtf - stores AutoSignature information 

Configuring Your Mail Account or Service to Dial 
    Your ISP Automatically

Using a Corporate or Workgroup Configuration

 xe "Automatic dial-up:configuring"\\€part3.doc-1220 
The Outlook Internet E-mail transport service (included with Outlook 98 Corporate or Workgroup support) does not call your Internet Service Provider (ISP) automatically to check for new mail. This section describes how to set up the transport service to connect automatically to your ISP at a regular interval to check for new mail. 

WARNING: The steps described in this section do not work if you are using Outlook with the Windows NT operating system (the issue should not occur with Windows NT). The Microsoft Dial-Up Networking 1.2 Upgrade is designed for Windows 95 only. Installing the ISDN Accelerator Pack on Windows NT may damage your dial-up networking.

You can set up the following connection options for Outlook and the transport service: 

· When you start Outlook, it immediately dials your ISP and checks mail. 

· At an interval you set, Outlook automatically dials your ISP and checks mail. 

Also, you can set up one of the following disconnect options for Outlook and the transport service: 

· After checking mail, Outlook disconnects your dial-up connection. 

· After checking mail, Outlook stays connected to your ISP. 

To set up the transport service to connect automatically to your ISP at startup, and then again at regular intervals to check for mail, complete the following five-part process: 

1. Install the Microsoft Dial-Up Networking 1.2 Upgrade. 

2. Set your e-mail connection type to connect using your phone line for all accounts that you want to check for new mail automatically. 

3. Configure your Dial-Up connection. 

4. Set the automatic Dial-Up interval.

5. Configure your connection to disconnect after checking mail.

 xe "Dial-Up Networking 1.2 Upgrade, installing"\\€part3.doc-1222 
PART 1: To install the Microsoft Dial-Up Networking 1.2 Upgrade

· To set Outlook to automatically call your ISP, install the Microsoft Dial-Up Networking 1.2 Upgrade, which is available from the Microsoft Web site at http://www.microsoft.com/.

If you have Windows 95 OSR2 (an OEM version of Windows that is available only with a new personal computer), you do not need to install the Microsoft Dial-Up Networking 1.2 Upgrade. 

 xe "Phone line, setting up connections"\\€part3.doc-1223 
PART 2: To set your e-mail connection type to connect using your phone line

1. Start Outlook. 

2. On the Tools menu, click Services. 

3. Click your Internet E-mail service, and then click Properties. 

4. Click the Connection tab, and then select the Connect using my phone line check box. 

5. Click OK to close the dialog box. 

6. Click OK to confirm the message that changes will take effect when you restart Outlook, and then click OK again. 

7. Quit Outlook. 

If you have configured multiple accounts, you must repeat steps 1 through 7 for each account that you want to check for new mail automatically. 

PART 3: To configure your Dial-Up connection

1. Double-click the My Computer icon, and then double-click Dial-Up Networking.

2. Double-click the Dial-Up Networking connection for your ISP, or if you have not created one yet, double-click the Make New Connection icon to create the connection first.

3. Type your username and password, and then select the Save Password check box. 

4. Click Connect. 

5. After connecting to your ISP, click Disconnect. 

PART 4: To set the automatic dial-up interval

1. Start Outlook. 

2. On the Tools menu, click Options. 

3. Click the Internet E-mail tab. 

4. Select the Check my local network connection(s) for new mail every x minutes check box, where x is the number of minutes for your connection interval.

5. Select the Automatically dial when checking for new messages check box. 

6. Click OK. 

 xe "Disconnect options, setting"\\€part3.doc-1226 
PART 5: To configure Outlook to disconnect after checking mail

1. On the Tools menu, click Options. 

2. Click the Internet E-mail tab. 

3. Select the If using a dial-up connection hang up when finished sending and receiving mail check box. 

4. Click OK. 

Using an Internet Only Configuration

 xe "Automatic dial-up:configuring"\\€part3.doc-1230 
By default, the Internet Only configuration does not call your ISP automatically to check for new mail. This section describes how to set up Outlook to connect automatically to your ISP at a regular interval to check for new mail. 

You can set up the Outlook mail account(s) to do the following: 

· When you start Outlook, Outlook immediately dials your ISP and checks mail. 

· At an interval you set, Outlook automatically dials your ISP and checks mail. 

To set up Outlook to connect automatically to your ISP at a regular interval, complete the following three-part process: 

1. Set your e-mail connection type to Connect using my phone line for all accounts that you want to check for new mail automatically. 

2. Configure your Dial-Up connection.

3. Set the Dial-Up interval. 

 xe "Phone line, setting up connections"\\€part3.doc-1231 
PART 1: To set your e-mail connection type to connect using your phone line

1. Start Outlook. 

2. On the Tools menu, click Accounts. 

3. Click the Mail tab.

4. Click the mail account that you want to configure, and then click Properties. 

5. Click the Connection tab, and then select the Connect using my phone line check box. 

6. Click OK to close the dialog box. 

7. Click Close to close the Internet Accounts dialog box. 

8. Quit Outlook. 

If you have configured multiple accounts, you must repeat steps 1 through 8 for each account that you want to check for new mail automatically. 

PART 2: To configure your dial-up connection

1. Double-click the My Computer icon, and then double-click Dial-Up Networking.

2. Double-click the Dial-Up Networking connection for your ISP, or if you have not created one yet, double-click the Make New Connection icon to create the connection first. 

3. Type your username and password, and then select the Save Password check box. 

4. Click Connect. 

5. After connecting to your ISP, click Disconnect. 

PART 3: To set the dial-up interval

1. Start Outlook. 

2. On the Tools menu, click Options. 

3. Click the Mail Delivery tab. 

4. Select the Check for new messages every x minutes check box, where x is the number of minutes for your connection interval. This number should be greater than 5 (for example, select a value of 15 or 20); otherwise, Outlook could prematurely cancel the connection already in process. 

5. Select the Automatically dial when checking for new messages check box.

6. Click OK. 

Stopping Outlook from Dialing Your ISP When Starting

Using a Corporate or Workgroup Configuration

By default, the Corporate or Workgroup configuration does not make a dial-up connection when you start. If automatic dialing has been enabled, you can prevent Outlook from dialing the modem when starting, so that you can work offline and use Remote Mail. With Remote Mail, Outlook makes the dial-up connection only while you are checking and delivering mail. 

To prevent an automatic dial-up connection

 xe "Automatic dial-up:preventing"\\€part3.doc-1241 
Using default settings, Outlook will not automatically dial your ISP and check mail. If Outlook does automatically dial your ISP when starting, follow these steps: 

1. On the Tools menu, click Options. 

2. Click the Internet E-mail tab.

3. Click to clear the Check my local network connection(s) for new mail every x minute(s) check box.

4. Click OK. 

Using an Internet Only Configuration

By default, the Internet Only configuration does not make a dial-up connection when you start. If automatic dialing has been enabled, you can prevent Outlook from dialing the modem at startup, so that you can work offline. 

To prevent an automatic dial-up connection

 xe "Automatic dial-up:preventing"\\€part3.doc-1243 
Using default settings, Outlook does not automatically dial your ISP and check mail. If Outlook does automatically dial your ISP when starting, follow these steps to disable it:

1. On the Tools menu, click Options. 

2. Click the Mail Delivery tab.

3. Click to clear the Check for new messages every x minutes check box. 

4. Click OK. 

Folders, Forms, and Address Books

Backing Up Outlook Data

 xe "Backing up Outlook data"\\€part3.doc-1250 
You can back up data created in Outlook, including e-mail messages, contacts, appointments, tasks, notes, and journal entries. Outlook stores its data in a file on your hard disk, or if you are using Outlook with Exchange Server, you can store the data in a mailbox on the server. 

This section describes the following:

· Making a backup copy of a personal folder file 

· Importing or exporting personal folder data 

· Backing up data using Outlook with Microsoft Exchange Server 

Making a Backup Copy of a Personal Folder File

If you are not using Outlook with Microsoft Exchange Server, Outlook stores all of its data in a personal folder (.pst) file. If you want to back up or export a particular folder, such as Contacts or Calendar, use the steps described in "Importing and Exporting Personal Folder Data."

To back up the entire personal folder file

1. Close any mail-related programs, such as Outlook, Microsoft Exchange, or Windows Messaging. 

2. Click the Start button, point to Settings, and then click Control Panel.

3. Double-click the Mail and Fax icon. If you do not have Microsoft Fax installed, double-click the Mail icon instead. 

4. Click the personal folders service you want to back up; if you have more than one personal folders service in your profile, back up each set of personal folders separately. By default this service is called "Personal Folders"; however, it could have been named something else. 

If the service has been named something else, you can find out about a service by selecting it from the list of services, and then clicking Properties. In the dialog box that appears, the title bar will say "Personal Folders" if the service is a personal folders service. After you read the title bar, click Cancel. Use this method to check the type of any unfamiliar service.

Note: If your profile contains no personal folders services and you store information, such as e-mail, contacts, or appointments in Outlook, your information is most likely stored in a mailbox on a Microsoft Exchange Server. In this case, see "Backing Up Data When Using Outlook with Microsoft Exchange Server" in this chapter.

If there are no personal folders in the list of services and you are not storing information in a Microsoft Exchange Server mailbox, you can use Outlook for browsing files only; the features that store data cannot be used, and there is no data to back up.

5. Click Properties, and make a note of the path and file name listed in the Properties dialog box.

Note: You might be able to reduce the size of a personal folder file by clicking Compact Now. This function is especially useful if you plan to back up the personal folder file to a floppy disk.

6. To close the open dialog boxes, click OK. 

7. Make a copy of the file that you noted in step 5. For more information about copying files in 
Windows 95, click the Start button, and then click Help. 

If you ever need to restore a personal folder file, copy the backup copy of the file to the same folder and name you noted in step 5. 

Importing and Exporting Personal Folder Data

You can export and import an individual folder, such as Contacts or Calendar, to its own personal folder file.

 xe "Exporting personal folder data"\\€part3.doc-1252 
To export personal folder data

1. On the File menu, click Import and Export. 

2. Click Export to a file, and then click Next. 

3. For the type of file, click Personal Folder File (.pst).

4. Click the folder you want to export, and then click Next. 

5. For Save exported file, type the name of the file to which the data will be exported.

6. Click Finish. 

 xe "Importing:personal folder data"\\€part3.doc-1253 
To import personal folder data

1. On the File menu, click Import and Export. 

2. Click Import from another program or file, and then click Next. 

3. For the type of file, click Personal Folder File (.pst).

4. Type the path and name of the personal folder file you want to import, and then click Next.

5. Click the folder into which the data will be imported. 

6. Click Finish. 

Backing Up Data Using Outlook with Microsoft Exchange Server

If Outlook is being used with Microsoft Exchange Server, you can choose to have Outlook store information on the Microsoft Exchange Server or in a set of personal folders on your hard disk. For a description of storage facilities used by Outlook, see "Capacity of Outlook Storage Facilities" in this chapter.

 xe "aa"\\€part3.doc-1256 
To determine where Outlook currently stores its data 

1. On the Tools menu in Outlook, click Services. 

2. Click the Delivery tab.

3. Examine the Deliver new mail to the following location field. 

If the field contains the word "Mailbox" followed by an e-mail name, Outlook stores new e-mail, contacts, and appointments in a set of folders on the Exchange Server. If the field contains the words "Personal Folder" or another name of a set of personal folders, Outlook stores new e-mail, contacts, and appointments in the personal folders on your hard disk.

When Outlook information is stored on Microsoft Exchange Server, it is typically backed up at the server. If your information is being stored in a set of personal folders on your hard disk and you want to back up the data, see the section "Making a Backup Copy of a Personal Folder File" in this chapter.

Capacity of Outlook Storage Facilities

 xe "Capacity of storage facilities"\\€part3.doc-1260 
The following storage facilities are used by Outlook when running as a client to Microsoft Exchange Server: 

 xe "Personal folder files:capacity"\\€part3.doc-1261 
· Personal folder (.pst) files located on the user's computer. One or more .pst files can reside on each user's computer. A .pst file can be defined as your primary store, meaning that your mail is delivered to the Inbox in that file, and all of your other default Outlook folders, such as Calendar, Contacts, Deleted Items, Journal, Notes, Sent Items, and Tasks reside there. Or, a .pst file can be defined as a secondary store, so that you can move items to it, either manually or with Inbox Rules, from your primary store.

Each .pst file can contain as many folders as you want, and each folder can contain a maximum of 64,000 records. The total size of a .pst file cannot exceed 2 gigabytes. 

 xe "Mailbox folder capacity"\\€part3.doc-1262 
· Mailbox folders located on Microsoft Exchange Server. The Exchange Server stores a mailbox folder for each user in the same database store. There is no server store limit for Exchange Server 5.5; with Exchange Server 4.0 and 5.0, the server has a capacity of 16 gigabytes for one store, which translates to millions of records. However, the server administrator can limit the size of each user's mailbox folder. 

 xe "Public folders:capacity"\\€part3.doc-1263 
· Public folders located on Microsoft Exchange Server. Public folders reside on the server in the same database store. They contain information shared by many users. Depending on access permissions, individual users can read, update, or add to the public folder. There is no server store limit for Exchange Server 5.5; with Exchange Server 4.0 and 5.0, the server has a capacity of 16 gigabytes for one store, which translates to millions of records. However, the server administrator can limit the size of each public folder. 

 xe "Offline store files:capacity"\\€part3.doc-1264 
· Offline store (.ost) files located on the user's computer. Only one .ost file can exist for each user profile. The .ost file is always defined as your primary store. Your mail is delivered to the Inbox in that file, and all of your other default Outlook folders, such as Calendar, Contacts, Deleted Items, Journal, Notes, Sent Items, and Tasks, reside there. 

The .ost file differs from the .pst file because .ost items can also reside in the user's mailbox on the server. You can synchronize the .ost file and mailbox folders so that they always contain the same information. Then, you can work offline when the server is unavailable; when you reconnect to the server, changes that you made offline are uploaded to the server, and mail received while you were offline is downloaded to the .ost file. 

The .ost file can contain as many folders as you want, and each folder can contain a maximum of 64,000 records. The total size of an .ost file cannot exceed 2 gigabytes. 

Controlling Your Mail Store on the Server

 xe "Controlling mail stores on the server"\\€part3.doc-1270 
The following tips can help users reduce the size of their mail store on the server: 

· Create a personal folder (.pst) file on your hard disk to archive folders/items that you do not need to access regularly. To set up this personal folder, click the Tools menu, and then click Services. Then, create the folder in the .pst file, and manually copy or cut items from your server mailbox to the file.

· Turn on the AutoArchive feature (from the File menu, click Archive), and Outlook will archive folders for you automatically. You can choose the AutoArchive settings, including the folders that are archived and the name of the archive file.

· If you are not using the Outlook Journal, make sure that you turn off the AutoJournal feature. To turn it off, click the Tools menu, click Options, and then on the Preferences tab, click Journal Options. Verify that none of the items being automatically recorded.

· Delete items that are old or no longer relevant, including mail, calendar information, and tasks.

· Delete attachments from mail, and save only relevant attachments to your hard disk.

· Check your folder size. To do this, right-click the Inbox, click Properties, and click Folder Size. 

Managing a Personal Folder File for Two Computers

 xe "Optimizing Outlook:managing a .pst file for two computers"\\€part3.doc-1280 
Outlook does not synchronize a personal folder (.pst) file between two different computers automatically. There are three possible workarounds for synchronizing .pst files:

 xe "Offline store files:synchronizing data between computers"\\€part3.doc-1281 
Option 1: Use an offline store (.ost) file. If you are running Microsoft Exchange Server as your mail service, the best way to synchronize data between two computers is to use an .ost file. Then, the data stored on the server is synchronized automatically with each computer using the server store. 

Option 2: Copy the personal folder (.pst) file. You can use a single .pst file and copy it from one computer to another. A problem with this technique is that a .pst file can become very large and may be too large to copy to a floppy disk. In this event, you can use Windows Backup or another backup utility with the ability to write a file over multiple disks. 

Note: You can use the Briefcase application to synchronize two computers if your .pst file is less than 1.44 MB in size.

Option 3: Copy only the Calendar, Contacts, and Task folders. Usually, a large .pst file is the result of e-mail stored in the Inbox, Deleted Items, and other mail store folders. Therefore, you might want to share only your Calendar, Contacts, and Tasks without sharing your mail folders. To share only your Calendar, Contacts, and Tasks, complete the following three-part process:

1. Define a second .pst file for the shared folders. 

2. Copy Calendar, Contacts, and Tasks items into the new shared folders. 

3. Delete the contents of the old folders.

Note: These steps must be performed on both computers that will share the .pst information. 

PART 1: To define a second .pst file

1. On the Tools menu, click Services. 

2. Click Add, click Personal Folders, and then click OK. 

3. Type a unique name for the new .pst file, such as "Shared.pst," and then click Open.

4. Type a display name for the personal folder, such as "Shared Folders," and then click OK.

5. On the File menu, click Exit and Log Off. 

PART 2: To copy your existing Calendar, Contact, and Task items to the new folders

1. Start Outlook. 

2. Right-click your original Calendar folder, and then click Copy Calendar. 

3. In the Copy Folder dialog box, click to select your shared folders, and then click OK.

4. Repeat steps 2 and 3 for both your Contacts and Tasks folders.

You should now have Calendar, Contacts, and Tasks folders in your new shared folders file. Verify that the new folders contain all the items from the old folders before continuing with Part 3. 

PART 3: To remove the contents of your old Calendar, Contacts, and Tasks folders

1. Click your original Calendar folder.

2. On the View menu, click Current View, and then click Active Appointments.

3. On the Edit menu, click Select All. 

4. Right-click the selected items, and then click Delete. 

5. Repeat steps 3 and 4 for both your Contacts and Tasks folders. 

Your mail will now be delivered to your original personal folders, while Calendar, Contacts, and Tasks items will be delivered to your new shared folders. The new shared folder (Shared.pst) should be small enough for you to conveniently copy the information to disk for transport between computers. 

Reordering Outlook Address Book Names

 xe "Address Book names, reordering"\\€part3.doc-1290 
In Outlook, contacts are listed in the Address Book by default by first name and then last name. If you want, you can change this order to last name and then first name.

To reorder Address Book names

1. On the Tools menu, click Services.

2. Click Personal Address Book, and then click Properties.

3. Under Show names by, click Last name.

4. Click OK.

Sending Mail Messages to a Fax Number

 xe "Fax numbers:sending mail messages to"\\€part3.doc-1300 
When using the Microsoft Fax service with Outlook, you can address new mail messages to both e-mail addresses and fax telephone numbers. You can manually type a recipient's fax number or, if the entry already exists, you can select the number from an Address Book. If you manually type a fax telephone number, you must use the following format: 

[FAX:NUMBER]

There are two methods to send a fax, depending on whether you are using a Corporate or Workgroup configuration or an Internet Only configuration.

To send a fax with a Corporate or Workgroup configuration

1. In Outlook, click the Inbox on the Outlook bar. 

2. On the Compose menu, click New Mail Message. 

3. On the To line, type: [FAX:NUMBER] (where NUMBER is the fax telephone number to which you want to send the mail message). 

4. Type the subject and the message you want to send.

5. Click Send.

Note: For the above steps to work, you must have the Microsoft Fax service as part of your current profile.

When you use the special format described in step 3, Outlook instructs Microsoft Fax to process the message and send it as a fax automatically.

 xe "Fax numbers:sending mail messages to"\\€part3.doc-1302 
To send a fax with an Internet Only configuration

1. On the Actions menu, click New Fax Message. 

2. In the To: line, type the fax number (using the syntax: fax@9w5551212).

3. Type the Subject and body of the message.

4. Click Send.

You may need to click Tools, click Send Using, and then click Symantec Fax to complete the transmission.

Updating Existing Items to Use a New Custom Form

 xe "Custom forms:updating items for"\\€part3.doc-1310 
You can update items in an Outlook folder so they use a custom form instead of the standard Outlook form. For both mail and contacts, you can customize from the first page of the form. There are several occasions in Outlook when you may want to change the form used for all the items in a folder. For example:

· You use the default Outlook form to enter 10 contacts into your Contacts folder. Then, you create a special custom form for contacts and enter 10 additional contacts. When you view one of the first 10 contacts, you want the information to be displayed in the new custom form. 

· You create a custom form for contacts and enter 10 contacts using the custom form. Then, you import 100 contacts from a text file. The 100 imported contacts use the default form instead of the custom form. 

· You have a public folder with 1000 posted items based on the default post form. Then, you create a custom form that organizes the items for your work. You want to apply the new form to the 1000 existing items. 

Outlook Message Classes

 xe "Message classes"\\€part3.doc-1311 
A property of the item called "message class" determines the form that the item uses. You cannot change the message class of an item manually. However, you can write VBScript or Automation code to change the message class for all items in a folder. When you create and publish a custom form, the form is assigned a message class. This message class determines the form that is associated with an item. The format of the name is usually IPM.<FolderType>.<FormName> where <FolderType> is the type of folder (for example, Contacts or Tasks) and <FormName> is the name of the form. For example, if you create a new form named Revised and publish the form to your Contacts folder, the message class is IPM.Contact.Revised. 

 xe "Message classes"\\€part3.doc-1312 
The following table lists the names used for message classes.

Item
Default folder
Default message class

Contact
Contacts
IPM.Contact

Task
Tasks
IPM.Task

Appointment
Calendar
IPM.Appointment

Note
Notes
IPM.StickyNote

Journal Entry
Journal
IPM.Activity

Mail
Inbox
IPM.Note

To see the message class for an existing item, add the message class field as one of the columns in the current view. 

To add the message class to your view

1. On the View menu, point to Current View, and then click Customize Current View. 

2. Click Fields.

3. From the Select available fields from list, click All Contact Fields. 

4. To add the field as a column in your current view, drag the message class field (for example, Account or Anniversary) to the column header. 

The message class in this view is Read Only; you cannot type a different message class to change the form manually. 

Changing the Message Class

 xe "Omsgclas.exe"\\€part3.doc-1315 
To change the Message Class field for existing items, use Visual Basic Script (VBScript) code within an Outlook form, or use Visual Basic for Applications code from another program to automate Outlook. 

You can use the following two methods to change Message Class fields: 

· Download Omsgclas.exe. This file contains a Word 97 document with a macro utility that displays a dialog box with options for changing Outlook Message Classes. This Omsgclas.doc document allows you to change the message class held for each item in the folder so that all existing items will use a specific custom form. The macro runs automatically when you open the document. You can download the Omsgclas.exe file (40,242 bytes) from the Microsoft Software Library; see the Microsoft Web site at http://www.microsoft.com/.

· Create and run a VBScript routine that changes all the items in a folder to a specified form. First, you must create a new item to store the VBScript, and then you can enter and run the VBScript code. See Parts 1, 2, and 3 below, which describe this method.

Important: Microsoft provides programming examples for illustration only, without warranty either expressed or implied, including, but not limited to, the implied warranties of merchantability and/or fitness for a particular purpose. The procedures in this section assume that you are familiar with the programming language being demonstrated and the tools used to create and debug procedures. Microsoft support engineers can help explain the functionality of a particular procedure, but they will not modify these examples to provide added functionality or construct procedures to meet your specific needs. If you have limited programming experience, you may want to contact the Microsoft fee-based consulting line at (800) 936-5200. For more information about the support options available from Microsoft, please see the Microsoft Web site at http:/www.microsoft.com/. 

PART 1: To create a new item to store the VBScript code

1. Open the folder that contains the items you want to update. 

2. On the File menu, point to New, and then click the appropriate item. For example, if you want to create a new item in the Contacts folder, click Contact. If you do not want to keep the item in this folder, you can move the item to a different folder at a later time. The item, though, must be located temporarily in the folder so that the VBScript code can function correctly. 

3. To enter form design mode, on the Tools menu, point to Forms, and then click Design a Form.

4. Select the type of form, and then click Open. 

PART 2: To enter the VBScript code

Note: The example in this section assumes that you have published a new form called MyNewForm in the current folder. If you use a different title for your form, modify the form title used in the third line of code.

1. On the Form menu, click View Code. 

2. In Script Editor, type the following code. You do not need to enter the lines that begin with an apostrophe, since these lines are comments that are ignored when executed.

   Sub Item_Open
   ' Change the following line to your new Message Class
   NewMC = "IPM.Contact.MyNewForm"
   ' Set cf to the current folder
   Set CurFolder = Application.ActiveExplorer.CurrentFolder
   ' Loop through all of the items in the folder
   For I = 1 to CurFolder.Items.Count
      Set CurItem = CurFolder.Items.Item(I)
      ' Test to see if the Message Class needs to be changed
      If CurItem.MessageClass <> NewMC Then
         ' Change the Message Class
         CurItem.MessageClass = NewMC
         ' Save the changed item
         CurItem.Save
      End If
   Next
   MsgBox "Done."
   End Sub

3. On the Script Editor File menu, click Close. 

4. To exit form design mode, on the Tools menu, clear the Design Outlook Form check box. 

5. On the item's toolbar, click Save and Close. If the item does not have a Save and Close button, click the X in the upper-right corner of the item's window, and then click Yes when prompted to save changes. 

PART 3: To run the VBScript code

1. To run the VBScript code, re-open the item. The code runs automatically because it was entered into an Item_Open event procedure. If you receive a macro warning, click Enable Macros. 

2. Wait while the code changes the message class for all of the items in this folder. Depending on the number of items, this may take several minutes. When the code finishes running, you should receive a message that says Done.

If you want to edit the VBScript code later, hold down the SHIFT key when you open the item. This prevents the VBScript code from executing, and you can go into form design mode and make changes to the VBScript code. 

Using Links to Access Outlook Folders and Items

 xe "Folders:creating links for accessing"\\€part3.doc-1330 
You can use three methods to create links that open Outlook folders and items: 

· To open an Outlook folder on your server, use this syntax: 

<Outlook:Foldername>

For example: <Outlook:Sent Items>
· To open a personal or private folder, use this syntax: 

<Outlook://Foldername>

For example: <Outlook://Personal Folders/My Stuff>
· To open a specific item, precede the name with a tilde (~): 

<Outlook:Foldername/~Itemname>

For example: <Outlook:Contacts/~Nancy Davolio>
Note: You must include the GREATER THAN (>) and LESS THAN (<) symbols. 

If you are using WordMail, you can drag a folder into a mail message to automatically generate a link. If the folder name contains a space, the space is replaced with %20 for compatibility with browsers that do not support spaces in names.

If you are not using WordMail, Outlook creates an *.xnk shortcut (instead of a link) when you drag a folder into a mail message.

Calendar Issues

Customizing Outlook Calendar Holidays

 xe "Calendar features:customizing holidays"\\€part3.doc-1340 
You can customize the predefined Calendar holidays in Outlook. The technique described in this section involves modifying the Outlook.txt file that stores the holidays for the active calendar. Outlook stores a read-only text file named Outlook.txt in the \Program Files\Microsoft Office\Office folder, which it uses for the Add Holidays feature. 

The Outlook.txt file lists holidays in the following format: 

[Country] ###

Holiday description, yyyy/mm/dd

Holiday description, yyyy/mm/dd

In this format, ### is the total number of holidays listed for a particular country. Note that there is a space between the closing bracket and the number, as well as a carriage return at the end of the line. On each holiday line, there is a comma and a space between the holiday description and the date, as well as a carriage return at the end of the line. For example: 

[United States] 3

Independence Day, 1997/07/04

Thanksgiving Day, 1997/11/27

Christmas Day, 1997/12/25

WARNING: MODIFY THE OUTLOOK.TXT FILE AT YOUR OWN RISK. Microsoft provides this procedure "as is" without warranty of any kind, either express or implied, including but not limited to the implied warranties of merchantability and/or fitness for a particular purpose. 

To create a custom set of holidays

1. If you are running Outlook, quit the application. 

2. Start Windows Explorer, locate Outlook.txt, and make a backup copy of the file. 

3. Right-click the original Outlook.txt file, and then click Properties.

4. In the Attributes area, clear the Read-only check box, and then click OK.

5. In Windows Explorer, double-click Outlook.txt to open the file in Notepad or WordPad. 

6. Press CTRL+END to position the insertion point at the end of the file. 

7. Type a new country header and custom holidays using the format described above. 

8. Save and close Outlook.txt in a text-only format. 

9. Switch to Windows Explorer. Right-click the original Outlook.txt file, and then click Properties.

10. In the Attributes area, select the Read-only check box, and then click OK.

The next time you run Outlook, the new custom holidays are added to your Calendar. 

Using Schedule+ As the Primary Calendar in Outlook

 xe "Calendar features:using Schedule+ as the primary calendar"\\€part3.doc-1350 
During Outlook Setup, users with a Corporate or Workgroup configuration have the option to substitute Microsoft Schedule+ 95 for the Outlook calendar function. In a mixed environment consisting of Outlook and Schedule+ 95 and/or Schedule+ 1.0 users, all users can exchange meeting request messages and share free/busy status with each other. When users "publish" their free/busy status, other users can view the free/busy time blocks, and with appropriate permission, Outlook and Schedule+ users can view each other's free/busy status. 

However, many Outlook capabilities go beyond those of Schedule+ 95 and Schedule+ 1.0. Outlook users should be aware that their coworkers who are still using Schedule+ 95 or Schedule+ 1.0 may not be able to view or use some of the messaging or calendar information the same way another Outlook user can. Schedule+ 95 users cannot open an Outlook user's calendar (unless the Outlook driver for Schedule+ is installed). Also, a delegate relationship, which enables a user to manage another user's e-mail and schedule (including meeting and task requests), requires that both users run the same scheduling client. For more information about interoperability with Schedule+, see Chapter 3, "Interoperability."

Although Outlook, Schedule+ 95, and Schedule+ 1.0 offer a high level of interoperability for basic calendar and group scheduling functions, the differences can affect more advanced levels of access to other calendars. Selecting the Use Schedule+ 95 as my primary calendar option is one method of allowing a group of users to modify each other's schedules seamlessly. Continuing to use Schedule+ for calendar functions during the transition period ensures the retention of the same level of interoperability that existed before the upgrade to Outlook.

Note: The option to use Schedule+ 95 for the primary calendar is available only if Schedule+ 95 is installed and working on the computer before you install Outlook. Alone, the Outlook Setup program does not install enough of the Schedule+ 95 file set to enable its operation, and this option will not be available. 

Getting the Outlook Calendar Template for Word 97

 xe "Calendar features:Outlook calendar template for Word 97"\\€part3.doc-1360 
The Olcalndr.exe file contains a sample Microsoft Word 97 template. The template includes Visual Basic for Applications (VBA) macros, which use OLE Automation to automate the process for creating Outlook monthly calendars. Because the template uses the Word table format, you can easily modify your calendar before saving or printing. Using the Word for Windows "Save as HTML" converter, you can save the monthly calendar for publishing on a Web page. 

You can download the Olcalndr.exe file (59,060 bytes) from the Microsoft Software Library; see the Microsoft Web site at http://www.microsoft.com/. The Olcalndr.exe file contains the following files: 

· Olcalndr.dot, which is the Outlook Calendar Template for Word 

· Readme.txt, which provides information and instructions about Olcalndr.exe

APPENDIX A

Sample Outlbar.inf File

This appendix provides the complete contents of Outlbar.inf, which is the configuration file used by Microsoft® Outlook™98 to define the navigation choices for the Outlook Bar. System administrators can review this sample file when they customize the Outlook Bar for their own user communities. 

The path to the custom Outlook Bar configuration file is specified in the Outlook 98 Deployment Wizard. The custom Outlook Bar replaces the standard Outlook Bar during user setup. For more information about customizing this file, see Chapter 4, "Customizing Microsoft Outlook 98 Features."
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Outlbar.inf File Contents

 xe "Outlbar.inf file:sample file"\\€part1.doc-1001 
; -----------------------------------------------------------------

; This file is used to construct the default Outlook Bar, and to

; upgrade from an old version.

; -----------------------------------------------------------------

[Version]

Signature="$CHICAGO$"

Class=Outlook

OutlookInfVersion=1

[UpgradeOutlookBar]

UpgradeGroup=UpgradeOutlook,UpgradeMail,UpgradeOther

[UpgradeOutlook]

OldName=%OLDOUTLGRP%

Name=%OUTLGRP%

ShortcutsGroupIndex=0

Shortcuts=UpgradeOutlookShortcuts

[UpgradeOutlookShortcuts]

TodaysOutlook

[UpgradeMail]

OldName=%OLDMAILGRP%

Name=%MAILGRP%

ViewType=1

Shortcuts=UpgradeMailShortcuts

[UpgradeMailShortcuts]

Drafts=1,9

[UpgradeOther]

OldName=%OLDOTHRGRP%

Name=%OTHRGRP%

[DefaultOutlookBar]

AddGroup=OutlookGroup,MailGroup,OtherGroup

[DefaultOutlookBarPIMOnly]

AddGroup=OutlookGroupPIM,MailGroupPIM,OtherGroup

[DefaultOutlookBarNoIFM]

AddGroup=OutlookGroup,MailGroup

[DefaultOutlookBarPIMOnlyNoIFM]

AddGroup=OutlookGroupPIM,MailGroupPIM

[OutlookGroup]

Name=%OUTLGRP%

Shortcuts=OutlookGroupShortcuts

[OutlookGroupPIM]

Name=%OUTLGRP%

Shortcuts=OutlookGroupShortcutsPIM

[MailGroup]

Name=%MAILGRP%

ViewType=1

Shortcuts=MailGroupShortcuts

[MailGroupPIM]

Name=%MAILGRP%

ViewType=1

Shortcuts=MailGroupShortcutsPIM

[OtherGroup]

Name=%OTHRGRP%

Shortcuts=OtherGroupShortcuts

[OutlookGroupShortcuts]

TodaysOutlook

Inbox=1,0

Calendar=1,1

Contacts=1,2

Tasks=1,3

Journal=1,4

Notes=1,5

Deleted=1,6

[MailGroupShortcuts]

Drafts=1,9

Outbox=1,8

Sent=1,7

[OutlookGroupShortcutsPIM]

TodaysOutlook

Calendar=1,1

Contacts=1,2

Tasks=1,3

Journal=1,4

Notes=1,5

Deleted=1,6

[MailGroupShortcutsPIM]

Inbox=1,0

Drafts=1,9

[OtherGroupShortcuts]

UserComputer

UserDocuments

UserFavorites

PublicFoldersRoot

UserPfFavorites

[TodaysOutlook]

Target=1,10

Name=%TODAYSOUTLOOK%

[PublicFoldersRoot]

Target=1,11

[UserPfFavorites]

Target=1,14

[UserTopLevelFolders]

Target=1,15

[UserComputer]

Target=2,17    ; FATNS,CSIDL_DRIVES      (My Computer)

[UserDocuments]

Target=2,5     ; FATNS,CSIDL_PERSONAL    (My Documents)

[UserFavorites]

Target=2,6     ; FATNS,CSIDL_FAVORITES   (Favorites)

[Strings]

OUTLGRP="Outlook Shortcuts"

MAILGRP="My Shortcuts"

OTHRGRP="Other Shortcuts"

OLDOUTLGRP="Outlook"

OLDMAILGRP="Mail"

OLDOTHRGRP="Other"

TODAYSOUTLOOK="Outlook Today"

APPENDIX B

Setup Command-Line Options

This appendix describes the Setup command-line options, which you can use to customize and run your installation from the command line. For detailed information about the setup process and the Microsoft® Outlook™98 Deployment Wizard, see Chapter 2, "Installation and Configuration."
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Setup Command-Line Options

You can run the Setup program from the command line. If you do, you can add parameters to the command that allow you to specify certain options, such as choosing a standard installation or specifying quiet mode (which removes or reduces the prompts the user receives). 

 xe "Command-line options:running Setup from the command line"\\€part1.doc-1003 
To run the Setup program from the command line

1. In Windows 95 or Windows NT Workstation 4.0, click Start, and then click Run.

2. Type the location you are installing from, followed by the word setup. For example, x:\setup or x:\ol98\setup.

3. If you want to add a command-line option, type it after the command. For example, to run Setup in quiet mode, type x:\setup /Q.

When users click Setup.exe in the \CD folder of your customized ODK package, the Autorun screen runs the appropriate Setup.exe from the language\Packages folder (for example, for English, it launches \CD\EN\Packages\Setup.exe). When Setup.exe in the Packages folder runs, it self-extracts and runs Outlwzd.exe with the custom settings that you defined in the wizard.

You can use command-line switches to control how both the Setup.exe and Outlwzd.exe files are run. For example, you can use command-line switches to choose the installation mode, specify a quiet mode, or control whether the computer is restarted after installation. Also, you can use command-line switches without a customized ODK package (the only switch that requires this package is /Q). 

Command-Line Option Descriptions for Setup.exe

 xe "Setup command-line options:switches for Setup.exe"\\€part1.doc-1004 
To use command-line switches with Setup.exe, use Wextract, an extraction utility based on Internet Express technology. The following table shows frequently used Wextract command-line options. 

Command-line option for Setup.exe
Description

/C:<>
Path and name of the Setup .inf or .exe file

/Q
Quiet mode

/R:A
Always reboot

/R:N
Never reboot

/R:S
Silent reboot

/T:<directory path>
Target folder for extracting files

Command-Line Option Descriptions for Outlwzd.exe

 xe "Outlwzd.exe command-line options"\\€part1.doc-1005 
A second group of command-line switches are used with Outlwzd.exe. The following table describes Outlwzd.exe command-line options.

Command-line option for Outlwzd.exe
Description

/I:[Y/N]
Indicates whether or not to install the Windows Desktop Update. If this option is not specified, setup matches the previous state of the user's computer; using this option, you can override this default behavior and explicitly define whether the Windows Desktop Update is turned on or off.

/L
Specifies the Outsites.dat to be used in a Web installation. This option should point to the Outsites.dat file, which identifies download sites (for example: /L:"www.somewebsite.com/Outsites.dat").

/M:[0|1|2|3...]
Specifies the installation mode. For customized ODK packages, 0 refers to the first installation choice, 1 refers to the second choice, and so on (for example, 0=minimal, 1=standard, 2=full). If 0 is specified, the Windows Desktop Update is not installed (same as specifying the /I:N option).

/N
Specifies the launching behavior of Outlwzd.exe. The /N option causes Outlwzd.exe to ignore the version of the previous installation and not launch Olmaint.exe. The /N- option causes Outlwzd.exe to ignore the version of the previous installation and launch Olmaint.exe.

/Q
Specifies a quiet "hands-free" batch mode. The user is prompted for information that is not specified. A properly configured Setup.ini file is required for this option to work.

/R
Specifies whether Outlwzd.exe should reboot if needed. You cannot use this option to force Outlwzd.exe to reboot in all cases; however, you can use it to force Outlwzd.exe not to reboot in all cases (using the /R:N option). If you suppress rebooting, your program should take care of restarting the computer; Outlook is not properly configured until the computer is restarted.

/S:""#e""
Designates the source path of Outlwzd.exe. The ""#e"" refers to the full path and name of the .exe file.

/U:""<path>""
Specifies the path (file or network in Universal Naming Convention format) for installation cabinet (.cab) files. Do not use /U for CD-ROM installations.

/X
Installs Internet Explorer without the Internet Explorer icons on the desktop, Start menu, and Quick Launch bar. Also, the Internet Explorer version number is set lower, so that Active Setup tries to update it if the same version of Internet Explorer is delivered.

Important Considerations

 xe "Setup command-line options:considerations for using"\\€part1.doc-1006 
When you use command-line options, be aware of these important considerations: 

· The /S switch is required with Outlwzd.exe. Without this switch, users go into Web Install Mode rather than CD, and they do not get the correct product identification code information. 

· If you use the /Q switch for Setup.exe, it will also run Outlwzd.exe /Q. An error message will display if you do not have the configured Setup.ini file.  

· If you use Outlwzd.exe switches, you must run Setup.exe with the /C switch. Within the /C switch, you can then specify switches to run with Outlwzd.exe. 

Here are some sample scenarios:

· The following expression runs the third installation option: 

setup.exe /C:"outlwzd.exe /S:""#e"" /M:2" 

· The following expression performs a quiet installation, with no user prompts and no reboot afterward:

setup.exe /Q /C:"outlwzd.exe /S:""#e"" /Q /R:N"

Note that the placement of quotation marks is important, and that the path is surrounded with two pairs of double quotation marks.

APPENDIX C

Other Microsoft Outlook Clients

To meet market demands, today's e-mail and collaboration clients must provide both business and consumer users with a wide range of capabilities that keep pace with their changing needs. Customers need solutions that offer the flexibility and power to help them stay current with emerging trends, such as integrated messaging ("universal inbox") features and Internet functionality, security, and address books.

With technology trends in mind, the Microsoft® e-mail and collaboration client strategy has evolved to offer a spectrum of flexible, scalable, cross-platform e-mail clients that address different customer and market needs in a consistent manner, and provide smooth upgrade and migration paths. The following sections describe other products that are part of the Microsoft Outlook™ family of e-mail and collaboration clients.
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Microsoft Outlook Web Access

 xe "Web Access, Microsoft Outlook:overview"\\€part1.doc-1010 
For customers who use Microsoft Exchange Server version 5.0 or later, Microsoft offers Outlook Web Access as a feature of Microsoft Exchange Server. Outlook Web Access gives users secure access to their e-mail, calendar, group scheduling, and public folder information on Microsoft Exchange Server using only a Web browser.

Outlook Web Access is implemented using a combination of Microsoft Active Server Pages technology and Java controls and scripts downloaded on demand to the user's Web browser. It requires Microsoft Exchange Server version 5.0 with Microsoft Exchange Service Pack version 1.0 and Microsoft Internet Information Server (IIS) version 3.0 with Active Server Pages installed (or later versions of these products). Also, a Web browser that supports HTML 3.2, Java controls, and JavaScript must be installed on the client machine.  

Note: If you are using Microsoft Internet Explorer for Windows version 3.0x, the Internet Explorer 3.02 File Upload Add-on is required to add file attachments to mail messages.  

Outlook Web Access requires no desktop installation, which streamlines administration and provides easier client control. Outlook Web Access can be a strategic choice for businesses that experience one or more of the following situations: 

 xe "Remote access, Microsoft Outlook Web Access"\\€part1.doc-1012 
· Roaming or remote access. Users who are away from their computers, as well as users who share a PC, can take advantage of Outlook Web Access to access Microsoft Exchange Server information securely from any Web browser. Because Outlook Web Access does not download mail to the client, there is no risk of users accidentally copying messages to another user's hard disk.

 xe "UNIX clients, Microsoft Outlook Web Access"\\€part1.doc-1013 
· UNIX clients or computers with hardware limitations. For users running UNIX workstations or whose computers have limited RAM or hard-disk space, Outlook Web Access provides basic e-mail, calendar, and collaborative features. Outlook Web Access, though, is not intended as a replacement for the full-featured Outlook messaging clients for Microsoft Windows® 3.x and the Macintosh operating systems.

 xe "Cross-platform system, Microsoft Outlook Web Access"\\€part1.doc-1014 
· Cross-platform system. Corporations with users who require access to Microsoft Exchange Server from any operating system can benefit from the minimized support requirements, consistent user interface, and cross-platform features of Outlook Web Access. 

 xe "Extranet distribution of applications"\\€part1.doc-1015 
· Extranet applications. Corporations that need to deploy applications broadly to vendors, suppliers, or customers can use Outlook Web Access to distribute the applications inexpensively and efficiently over the Internet. Outlook Web Access supports authenticated and anonymous external users.

Features

 xe "Web Access, Microsoft Outlook:features"\\€part1.doc-1020 
When connected to Microsoft Exchange Server, users can access Outlook Web Access and take advantage of the following features:

 xe "E-mail features of Outlook Web Access"\\€part1.doc-1021 
· Basic e-mail. Outlook Web Access users can address mail using the Microsoft Exchange Global Address Book, send and receive file attachments and hyperlinks, set messaging priorities, and request delivery and read receipts. Also, they can use hierarchical folders and the Outlook bar, and group and sort messages in a folder based on standard fields or a conversation thread.

 xe "Calendar features:Outlook Web Access"\\€part1.doc-1022 
· Basic calendar and group scheduling. Users can create one-time or recurring appointments in a personal calendar, and access daily and weekly views of the calendar. Also, they can view free/busy times for multiple users and resources when scheduling a meeting, and automatically send and respond to meeting requests by using e-mail. 

 xe "Public folders:Microsoft Outlook Web Access"\\€part1.doc-1023 
· Basic public folder access. Users can access custom table views in public folders, and group and sort messages in a folder based on standard fields or a conversation thread. Users can access public folders anonymously, allowing customers and employees to post various types of requests for information, such as sales or product data, via the Internet.

 xe "Custom forms:displaying in Outlook Web Access"\\€part1.doc-1024 
· Collaborative applications. In addition to basic public folder support, users can develop custom forms by using Microsoft Visual InterDev™ and display them in Outlook Web Access. 

Limitations

 xe "Web Access, Microsoft Outlook:limitations"\\�part1.doc-1030 
Outlook Web Access is not intended to satisfy advanced e-mail and collaboration requirements addressed by the other products in the Outlook client family. It does not include the following advanced features: 

· Personal address books

· Spell-checking

· Sending and receiving rich text or HTML mail messages

· Auto-resolving of addressees

· Microsoft Exchange digital encryption and signature support

· S/MIME support

· Replied and forwarded flags in list view

· Message flags and inbox rules

· Three-pane view

· Dragging and dropping to a folder

· Searching for messages

· WordMail and Microsoft Office integration

· Monthly view and other customized views of a calendar

· Displaying discontinuous days side by side

· Appointment list views

· Viewing free/busy details

· Dragging and dropping to move an appointment

· Tracking acceptance of meeting attendees

· All-day or multiple-day events

 xe "Web Access, Microsoft Outlook:limitations"\\€part1.doc-1031 
· Task lists and task management

· Exporting to DataLink watch or other devices

· Non-tabular Outlook views

· Outlook forms

· Microsoft Exchange digital encryption and signatures

· Synchronizing local offline folders with server folders

Also, the Outlook Web Access user interface varies slightly from other Outlook client family products, because it requires special optimizations to work within a Web browser. Users must connect to Microsoft Exchange Server to view information. 

Note: If the Web server hosting Outlook Web Access is on the same machine as Microsoft Exchange Server, and Outlook Web Access is the client for all users, the number of users supported per Microsoft Exchange Server is reduced significantly. 

Microsoft Outlook Clients for Windows 3.x 
     and the Macintosh

 xe "Microsoft Outlook client for Macintosh"\\€part1.doc-1040 
The Outlook clients for the 16-bit Microsoft Windows and Macintosh operating systems were designed specifically for businesses that use Microsoft Exchange Server. For customers who need interim clients as they migrate to 32-bit Windows, Outlook for Windows 3.x and Outlook for the Macintosh offer improved performance, as well as smooth interoperability (but not feature parity) with Outlook on 32-bit Windows. For more information about interoperability with Outlook 98, and also with Microsoft Schedule+ for calendar and group scheduling, see Chapter 3, "Interoperability."

These versions of Outlook include e-mail, personal calendaring, task lists, group scheduling, and HTML-based custom forms, and provide an easy migration path from current Microsoft e-mail clients. This approach provides a consistent solution for companies that need to support employees who current use 16-bit Windows or the Macintosh. 

Note: Standard e-mail and group scheduling require Microsoft Exchange Server 4.0 or later. Implementing custom forms (using HTML and Microsoft Exchange Server Collaboration Data Objects) requires Microsoft Exchange Server 5.0, Microsoft Exchange Service Pack 1.0 or later, and Microsoft Internet Information Server (IIS) 3.0 with Active Server Pages installed. 

Microsoft Outlook Express

 xe "Microsoft Outlook Express"\\€part1.doc-1045 
Microsoft Outlook Express is designed for users who require fast and reliable Internet e-mail and news capabilities. Built on open Internet standards, Outlook Express offers a rich feature set that is tightly integrated with Microsoft Internet Explorer version 4.0. Outlook Express is free of charge and easy to install, making it the perfect Internet e-mail client for home, small business, and Microsoft Office for Macintosh users.  

Outlook Express is an upgrade from the Microsoft Internet Mail and News client that was included with Microsoft Internet Explorer version 3.0. Outlook Express automatically imports e-mail folders, address books, and settings from previous installations of Microsoft Exchange mailbox, Eudora, and Netscape mail. An easy migration path to Outlook 98 makes Outlook Express an ideal client for consumers.  

Outlook Express supports today's most important e-mail, news, and directory standards, and offers significantly more features than other basic e-mail packages. For example, new features in Outlook Express include a more intuitive user interface, customizable toolbars, stationery, and address-book functionality. New migration tools and support for multiple Internet service provider (ISP) accounts help users easily get started with e-mail. Powerful inbox rules help users manage their e-mail. In addition, full support for HTML mail allows users to easily create and personalize e-mail.  

Microsoft Pocket Outlook

 xe "Microsoft Pocket Outlook"\\€part1.doc-1050 
For customers who need to use Outlook in conjunction with a small hand-held computer, Microsoft offers Pocket Outlook as a feature of the new Microsoft Windows CE version 2.0 operating system. Pocket Outlook is the perfect mobile companion application to any desktop or notebook computer running the complete Outlook 98 client.

Pocket Outlook provides a subset of the key Outlook features, including basic e-mail and group scheduling, to help you manage your personal information effectively. With Pocket Outlook, you can carry your most important information with you, and keep it up-to-date effortlessly by automatically synchronizing it with Outlook on your desktop computer.
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A

Abbreviations, x, xi

Acronyms, x, xi

Active Channel bar, customizing, 31

Active Desktop components, specifying, 33

Active Setup

customizing, 20

described, 11

how Active Setup works for the user, 43

specifying components, 18

specifying parameters for, 17

specifying trusted publishers, 19

ActiveExplorer method, 72

ActiveInspector method, 72

ActiveX Controls

adding to Outlook Today, 89

using for custom forms, 4

Adding new components to Outlook, 10

Add-On Component URL, specifying, 24

Address Book names, reordering, 110

Address toolbar, adding, 33

.adm template file for system policies, 45

Administrative features, 4

Adult content, filtering, 37

Appending strings to user agent strings, 35

\Application Data folder, 55

Appointments and Schedule+ interoperability, 61

Architecture, 3

Archiving (backing up) Outlook data, 105

Attachments

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

Authenticode settings, 37

Auto-configure URL, 35

Auto-detect links feature, 53

Automatic browser configuration, 35

Automatic dial-up

configuring, 101, 103

preventing, 104, 105

Automatic generation of Microsoft Exchange Views, 54

Automatic software distribution, 32

Automatic synchronization, 53

Automatic upgrade, enabling, 43, 44

Automating installations, 49


AutoPreview feature in Outlook Calendar, 3

Auto-proxy URL, 35

Autorun screen, customizing, 21

B

Background of desktop, customizing, 31

Background of toolbar, customizing, 29

Background synchronization, 53

Backing up Outlook data, 105

Ballot messages, 61

BCC, meaning of, x

Branding.cab file, signing, 43

Browser configuration, automatic, 35

Browser online support page, specifying, 30

Browser settings, customizing, 25

Browser usage, tracking, 35

Bypassing proxy servers, 36

C

/C switch

considerations for using, 124

using with Setup.exe, 122

.cab files, signing, 19, 42

Calendar caching, 54

Calendar data, migrating, 52

Calendar features

configuring Schedule+ support, 27

customizing holidays, 115

interoperability with Schedule+, 61

opening an Outlook calendar from Schedule+, 65

Outlook calendar template for Word 97, 116

Outlook driver for Schedule+, 65

Outlook Web Access, 127

using Schedule+ as the primary calendar, 116

Calendar format, specifying, 40

Calendar holidays, customizing, 115

Calendar synchronization, 54

Calendar template for Word 97, 116

Capacity of storage facilities, 107

CD installations, 14

CD key, 16

CD, meaning of, x

CD splash screen, customizing, 21

CDO interface for scripting forms, 60, 67

CDO, meaning of, x

Certificate authorities

importing, 37

obtaining certificates, 19

specifying in the registry, 93

Certificates

creating security settings for, 96

how users can configure settings, 95

moving between computers, 96

specifying trusted publishers, 19

troubleshooting, 97

Channels for software update, customizing, 32

Channels, customizing, 31

Checking fax numbers, 56

Checking mail, configuring options for, 101, 103

Checking names against directory services, 40

/CleanFreeBusy switch, 100

/CleanReminders switch, 100

/CleanSchedPlus switch, 100

/CleanViews switch, 100

Client installation point, non-custom, 10

Code example for FindControl method, 73

Code example for referencing toolbars and menus, 73

Code signing, 19, 42

Collaboration features

Microsoft Exchange Client, 60

Microsoft Mail 3.x, 69

Collaboration standards support, 4

Collaborative applications, using with Outlook and Exchange Server, 3

CommandBars, customizing

overview, 72

preventing users from changing settings, 72

specifying custom configuration files, 28

syntax for referencing toolbars and menus, 72

using the FindControl method, 73

Command-line options

considerations for using, 124

running Setup from the command line, 122

switches for Outlook tasks, 100

switches for Outlwzd.exe, 123

switches for Setup.exe, 122

Comment text in Outlbar.inf file, 79

Component list, 17

Components, adding to Outlook, 10

Configuration file for Outlook Bar, sample file, 118

Configuration identifier, 24

Configuring Outlook

automatic dial-up, 101, 103

preventing automatic dial-up, 104, 105

Schedule+ support, 27

setting up for multiple users, 101

setting up for roaming users, 101

user settings, 38

using command-line switches, 100

Connecting to the ISP automatically, 101, 103

Connection time-out, 53

Contact data, importing from Schedule+, 64

Contacts, listing last name first, 110


Content ratings, customizing, 37

Control Panel Web view, customizing, 34

Controlling mail stores on the server, 108

Controlp.htt file, 34

Conventions in this Deployment Kit, ix

Converters, file format, 40

Copying (backing up) Outlook data, 105

Corporate or Workgroup configuration, 12, 26

Creating Setup packages, 50

Cross-platform system, Microsoft Outlook Web Access, 126

Custom Active Setup components, specifying, 18

Custom component groups, naming, 22

Custom field types

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

Custom forms

displaying in Outlook Web Access, 127

new capabilities for designing, 8

updating items for, 111

Custom holidays, creating, 115

Customizing Active Setup, 20

Customizing Autorun screens, 21

Customizing browser settings, 25

Customizing channels, 31

Customizing content ratings, 37

Customizing Control Panel Web view, 34

Customizing desktop toolbars, 33

Customizing desktop wallpaper, 31

Customizing Favorites, 30

Customizing Internet Explorer, 28

Customizing junk e-mail filters, 56

Customizing links, 30

Customizing My Computer Web view, 34

Customizing Outlook Today

advanced customization, 85

basic customization, 83

customization details, 88

disabling Outlook Today, 89

distributing your customized page, 83

overview, 82

performance impact, 90

RENSTATICTABLE, 91

security considerations, 88

Customizing security options

configuring security settings, 95

overview, 93

registry settings, 93

security zones, 37

troubleshooting, 97

upgrading security users, 94

Customizing security zones, 37

Customizing Setup options, 10, 25

Customizing software update channels, 32

Customizing start and search pages, 29

Customizing the Outlook bar

Outlbar.inf file format, 74

overview, 74

specifying custom configuration files, 28

Customizing toolbars and menus

desktop toolbars, 33

overview, 72

preventing users from changing settings, 72

specifying custom configuration files, 28

syntax for referencing toolbars and menus, 72

using the FindControl method, 73

Customizing user agent strings, 35

Customizing user settings, 38, 41

Customizing welcome messages, 31

Customizing window title, 29

D

Databinding, using with Outlook Today, 82

Default components, adding to Outlook, 10

Default installation options, 13

Default Outlook bar, Outlbar.inf format, 74

Default views, restoring, 100

[DefaultOutlookBar] sections, Outlbar.inf, 75

Deferred delivery, Microsoft Mail 3.x, 67

Delegate access

Microsoft Exchange Client, 61

Microsoft Mail 3.x, 69

Schedule+, 63

Delegation of tasks, 61, 63, 69

Design goals for Outlook, 2

Desktop components, specifying, 33

Desktop icons, 22, 52

Desktop toolbars, customizing, 33

Desktop wallpaper, customizing, 31

Destination folder, 17

Dialing the ISP automatically, 101, 103

Dial-Up Networking 1.2 Upgrade, installing, 102

Digital IDs. See Certificates

Digital signatures

customizing Outlook security options, 93

Microsoft Mail 3.x, 67

signing program files, 19, 42

troubleshooting, 97

verifying, 19

Direct booking, 63

Directory services, specifying, 39

Disabling form design, 53

Disabling Outlook Today, 89

Disconnect options, setting, 103

Distributing a customized Outlook Today page, 83

Distributing packages, 49, 51

Distribution channels for software update, 32

DLL, meaning of, x

.dll file for custom Outlook Today page, 83, 85

Document conventions, ix

Download sites, specifying from the command line, 123

Driver for Schedule+, 65

E

EFD (Exchange Forms Designer), 60, 69

E-mail editor, 40, 45


E-mail features of Outlook Web Access, 126

E-mail filters, customizing for junk e-mail, 56

E-mail service options, choosing, 26

E-mail Transport Service, configuring, 101

Embedded hyperlinks

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

Encryption

customizing Outlook security options, 93

Microsoft Mail 3.x, 67

specifying minimum key length, 47, 93

Enhanced standard message form

Microsoft Exchange Client, 58

Microsoft Mail 3.x, 68

Enrolling security keys, 94, 95

.epf files, 94

Example code for FindControl method, 73

Example code for referencing toolbars and menus, 73

Example JavaScript for custom Outlook Today page, 89

Example Outlbar.inf file, 118

Exchange Forms Designer, 60, 69

Exchange Server Resource Kit, ix

Exchange Views, 54

Exhange Client, interoperability, 58

Expiration of messages

Microsoft Exchange Client, 58

Microsoft Mail 3.x, 67

Exporting personal folder data, 106

Extended message properties

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

Extranet distribution of applications, 126

F

Favorites folder, customizing, 30

Fax numbers

checking, 56

sending mail messages to, 110, 111

Features for Administrators, 4

Field types, custom

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

file://protocol, 83

File-format converters, 40

File System namespace <rootid> codes, 80

Files moved to \Application Data folder, 55

Filters for junk e-mail, customizing, 56

FindControl method, 73

Finding command values for CommandBars, 73

First/last name in Address Book, reordering, 110

Folder for Outlook installation, specifying, 24

Folders

backing up, 105

creating links for accessing, 114

exporting personal folder data, 106

importing personal folder data, 107

managing the size of, 108

restoring missing folders, 100

storage facilities, described, 107

Font styles, changing for Outlook Today, 88

Foreign language selection, 16

Form design feature, disabling, 53

Forms

custom forms design, 8

Microsoft Exchange Client, 60

Microsoft Mail 3.x, 69

updating items to use custom forms, 111

Free/Busy feature

interoperability with Schedule+, 61, 62

overview, 54

Free/Busy information, cleaning and regenerating, 100

Full-text search, Microsoft Mail 3.x, 67

G

GAL, meaning of, x

Generating GUIDs, 19

Generating your custom Setup, 42

GetExlorer method, 72

GetInspector method, 72

Getting command values for CommandBars, 73

Globally unique identifiers, specifying, 19

Group scheduling, 61

Group scheduling, Outlook Web Access, 127

[GroupSections] section, Outlbar.inf, 75

GUIDs, specifying, 19

H

Hand-held devices, synchronizing Outlook data with, 8

Hands-free installation. See Silent installation

Help page, specifying, 30

Hiding Internet Explorer icons, 22

Holidays, customizing, 115

HTML support, 7

HTML, meaning of, x

HTML-formatted messages

Microsoft Exchange Client, 60

Microsoft Mail 3.x, 68

.htt files, modifying, 34

Hyperlinks, embedded

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

I

/I switch, 123

iCalendar, 7, 54, 58

Icons

hiding, 22

offline folders, 53

setup options (/X switch), 123

Identifiers for programs (GUIDs), 19

IEAK (Internet Explorer Administration Kit), 11, 52

IMAP4, meaning of, x

IMAP4 protocol, using with Outlook, 58


IMAP4 servers, 11

IMAP4 support, 7

IMEP, meaning of, x

Import filters, obtaining, 8

Importing

Active Desktop settings, 34

Authenticode security information, 37

calendar data, 52

channel configurations, 31

content rating settings, 37

desktop toolbar settings, 33

personal folder data, 107

Schedule+ data, 64

software update channel configuration, 32

Inappropriate content, filtering, 37

Inbox rules, 60

INF, meaning of, x

.inf files, sample Outlbar.inf file, 118

.ins files, using to configure options, 35

Installation folder, specifying, 24

Installation modes, specifying with the /M switch, 123

Installation options (command-line switches)

considerations for using, 124

running Setup from the command line, 122

switches for Outlwzd.exe, 123

switches for Setup.exe, 122

Installation options, specifying in the wizard, 23

Installation point, non-custom, 10

Installing

IEAK, 52

Outlook 98 Deployment Wizard, 13

Outlook components, 10

Outlook driver for Schedule+, 65

package definition files, 49

Windows Desktop Update, 25

Installing the Dial-up Networking 1.2 Upgrade, 102

Integrating the Windows Desktop Update, 25

Internet content ratings, customizing, 37

Internet E-mail Transport Service, configuring, 101

Internet Explorer

Add-On Component URL, specifying, 24

customizing, 25, 28

icons, hiding, 22

integration with Outlook, 6

Welcome window, disabling, 31

Internet Explorer Administration Kit (IEAK), 11, 52

Internet Free/Busy feature, 54

Internet Mail servers, specifying, 38

Internet News servers, specifying, 38

Internet Only configuration, 12, 26

Internet sites with product information, ix

Internet standards, support for, 2

Interoperability

introduction, 58

Macintosh, 66

Microsoft Exchange Client, 58

Microsoft Mail 3.x, 67

Microsoft Outlook 97, 118

Microsoft Project, 69

Interoperability (Continued)
Outlook driver for Schedule+, 65

public folders, 60

Schedule+, 61

Windows 3.1x, 66

ISP, meaning of, x

J

JavaScript for custom Outlook Today page, 89

Journal, system policy for, 46

Junk e-mail feature, 48

Junk e-mail filters, customizing, 56

K

Keys, security

enrolling (recovering), 94

minimum length for encrypted mail, 47, 93

moving between computers, 96

public and private, described, 93

renewing after time-out period, 97

setting up, 94

L

/L switch, 123

LAN, meaning of, x

Language, specifying, 16

LDAP directory access, MAPI service provider for, 54

LDAP, meaning of, x

LDAP server settings, specifying, 39

LDAP support, 7

Lightweight Directory Access Protocol support, 7

Link auto-detection, 53

Links

adding to a custom Outlook Today page, 88

creating for opening items, 114

customizing, 30

embedded links in messages, 59, 68

Links toolbar, adding, 33

List of components, 17

Location of custom packages, specifying, 17

Location of Outlook installation, specifying, 24

M

/M switch, 123

Macintosh, interoperability with Outlook, 66

Mail 3.x, interoperability with Outlook, 67

Mail editor, 40, 45

Mail service options, choosing, 26

Mail store size, controlling, 108

Mailbox folder capacity, 108

Managing mail stores on the server, 108

MAPI LDAP service provider, 54


MAPI, meaning of, x

MAPI namespace <rootid> codes, 79

Mass-mailings. See Junk e-mail

Meeting requests, interoperability with Schedule+, 61

Menus, customizing

overview, 72

preventing users from changing settings, 72

syntax for referencing toolbars and menus, 72

using the FindControl method, 73

Message classes, 111, 112

Message expiration

Microsoft Exchange Client, 58

Microsoft Mail 3.x, 67

Message form

Microsoft Exchange Client, 58

Microsoft Mail 3.x, 68

Message properties

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

Message recall, 67

Message size

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

Messaging standards support, 4

MHTML, meaning of, x

MHTML support, 7

Microsoft Dial-Up Networking 1.2 Upgrade, installing, 102

Microsoft Exchange Client, interoperability, 58

Microsoft Exchange Server Resource Kit, ix

Microsoft Exchange Views, 54

Microsoft Mail 3.x, interoperability with Outlook, 67

Microsoft Outlook client for Macintosh, 128

Microsoft Outlook client for Windows 3.x, 128

Microsoft Outlook Express, 128

Microsoft Outlook Web Access

features, 126

limitations, 127, 128

overview, 126

Microsoft Pocket Outlook, 129

Microsoft Project, interoperability with Outlook, 69

Microsoft Schedule+ interoperability, 61

Microsoft Systems Management Server, 49

Microsoft Windows 3.x, interoperability with Outlook, 66

Microsoft Word 97, Outlook calendar template for, 116

Microsoft Word, using for WordMail, 60

Migrating calendar information, 52

Migration tools, 56

Minimum key length for encrypted mail, 47, 93

Missing folders, restoring, 100

Mobile users, setting up Outlook for, 101

Mode for installation, specifying, 123

MSDL, meaning of, x

Multiple users, setting up Outlook for, 101

My Computer Web view, customizing, 34

Mycomp.htt file, 34

N

/N switch, 123

Names in Address Book, reordering, 110

Namespace values, Outlbar.inf file

File System namespace <rootid> codes, 80

MAPI namespace <rootid> codes, 79

Naming groups of custom components, 22

NetFolders, 49

Network News Transport Protocol support, 7

New components, adding to Outlook, 10

New features for Administrators, 4

New system policies, 45

News reader, 7

News servers, specifying, 38

NNTP, meaning of, x

NNTP support, 7

No E-Mail configuration, 12, 26

Non-custom client installation point, setting up, 10

Non-table views, Microsoft Exchange Client, 59

O

Obtaining certificates, 19

ODK profiles (.ins files), 35

ODK Wizard. See Outlook 98 Deployment Wizard

Offline folder icons, 53

Offline store files

capacity, 108

synchronizing data between computers, 109

system policies, 47

Offline store synchronization, 47, 53

Olcalndr.dot, 116

Olcalndr.exe, 116

Olmaint.exe (/N switch), 123

Omsgclas.exe, 112

Online support page, specifying, 30

Opening items, creating links for, 114

Optimized installations, 4, 11

Optimizing Outlook

backing up Outlook data, 105

configuring automatic dial-up, 101, 103

controlling mail stores on the server, 108

customizing calendar holidays, 115

getting the calendar template for Word 97, 116

managing a .pst file for two computers, 109

preventing automatic dial-up, 104, 105

reordering Address Book names, 110

sending messages to a fax number, 110

setting up for multiple users, 101

setting up for roaming users, 101

updating items to use custom forms, 111

using command-line switches, 100

using links to access folders and items, 114

using Schedule+ as the primary calendar, 116

OST, meaning of, x

Outcmd.dat file, 72


Outlbar.inf file

File System namespace <rootid> codes, 80

format, 74

MAPI namespace <rootid> codes, 79

predefined substitution strings, 81

sample file, 118

Outlk98.adm template file, 45

Outlk98.pdf file, 49

Outlook 97, interoperability, 58

Outlook 98 Deployment Wizard

installing, 13

overview, 5, 11

preparing to run, 14

starting, 15

summary of stages, 15

Outlook bar

customizing, 74

Outlbar.inf file format, 74

refreshing, 100

specifying custom configuration files, 28

Outlook calendar template for Word 97, 116

Outlook driver for Schedule+, 65

Outlook Express, 128

Outlook Today, customizing

advanced customization, 85

basic customization, 83

customization details, 88

disabling Outlook Today, 89

distributing your customized page, 83

overview, 8, 82

performance impact, 90

RENSTATICTABLE, 91

security considerations, 88

Outlook Web Access

features, 126

limitations, 127

overview, 126

Outlwvw.dll, 83, 84, 85

Outlwzd.exe command-line options, 123

Outsites.dat file, 123

OWA, meaning of, x

P

Package definition files, 49, 50

Package distribution, 49, 51

.pdf files, 49, 50

PDF, meaning of, x

Performance impact of custom Outlook Today page, 90

Performance improvements, 2

Personal address books, importing, 8

Personal folder files

backing up, 105

capacity of, 107

exporting data from, 106

importing data to, 107

managing for two computers, 109

Phone line, setting up connections, 102, 103

PIM import filters, obtaining, 8

Plain text

Microsoft Exchange Client, 60

Microsoft Mail 3.x, 68

Pocket Outlook, 129

Poledit.exe, 44

Policies. See System policies

Policy Editor. See System Policy Editor

POP3, meaning of, x

POP3 servers, 11

POP3/SMTP protocols, using with Outlook, 58

POP3/SMTP support, 6

Post offices, interoperability with Outlook, 67

Predefined substitution strings, 81

Preparing to run the ODK Wizard, 14

Preventing automatic dial-up, 104, 105

Preview pane, Microsoft Exchange Client, 61

Private items, Microsoft Exchange Client, 59

Private keys, 93

Product updates page, specifying, 24

/Profile switch, 100

Project, interoperability with Outlook, 69

Protocol support, 2

Protocols compatible with Outlook, 58

Proxy bypass, 36

Proxy settings, specifying, 36

PST, meaning of, x

Public folders

capacity, 108

Microsoft Exchange Client, 60

Microsoft Mail 3.x, 67

Microsoft Outlook Web Access, 127

Public keys, 93

Publisher certificates. See Certificates

Q

/Q switch (Quiet mode)

considerations for using, 124

using with Outlwzd.exe, 123

using with Setup.exe, 122

Quick Launch bar, setup options (/X switch), 123

Quick Launch toolbar, adding, 33

Quiet installation. See Silent installation

R

/R switch

considerations for using, 124

using with Outlwzd.exe, 123

using with Setup.exe, 122

Ratings, customizing, 37

Reboot after installation (/R switch)

using with Outlwzd.exe, 123

using with Setup.exe, 122

Rebuilding the Outlook bar, 100


Recovering security keys, 94

Reducing mail store size, 108

Referencing toolbars and menus, 72

Registering uninstall programs, 19

Registry settings

adding new registry entries, 41

\Application Data folder, 55

custom .dll file for Outlook Today, 83, 85

custom .htm file for Outlook Today, 84

disabling auto-dial for faxing, 56

disabling form design, 53

Exchange Views, 54

importing calendar information, 52

Internet Free/Busy, 54

Journal, 46

junk e-mail, 48

mail editor, 46

minimum encryption key length, 47

NetFolders, 49

offline store synchronization, 47

Outlook automatic upgrade, 43, 44

Outlook Today, 46, 89

S/MIME, 46

security options for Outlook, 93

uninstall keys, 19

Reminders, cleaning and regenerating, 100

Remote access, Microsoft Outlook Web Access, 126

Remote installation using .pdf files, 49

Removing the Outlook driver for Schedule+, 65

RENSTATICTABLE, 91

Reordering Address Book names, 110

res:// protocol, 83, 90

/ResetFolders switch, 100

/ResetOutlookBar switch, 100

Resource .DLL file for custom Outlook Today page, 83, 85

Restoring missing folders, 100

Rich text in messages

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

Roaming users, setting up Outlook for, 101

Root certificate, adding, 37

<rootid> values, Outlbar.inf file

File System namespace, 80

MAPI namespace, 79

RPC, meaning of, x

Rules wizard, 60

Rules, Microsoft Exchange Client, 60

Run On Workstation job, creating, 51

Running Setup from the command line, 122

Running the ODK Wizard, 15

S

/S switch

considerations for using, 124

using with Outlwzd.exe, 123

S/MIME, meaning of, x

S/MIME security in Outlook, 93

S/MIME support, 7

S/MIME system policy options, 46

Sample code for FindControl method, 73

Sample code for referencing toolbars and menus, 73

Sample JavaScript for custom Outlook Today page, 89

Sample Outlbar.inf file, 118

Saved views, Microsoft Exchange Client, 59

Saving (backing up) Outlook data, 105

Schedule+

configuring support for, 27

deleting data from the server, 100

interoperability with Outlook, 61

migrating data into Outlook, 52

opening an Outlook calendar from Schedule+, 65

Outlook driver for Schedule+, 65

using as the primary calendar, 116

Scheduling features

See also Calendar features

interoperability with Schedule+, 61

Outlook Web Access, 127

Script, adding to Outlook Today, 89

Search page, customizing, 29

Secure Multi-purpose Internet Mail Extensions support, 7

Secure Password Authentication (SPA), 39

Security model, 6

Security of custom packages, code signing, 19, 42

Security options, customizing

configuring security settings, 95

creating Outlook security settings, 96

moving certificates and keys, 96

overview, 93

registry settings, 93

troubleshooting, 97

upgrading security users, 94

Security zones, customizing, 37

Sending mail messages to a fax number, 110

Server connection time-out, 53

Setup command-line options

considerations for using, 124

running Setup from the command line, 122

switches for Outlwzd.exe, 123

switches for Setup.exe, 122

Setup options, customizing, 10, 25

Setup packages, creating, 50

Setup.exe, 42, 43, 44

Setup.exe command-line switches, 122

[ShortcutSections] section, Outlbar.inf, 77

[ShortcutsSections] section, Outlbar.inf, 76

Signatures, digital

customizing Outlook security options, 93

Microsoft Mail 3.x, 67

signing program files, 19, 42

troubleshooting, 97

verifying, 19

Signing program files, 19, 42

Silent installations, 22


Silent mode. See /Q switch (Quiet mode)

Simple Mail Transport Protocol support, 6

Site certificate settings, 37

Size of mail store on server, controlling, 108

Size of messages

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

Size of storage facilities, 107

SMS, meaning of, x

SMTP, meaning of, x

SMTP support, 6

SMTP/POP3 servers, 11

Software update channels, customizing, 32

SPA (Secure Password Authentication), 39

Spam mail. See Junk e-mail

Splash screen, customizing, 21

SPX, meaning of, x

Standard message form

Microsoft Exchange Client, 58

Microsoft Mail 3.x, 68

Start menu, Setup options (/X switch), 123

Start page, customizing, 29

Starting Outlook with command-line switches, 100

Starting the ODK Wizard, 15

Stationery

Microsoft Exchange Client, 60

Microsoft Mail 3.x, 68

STF, meaning of, x

Stopping Outlook from dialing the ISP at startup, 104, 105

Storage facilities, described, 107

Streaming and preprocessing (res:// protocol), 83, 90

String substitution, 78

[Strings] section, Outlbar.inf, 78

Substitution strings, predefined, 81

Support for Internet standards, 2

Support page for the browser, specifying, 30

Switches, command-line

configuring Outlook from the command line, 100

considerations for using, 124

for Outlwzd.exe, 123

for Setup.exe, 122

running Setup from the command line, 122

Synchronizing data between two computers, 109

Syntax for referencing toolbars and menus, 72

System administration features, 4

System policies

Journal, 46

junk e-mail, 48

mail editor, 45

NetFolders, 49

new policies, 45

offline store synchronization, 47

Outlook Today, 46

overview, 44

S/MIME, 46

using Outlk98.adm template, 45

System Policy Editor, 44, 45

Systems Management Server, 49

T

/T switch, 122

Table views, Microsoft Exchange Client, 59

TAPI, meaning of, x

Target language, specifying, 16

Task assigment, Microsoft Project interoperability, 69

Task data, importing from Schedule+, 64

Task delegation, Microsoft Exchange Client, 61

TCP/IP, meaning of, xi

TeamStatus, Microsoft Project, 69

Technical support page, specifying, 30

Telephone line, setting up connections, 102, 103

Template (calendar) for Word 97, 116

Template for system policies, 45

Title text, customizing, 29

Toolbars, customizing

desktop toolbars, 33

overview, 72

preventing users from changing settings, 72

specifying a background bitmap, 29

specifying custom configuration files, 28

syntax for referencing toolbars and menus, 72

using the FindControl method, 73

Tools for migration, 56

Tracking browser usage, 35

Troubleshooting security problems, 97

Trusted publishers, specifying, 19

Turning off Outlook Today, 89

Typographic conventions, ix

U

/U switch, 123

UNC format, 123

UNC, meaning of, xi

Uninstall keys, 19

Universal Naming Convention format, 123

UNIX clients, Microsoft Outlook Web Access, 126

Unlimited message size

Microsoft Exchange Client, 59

Microsoft Mail 3.x, 68

Update channels for software, 32

Update page for Internet Explorer components, specifying, 24

[UpgradeGroupSections] section, Outlbar.inf, 75

[UpgradeOutlookBar] section, Outlbar.inf, 74

Upgrading Outlook automatically, 43, 44

Upgrading security, 94

URL, meaning of, xi

User agent strings, customizing, 35

User Choice e-mail option, 26

User settings, customizing, 41

V

VBScript, using for custom forms, 4

vCalendar, 7, 58

vCards

Microsoft Exchange Client, 60

Microsoft Mail 3.x, 68

support for, 7

Verfiying fax numbers, 56

Version numbers for programs, specifying, 19

[Version] section, Outlbar.inf, 75

Views

automatic generation of Exchange Views, 54

non-table views, Microsoft Exchange Client, 59

restoring default views, 100

saved views, Microsoft Exchange Client, 59

support for multiple types of views, 3

Visual Basic Scripting Edition, using for custom forms, 4

Voting buttons, 59, 68

Voting messages, 61

W

Wallpaper, customizing, 31

Warning messages for security, 93

Web Access, Microsoft Outlook

features, 126

limitations, 127, 128

overview, 126

Web sites with product information, ix

Web views, customizing, 34

Welcome message, customizing, 31

Window title, customizing, 29

Windows 3.x, interoperability with Outlook, 66

Windows Desktop Update, 25

Windows Desktop Update installation (/I switch), 123

Windows registry, adding entries to, 41

Wizard. See Outlook 98 Deployment Wizard

WMS, meaning of, xi

Word 97, Outlook calendar template for, 116

WordMail, 60

Workgroup configuration, 12, 26

X

/X switch, 123
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